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Working with Earned Value Analysis

The following explains how to work with Earned Value.

Within our documentation, some content might be specific for cloud deployments while other
content is relevant for on-premises deployments. Any content that applies to only one of these
deployments is labeled accordingly.

Note: The instructions and information presented in the Unifier
documentation is based on an out-of-the-box setup and before being
customized by the user.

The Earned Value Analysis (EV Analysis) is an industry standard for analyzing project
performance, and it can be used to track:

Progress to date
Forecast completion date
Forecast completion cost
Schedule variances
Budget variances
Performance

v v v v v Vv

As a feedback tool, the EV Analysis helps you to:

» Identify where the problems may occur and whether the problems are critical or not.
» Determine what needs to be done to put the project back on track.

The Earned Value Analysis node (Earned Value Manager > Earned Value Analysis) is
based on the project schedule data (activities and assignments) and company rates (resources
and roles) imported from P6 through integration. The Earned Value Analysis node:

» Optimizes the use of cost control features.

» Calculates earned value and other related measures for a project, such as planned value,
actual cost, variances, performances indexes, and at completion values using rates defined
in Unifier.

Note: EVM requires database partition tables in Oracle Database. The
database partition feature is only available in Oracle Database
Enterprise Edition and should be enabled with license.

Use the Earned Value Analysis Report node (Earned Value Manager > Earned Value
Analysis Report) to generate ANSI Reports.
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To be able to use the Earned Value Management (EVM) module:

» You need a license for the module
» Oracle DB, being used for Unifier, must have DB Partition feature enabled.
» The following Oracle third-party applications must be available:
» P6
»  Gateway
» Unifier and P6 Integration through Gateway must be established.

Ensure that P6, Gateway, and Unifier integration have configured properly. P6 must have at
least one project (if baseline is available in P6 you are set; otherwise, you must use the P6
Current Schedule as baseline).

The option to enable multiple projects mapping between P6 and Unifier is included in the
Shell Attributes form. In the Shell Attributes form, use the Integration tab to map multiple P6
projects with the respective shell in Unifier using P6 Project ID.

Summary of Steps for Earned Value (EV) Analysis

The following is a summary of steps that you must perform for EV Analysis:

1) Begin by setting up integration parameters in Gateway, P6 and Unifier.

2) In Company Workspace (Admin mode), use the two new synchronizations in the Gateway
node to import P6 activities, assignments, and rates for EV analysis.



3)

4)

5)

6)

7)

Working with Earned Value Analysis

In Company Workspace (User mode), initiate the synchronizations from the company-level
Master Rate Sheet node to fetch the global roles and resources data from P6.

In Shell Details, Integration tab, select the Link Multiple P6 Projects check box and add P6
projects.

Notes:
= The same P6 project cannot be mapped to other shells. The
one-many relationship is unique for EVM functionality.

= The Unifier company currency and P6 base currency must be the
same.

In the Shell (User mode), the Activity Manager module is available to store an activity sheet
and shell-level rate, WBS, and OBS sheets.

I. Initiate synchronizations in the Activity Sheets log to get:
1. The activities and assignments data from the linked P6 projects.

2. Inthe Rate Sheet node, create rate sheets, if shell-specific rates are required. This
creates a shell-level Rate Sheet with roles and resources that will be used in the shell.

In the Shell (User mode):

In the Earned Value Analysis node (Earned Value Manager > Earned Value Analysis),

perform earned value analysis corresponding to an activity sheet.

I. Activity sheet data (WBS, CBS, and all projects) is consolidated, rolled up, and displayed
in summary tables in an EV scenario.

2. Earned value analysis can be generated directly for cost loaded projects, with Unifier
Rate Sheet.

3. Forresource loaded projects, resource and role rates must be present before analyzing
earned value and other matrices.
4. Duration based projects are ignored because they do not have cost data.

In the Company Workspace and Shell, the related areas in Unifier include all permissions,
reporting, and Configuration Package Management modules.

Note: Only the Cost-loaded and Resource-loaded projects are used for
EV analysis. Although it can be included in an Activity Sheet, a
duration-based project cannot be used for Earned Value Analysis.






Configuring the Gateway Integration

After integration parameters are set up in P6 and Gateway, configure the Gateway integration
options.

Notes:
= The Summary sheet Integration will not work when you enable link to
multiple projects in the Integration tab of a shell.

= All existing Activities data, and corresponding Audit log data, will be

deleted when you enable link to multiple projects in Integration tab of
a shell.

= When the P6 project id is added in General tab of a Shell Details
(which is already added in another Shell Integration tab), then the
priority will be given to the shell in which the p6 project id added in
Integration tab on running Get Data from any of the shells.

1) Go to the Company Workspace (Admin mode) and navigate to the Gateway node.
2) Open the Integration Settings dialog.

3) Complete the two synchronizations that are available to import P6 activities and rates for
Earned Value analysis:

I. Select Synchronization to import Activity & Assignment data.
2. Select Synchronization to import Role & Rate rates.

11
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The solution uses existing Unifier and P6 projects only. The existing export
synchronization will be used to export data from Unifier to P6 for activity sheet with
multiple projects.

For a successful integration, the Schedule type must be selected in P6. This is a
mandatory condition.

3. P6 Base Currency
By default, the P6 currency is populated with Company Currency.
If the P6 base currency is not the same as Company Currency, the admin can change it
to the relevant P6 base currency.
Begin initiating the Gateway synchronizations to import and store P6 data:

» Role and Resource Rates
» Activity and Assignment Data

In This Section

RoOle and RESOUICE RALES........cooiiiiiiiii e e e e e 12
Activity and ASSIGNMENT DAt .......ccoeeiiiiiiie e e e 12
Prerequisites for Configuring the Gateway Integration..............cccccevvvvieeiieeeeeeeevvnnnnn, 13

Role and Resource Rates

In the Company Workspace (User mode), initiate the synchronization from the Master Rate
Sheet node to fetch the global roles and resources data from P6.

Click Get Data to run the synchronization and create the Master Rate Sheet. The Master Rate
Sheet fetches and stores global roles and resource data from P6. Effective dates and standard
price/unit imported from P6 on first import can be modified in Unifier. Rates from the Master
Rate Sheet are used in the Activity Sheet in a Unifier project for P6 resource loaded projects.
See Master Rate Sheet (on page 15) for more information.

Note: Rates are not imported on subsequent synchronizations. Only
resource and role lists are updated.

Activity and Assignment Data

In the shell Details, use the Integration tab to map P6 projects.

1) Click to expand the Activity Manager module.

2) Click the Activity Sheet sub-node to open the log.

3) Click Get Data to run the synchronization and create the Activity Sheet.

The Activity Sheet fetches and stores the activity and assignment data from P6, and the role and
resource rates data from the company-level Master Rate Sheet. Subsequent synchronizations
will update the data. For more information, see the following:

» Mapping P6 Projects in Shell Details (on page 15)

» Earned Value Management Attributes (on page 157)

12
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Prerequisites for Configuring the Gateway Integration
» Integration Parameters in Gateway and P6

» Permissions

Integration Parameters in Gateway and P6

Complete configuration of the integration parameters in Gateway and P6. The Schedule type
must be selected for projects in P6 for successful integration.

Permissions

Grant the required Administration and User mode permissions for the relevant modules in
Unifier by using the following modules:

» Permission templates
» Access Control
» User Administration

For Administration mode access (Company) use:
» Gateway

For User mode access (Company) use:

» Master Rate Sheet

For User mode access (Project/Shell)

» Activity Manager
» Activity Sheet
» Rate Sheet
» WBS Sheet
» OBS Sheet
» Earned Value Manager
» Earned Value Analysis
» Earned Value Analysis Report

See Setting up the Earned Value Management Permissions in the Unifier Modules Setup
Administration Guide for detalils.

13






Mapping P6 Projects in Shell Details

When Unifier is integrated with P6 via Gateway, an additional Gateway Integration tab is
displayed in shell details.

1) Navigate to the shell in which you want to map multiple P6 projects to perform Earned Value
analysis.

2) Click the more menu option (the three horizontal dots icon next to My Dashboard) and
select Details.

3) Inthe Gateway Integration tab, select the Link Multiple P6 Projects check box.
This drives the synchronizations in the Gateway node.

4) Click Add.

5) Inthe Add P6 Project dialog box, enter the project ID and click OK.

The project name and schedule type are auto-populated after running the sync.

Only Cost Loaded and Resource Loaded projects are used in Earned Value Analysis. The
Duration Based projects are ignored because they do not have cost data.

P6 includes a "Cost Spread" option that enables the user to spread cost based on "Linear" or
"Units" spreads. Unifier only supports the "Linear" spread; it does not support the "Units" spread.

After the P6 project and its activities are synced to the Activity Sheet, you cannot modify or
delete respective Project IDs. Clearing the Link Multiple P6 Projects check box also cannot be
done if any P6 project IDs are added.

Note: The same P6 shells cannot be mapped to other shells in Unifier.
The one-to-many relationship is only unique for Earned Value
Management functionality.

Master Rate Sheet

Unifier enables you to set a series of rate rules that should be applied when certain conditions
are met in a project by way of the Master Rate Sheet.

In P6, users can assign a role, or resource, to an activity under the assignments tab of an
activity for any project. The rates (Price/Unit) for assigned roles and resources are managed at
global level in P6, which can then be used in a project while doing the costing (calculating
Present Value, Earned Value, etc.) of the project depending on the rate source (resource, role or
override) corresponding to that assignment in an activity.

A Master Rate Sheet is created after the first P6-Unifier integration via Gateway. It fetches and
stores global roles and resource data (and their corresponding rates) from P6.

Subsequent synchronizations will update roles and resources but not the rates. By default, the
rates present in the Master Rate Sheet are used across all the resources and roles present in
the activity sheets across all shells unless you assign a shell-level rate sheet to the Activity
Sheet in that shell.

15
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There is no support to export data from the Master Rate Sheet in Unifier to P6 in the multiple
mapping paradigm.

The sheet stores all the changes made across all the resources and roles present in it manually
or by way of synchronization.

The P6 synchronization for Resource rates and Role rates can result one of the following
scenarios:

Scenario One:

P6 Resource currency = P6 Project currency = Unifier Company currency
No changes required

Scenario Two:

P6 Resource currency <> P6 Project currency = Unifier Company currency

The value against any resource rate from P6 comes in P6 company currency, even if the
resource currency is different. As a result, while synchronizing with P6, the value coming
from P6 as resource rate will be converted to the respective amount in the resource
currency.

The exchange rate for doing this will be fetched from the Standards and Libraries with unifier
company currency as the base currency.

If there is no exchange rate, then by default the system uses zero as the exchange rate. The
converted resource rate will be stored in the Master Rate Sheet for an effective date.

If there are multiple rates with different effective dates, then the system uses the exchange
rate applicable to the effective dates, for conversion.

Scenario Three:

P6 Resource currency = P6 Project currency = <> Unifier Company currency

The currency object between P6 and Unifier will be mapped in Gateway to get the P6 Project
currency. Once, the application receives the P6 project currency, it treats it as explained in
Scenario Two, by applying the exchange rate to individual resources.

Scenario Four:

P6 Resource currency <> P6 Project currency <> Unifier Company currency

The application implements the process indicated in Scenario Three; thereby, converting all
the resource rates in unifier company currency.

If the resource rate currency is different from the P6 project currency, then Unifier applies the
process indicated in Scenario Two to handle this scenario (Scenario Four).

Note: While creating a shell-level rate sheet the system keeps the

currencies that are being used in the Company Workspace because that
is where the currency is going to be used by a resource.

Master Rate Sheet and P6 (Multiple Row Rates)

In P6 both the resource and role rates are maintained globally. You can import P6 resource and
role rates into the Master Rate Sheet.

16
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For a resource loaded schedule, you need rates corresponding to these roles and resources for
doing costing of any project. See the About Costing topic, below, for details about performing
costing.

There are two types of rate sheets:

» Master Rate Sheet (at Company Workspace)
Company Workspace > User mode > Master Rate Sheet
» Rate Sheet (at Project/Shell)
Project/Shell > User mode > Activity Manager > Rate Sheet

For P6 resource loaded schedule, the Master Sheet receives the standard rates which
correspond to the roles and resources, and the rates are used in costing of any project in Unifier.

In P6 you can define a role with multiple rates and multiple effective dates and bring the
information into the Master Rate Sheet.

Note: When you click on Get Data from the Master Rate Sheet log, the
rate sheet displays all of the existing role rates with effective date as
01/01/2020.

When you create a project rate sheet that only has the resources and roles that are being used
in the resource-loaded project in the system activity sheet of a shell, you can see the assigned
roles, with the multiple rates, that have been sent to the Master Rate Sheet.

You can assign the role rate to the activities and resource assignments and any cost
calculations will use the assigned rate.

When you refresh data in the Master Rate Sheet, Unifier performs all of the existing validations.

For a cost loaded schedule, there are no calculations conducted in Unifier, and Unifier uses the
data directly from P6.

In P6, rates are assigned to a role or resource at global level. To maintain the consistency, the
P6 global data is imported to Unifier Company Workspace. This data is captured under the
Master Rate Sheet. That is to say, the rate sheet is created through P6-Unifier integration and is
saved as "Master Rate Sheet" under a new node in company workspace called Master Rate
Sheet.

Under Company Workspace, there is only one rate sheet called Master Rate Sheet. You are
not permitted to create a copy sheet of the Master Rate Sheet under Company Workspace.
The Master Rate Sheet contains rates for both roles and resources. You will be able to toggle
between role and resource rates within the window.

17
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Note: By default, the rates present in the Master Rate Sheet are used
across all roles and resources present in all activity sheets across all
shells unless the user has assigned another rate sheet (present at the
shell level) to the activity sheet/project.

To assign rates at the activity sheet level, you can use a subset of Master Rate Sheet in a shell
with the roles and resources being used in the resource-loaded projects in the system activity
sheet of that shell, only. Rate sheets present at any shell are subsets of Master Rate Sheet.
This means, when you click on refresh data (Refresh) for any rate sheet at shell level, then
Unifier updates the Master Rate Sheet with:

» The list of roles and resources based on the latest data available in resource-loaded projects
in the activity sheet

» The corresponding rates from Master Rate Sheet
The following rules are in place when refreshing data:

» If arole or resource rate has been removed from the system activity sheet (for that shellO,
then the system deletes the role or resource rate along with the rates in the Rate Sheet
being refreshed.

» If arole or resource rate has been added in the activity sheet, then the system updates the
rate sheet being refreshed with the new role or resource rate along with the rates in the
Master Rate Sheet.

» For arole or resource rate that appears across both the system activity sheet and rate sheet,
the system updates the currency or Resource/Role name (if applicable), using the role or
resource ID as the identifier.

A rate sheet in the Master Rate Sheet (at Company Workspace) is updated through P6, but a
rate sheet in the Rate Sheet (at Project/Shell) gets updated in Unifier through the Master Rate
Sheet at Company Workspace) and system activity sheet at that shell.

About Costing

You can perform costing in:

» A rate sheet by using the standard rate defined in the rate sheet.

» An activity sheet by using the additional type of costs (labor, G&A, and so forth) along with
the standard rate defined in the rate sheet.

In addition:

» You extend the rating in order to define various types of costs such as Labor.

» Each cost type has a categorization (such as direct or indirect) for reporting purposes.
» Each cost type can be a rate-based, a formula-based, or another cost type.
4

Each cost type can be defined in a priority order, in order to be able to calculate the values
accurately.

Accessing the Master Rate Sheet Log

To access the Master Rate Sheet log:
1) Go to the Company Workspace.
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2) Switch to User mode.
3) On the left-hand Navigator, click the Master Rate Sheet node.

Note: The location of the node may differ in your implementation based
on the Company WorkspaceUser Mode Navigator configuration.

The Master Rate Sheet (at Company Workspace, User mode) log displays the Master Rate
Sheet created at Company Workspace through P6-Unifier integration. When you click on the
Master Rate Sheet module, the Master Rate Sheet log opens.

The Master Rate Sheet log contains the following toolbars:

» Get Data
To initiate getting the data.

The Master Rate Sheet log contains the following columns:

» Name

Displays the name of the master rate sheet that has been created through P6-Unifier
integration, the name will be "Master Rate Sheet."

» Description

It will be left blank while creating the master rate sheet and is an editable field.
» Last Updated

Date when master rate sheet was last updated.
» Created By

The name of the user or admin who created the Master Rate Sheet (at Company
Workspace) through P6-Unifier integration.

The gear menu ( £ ) next to the Master Rate Sheet enables you to:
» Open
» Export CSV
» Export Role Rate Breakdown
» Export Resource Rate Breakdown
» Update Data
» Import Role Rate Breakdown
» Import Resource ate Breakdown

The Master Rate Sheet log contains the following tabs (right-hand pane):

Audit Log | Stores all the changes made across all roles and resource present in the
Master Rate Sheet (manual/synchronization).

Schedule | To schedule get data and see the history. The Schedule tab enables you
to:

» Set frequency for getting data or sending data (Set Frequency for).

» Select the frequency time (Frequency).

» Set the start and end dates.
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History

The History tab enables you to see a history of changes made on the
system activity sheet such as:

Action
Requestor
Initiated On
Start Date
End Date
Status

v v v v v Vv

When you open the Master Rate Sheet, the Master Rate Sheet - Resource overlay page

opens.

The Master Rate Sheet - Resource overlay page contains the following toolbars:

Status Enables you to select to see which status to display on page. The options
are:
» Active
» Inactive
» Delete
View Enables you to select the items according to Resource or Role.
Print Enables you to print or export the items listed on the page.
Refresh | To refresh the list of items on the page.
Edit View | To change the view of the listed items on the page.
Search To search for a particular item.
Find on |To find an item on the page.
Page
Collapse |Enables you to collapse or expand the items on the page.
or
Expand

The Master Rate Sheet - Resource overlay page contains the following columns which provide

details about the resource:

ID
Name

Type

v v v v Vv

Status

The gear menu ( ¥ ) next to an item listed on the Master Rate Sheet - Resource enables you

to:

Currency

» Open Expand Row
» Collapse Row
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Master Rate Sheet Log: Toolbar Functions

Get Data is the only option available. Click Get Data to initiate the synchronization from the
Master Rate Sheet node to fetch the global roles and resources data from P6. Currency and
Rates are not imported on subsequent synchronizations. Only resource and role lists are
updated. Rates can be modified in the Master Rate Sheet.

The main grid of the log displays the Master Rate Sheet. The log columns are as follows:

» Name: Master Rate Sheet

» Description: Master list of Resource and Role. Not editable.

» Last Updated: Date when sheet was last updated via synchronization or manually.
» Created By: The user who initiated the synchronization.

The gear menu ( & ) for the Master Rate Sheet are:

» Open: Select to open the Master Rate Sheet.

» Export CSV: Use the options to export Role or Resource Rates as CSV. This comprises the
global list imported from P6. The structure includes the following information:

» Resource ID

» Resource Name

» Resource Type (Labor, Non-labor, Material)
» Status

» Effective From

» Price/Unit

» Update Data: Use the options to import the modified Role or Resource Rates CSV files in
order to update role and resource rates.

Note: You cannot modify the name and status fields in the import file.
The rest (ID, effective from date and price/unit) are all required fields.

Master Rate Sheet Log: Tabs

The right pane of the Master Rate Sheet log has the following tabs:

» Audit Log
» Schedule
» History

The Audit Log tab tracks all changes made inside the rate sheet.

The Schedule tab allows you to set the frequency of automatically running the Get Data
synchronization at daily, weekly, monthly or quarterly intervals between the specified start and
end dates. Possible values in the Status field are:

» Running
» Completed
» Failed
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The History tab captures information about manual/synchronization (schedule get data) job.
The toolbar has Refresh and Find of Page functions. When you click Refresh, Unifier refreshes
the History. This enables you to track the status of an ongoing synchronization. For example,
when you click Get Data, and switch to the History tab, and you see new record with
"RUNNING" (sometimes empty), then click Refresh to see the status changed to "Completed," if
the job is done.

The following rules are followed while synchronizing the Master Rate Sheet data with P6:

» If aresource/role has been removed from the global list in P6, the Master Rate Sheet
role/resource and corresponding rates will not change.

» If aresource/role has been added to the global list in P6, then the new role/resource is
added to the Master Rate Sheet along with its corresponding rates.

» If the resource/role exists in both P6 and the Master Rate Sheet, then the system updates
only the resource/role name, if applicable (using resource or role ID as the identifier).

Opening Master Rate Sheet

Click the gear menu ( ¥ ) to open and click Open to open the Master Rate Sheet. When
opened, the Master Rate Sheet displays as an overlay.

The Master Rate Sheet log window has the following toolbar options :

Status

View

Print

Refresh

Find on Page

Expand All or Collapse All

v v v v v Vv

The Status option enables you to assign one of the following standings on the sheet:

» Active
» Inactive
» Deleted

There are two default views available under the View option which enables you to switch
between views:

» Resource
» Role

The Master Rate Sheet log window has the following tab:
» Rates

The Rates tab provides Price/Unit, populated from P6. Click Create to manually add new
breakdown structure for the following:

» Cost Type
» Rate Type
» Price/Unit
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To add new values, click the Add icon (the plus + icon). When finished, click Save.

You can use a formula to establish rates based on other cost types. When you edit the cell
Price/Unit, a formula icon is displayed and when you select the formula icon a hew formula
window will be displayed.

Note: In Master Rate Sheet some Resources or Roles have incorrect
breakdown structure, but they are not assigned to any project. If the
Resources or Roles have correct breakdown structure in the project,
then the recost will work.

See Earned Value Management Attributes (on page 157) for details about column headings
and elements. Refer to the Unifier Data Reference Guide for details on each element.

Master Rate Sheet and Manual Activity Sheet

The Master Rate Sheet receives the resources and roles values from the source, for example
P6, and the standard rates.

A Master Rate Sheet is created by way of integration with P6, through gateway. When your
Master Rate Sheet is created by way of integration with P6 Unifier adds two fields to enable you
define the calendar for a resource or role, and the default number of units per day.

Similar to adding resources and roles to your shell activity sheet, you can add resources and
roles to your Master Rate Sheet, manually. When the resources and roles are integrated with
P6, the application compares the calendar name in P6 with the calendar name in Unifier.

» If the calendar names match, then Unifier assigns the calendar to the resource and role.

» If the calendar names do not match, then Unifier does not assign the calendar to the
resource and role.

You can define and maintain new rates for the resources and roles in the Master Rate Sheet.
The application uses this information across all the resource and role assignments in the System
Activity Sheet across all shells, based on the Master Rate Sheet assigned.

Unifier supports defining multiple activity sheets, and the Master Rate Sheet supports the
creation of resources and roles. In the Master Rate Sheet, you can define the standard rates
and rate breakdown structure.

In general, if you have permission, you can:

» Define resources and roles in the Master Rate Sheet.

Assign the resources and roles to the activities created in the custom activity sheets.

Define the calendar for a resource or role, and the default number of units per day.

Define the standard rates for the resources and roles defined in the Master Rate Sheet.

Provide a calendar and number of units per day for the resources and roles imported from

P6 and assign the resources and roles to the activities in manual Activity Sheets.

» Get the resource calendar for the resources or roles that are created from P6 (through
integration), if the calendar name matches the custom calendars.

4
4
4
4

Note: Existing Master Rate Sheet supports the creation of the resources
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and roles.

Manual Activity Sheets will allow the assignment of the resources and roles that are created
within Master Rate Sheet and the resources or roles that are integrated with P6. Once the
assignments are added, the resource costs will be calculated based on the type of activity,
whether it is task dependent or resource dependent.

View (Resource - User Defined)

The following toolbar options are displayed in the Master Rate Sheet Resource - User Defined
log:

» Add Siblings

Add Child

Status

Print

Refresh

Find on Page

Expand & Collapse (the plus or minus icon)

Menu (the icon with three horizontal lines)

v v v v v v Vv

You can add the resources by clicking the Add Sibling option. This action creates the first row
in the log which enables you to define the resource ID and Name. There will be a unique value
validation for both ID and Name when entering the value.

» The ID field supports only alphanumeric characters (max 50 characters).
» The Name field supports only alphanumeric characters (max 80 characters).

The manually added resource or role ID must be unique in the Master Rate Sheet, across the
views.

Add Labor Type Resource:

When adding a resource, you can select the type as Labor, Non Labor, or Material. By
default, the resource type will be Labor. You can switch between the types (from Labor to
Non Labor or to Material) for the existing resources in the Resource view.

Note: You cannot change the type, once the resource is assigned to an
activity sheet.
Currency:

You can select a currency by using the Currency field drop-down. The default currency
value will be the company default currency. The list of currencies displayed in the Currency
field drop-down will be from the Standards & Libraries.

Note: You cannot change the currency once the resource is assigned to
an activity sheet.

The tooltip for the currency will indicate that the currency that was selected for your resource
will be used in the custom activity sheets.

Units/day:

24



Working with Earned Value Analysis

You can select the default Units/day in this column. By default, 8 units per day is displayed,
but you can update the resource capacity to up to any of number of units per day. The valid
decimal value in this column is between 0 and 999,999.

The tooltip for the Units/day will indicate that the value for units, or time, selected for your
resource will be used in the custom activity sheets. The default value is 8:00 units per day.

Status:

The Status can be active or inactive. By default, the active status will be selected for a new
resource.

Add Non Labor Type Resource:

You can add a non-labor type resource by selecting the type as Non Labor. The creation of a
Non labor resource is similar to a Labor resource.

Note: The unit of measure is not applicable in the case of labor typ and
non labor type resources.

Add Material Type Resource:

You can create a material-type resource by selecting the type as Material. The Currency and
Calendar fields can be set for a material-type resource the same way that they are setto a
Labor resource. You can specify the unit of measure when creating a material-type resource.
The unit of measure (UoM) field will display a list of all of the unit of measures available under
Unit of Measure (Data Structure Setup > Data Definitions > Unit of Measure). The
administrator can set additional UoM.

Creating Master Rate Sheet

When you go to your Company Workspace (User mode) and click the Master Rate Sheet
node, the Master Rate Sheet log opens. If there is no existing Master Rate Sheet, and you have
the Create permission, then the Master Rate Sheet log displays the Create option enabling you
to create a new Master Rate Sheet.

Creating Master Rate Sheet Manually (Properties)

In the Master Rate Sheet log you can create a Master Rate Sheet either through the Get Data
integration or through the Create options.

Note: If a Master Rate Sheet is available and you click Get Data, then
the existing Master Rate Sheet will be updated with the latest data from
P6.

You can manually create a Master Rate Sheet in the Master Rate Sheet log if:
» There is no Master Rate Sheet defined and present in the log, and you have the Create
permission only.

In this scenario, once you click Create, the Master Rate Sheet Properties window opens
which enables you to enter a name and description for the Master Rate Sheet and click
Create in order to open the Master Rate Sheet window.
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» There is no Master Rate Sheet defined and present in the log, and you have the Get Data
permission only.

In this scenario, you click Get Data in order to proceed with manually creating a Master Rate
Sheet, by way of integration.

» There is no Master Rate Sheet defined and present in the log, and you have both the Create
and the Get Data permissions.

In this scenario, you click either the Create option or the Get Data option in order to proceed
with manually creating a Master Rate Sheet.

When the Master Rate Sheet log has an item (a Master Rate Sheet created through integration
or manually), the Master Rate Sheet log displays the item Name as "Master Rate Sheet" and
the item Description as "Master Sheet for Roles and Resources."”

The Master Rate Sheet log will also contain the following information:

» Last Updated
» Created By

When the Master Rate Sheet log has an item, or an item is created, the right-hand pane of the
screen will display the following tabs:

» Audit Log tab
» Schedule tab
» History tab

The Audit Log tab displays the current events through the Master Rate Sheet option when in
the View (when Resource - P6 or Role - P6 is selected).

This topic explains the Audit Log tab in the user-defined and P6 views for resources and roles.
Events such as Create, Update, and Remove of the resources and roles in a User Defined view
will be audited along with the existing audit log events for resources and roles received from P6.

When a resource or role is added through CSV import, only an entry per resource or role will be
added in Audit Log for each successful creation of a resource or role. The Audit Log entries of
the User Defined view for resources or roles are as follows:

Date Event Actio |Field Name Old New User Name
n Value Value

Date and Resource > |Creat | Resource > NA <NewV |<Logged in
Timestamp |<Resource e <Field or alue> |Username>
of the event |ID> or Role > Column
occurred <Role ID> Name> or Role

> <Field

Name>
Date and Resource > |Upda | Resource > <OldVa |<NewV |<Logged in
Timestamp |<Resource te <Field or lue> alue> |Username>
of the event |ID> or Role > Column
occurred <Role ID> Name> or Role

> <Field

Name>
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Date and Resource > |Delet |Resource > NA NA <Logged in
Timestamp |<Resource e <Field or Username>
of the event |ID> or Role > Column
occurred <Role ID> Name> or Role

> <Field

Name>
Date and Import Creat | Resource > NA <NewV |<Logged in
Timestamp e <Resource ID> alue> |Username>
of the event
occurred

The Audit Log entries (for updated resources or roles Received from P6) when you add or
update the values for the Calendar and Units/day fields are as follows:

Date Event Actio |Field Name old New User Name
n Value Value

Date and Resource > |Upda |Resource ID > |<OldVa |<NewV |<Logged in
Timestamp |<Resource ID |te Calendar lue> alue> |Username>
of the event |- Name> or
occurred Role > <Role

ID - Name>
Date and Resource > |Upda |Resource ID > |<OldVa |<NewV |<Logged in
Timestamp |<Resource ID |te Units/day lue> alue> |Username>
of the event |- Name> or
occurred Role > <Role

ID - Name>

You can enter values in the Schedule tab fields only if you have the Get Data permission. If you
create a Master Rate Sheet manually (using the Create option), then there will be no details on
the right-hand pane until the data is received from the source. If the Master Rate Sheet has data
coming from P86, then the right-hand pane shows both the Schedule and History tabs.

The History tab displays the following information:

Action
Requestor
Initiated On
Start Date
End Date
Status

v v v v v Vv

The column above contain the history of the changes made to the Master Rate Sheet.
Master Rate Sheet (View)

When you open the Master Rate Sheet, the following view options (View field) are available,
which enables you to select different views of the Master Rate Sheet:
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v v v v Vv

»

Note: To see the different views, you must have the Get Data and
Create permissions, and the Resources and Roles values are received
from P6.

Resource - User Defined
Resource - P6
Resource - All Sources
Role - User Defined
Role - P6

Role - All Sources

If the Resources and Roles values are not received from P6, then the following view options are
available:

4
4

Resource - User Defined
Role - User Defined

The following explains the various scenarios for the View options:

»

28

If the Master Rate Sheet is with an existing resources and roles received from P6, and you
(the user) have Create permission, then you can add resources using the options in the
toolbar. When you open the Master Rate Sheet, the View drop-down will display Resource
as an option. The Add Sibling and Add Child toolbar options will be displayed, for adding
resources in a hierarchy. You can switch between custom resources and roles and P6
resources and roles. The toolbar options will be updated based on the selected view.

If you select Resource - P6, then you can add or update the Rates, Calendar, and
Units/day columns for the resources and roles. Also, you can update the status of the
resource, from active to inactive or delete.
If the Master Rate Sheet is with an existing resources and roles received from P6, and you
(the user) do not have Create permission, then the Master Rate Sheet will only receive data
from P6, and the following View drop-down options will be displayed:
» Resource - P6
» Role-P6
In this scenario, the resources and roles will be received from P6, and they are read-only in
the Master Rate Sheet. You will be able to update or add standard and breakdown rates to
the resources and roles.
Notes:
» |f you select Resource - P6, or Role - P6, then the Units/day column will be
displayed.
= The resource calendar might not be displayed, depending on the version of Unifier
that you use.
= Unifier uses the Units/day column selected for the resource in manual activity
sheets to calculate units, when resources are assigned to activities.
If the Master Rate Sheet is without an existing resources and roles received from P6, and

you (the user) have Create permission, then when you create a, or open the, Master Rate
Sheet, the following View drop-down options will be displayed:

» Resource - User Defined
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» Role - User Defined

When you select Resource - User Defined, the toolbar will display options that enable you
to add resources. The Master Rate Sheet can be edited, for existing resources, if rates are
available. You can add new sibling, or child, resources, by using the gear menu ( ¥ ). The

cut, copy, and paste options are available for rearranging the resources.

You can drag-and-drop resources within the user-defined view.

» If the Master Rate Sheet is without an existing resources and roles received from P6, and
you (the user) have Get Data permission only, then when you create a, or open the, Master
Rate Sheet, the following View drop-down options will be displayed:

» Resource - P6
» Role-P6

» If the Master Rate Sheet is without an existing resources and roles received from P6, and
you (the user) have both Get Data and Create permissions, then when you can create a
Master Rate Sheet through one of the following methods:

a. Using the Get Data option from the Master Sheet log
b. Using the Create option
If the Get Data option is displayed, then the Create option will be disabled.

When you create or open the Master Rate Sheet, then the following View drop-down options
will be displayed:

» If you select the Get Data’ option, then the Create option will be disabled. If the Master Rate
Sheet is created in the log then the Create option will not be seen in the log. When you
create or open the Master Rate Sheet, the View drop-down will show the following options:

» Resource - User Defined
» Role - User Defined

Adding Resources

You can use the gear menu ( ) to add a hierarchy (Add Sibling and Add Child) of the
resources:

» Add Sibling: See the toolbar options, above.

» Add Child: See the toolbar options, above.

» Remove: You can delete the resources and roles that are no longer used. If you delete a
parent resource, then the child rows (under the parent) will be deleted.
When a resource is not used in a activity sheet, if you select on a resource and click
Remove, then all of the selected resources will be deleted.
When a resource is used in a activity sheet, if you select a resource and click Remove, then
the resource will be removed from the Master Rate Sheet and from all the activity sheets,
where this resource is associated. If multiple resources are selected and one resource is
associated to the activity sheet, then the resource will be removed from the Master Rate
Sheet and from all the activity sheets
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» Cut or Paste: You can select one or more resources, or roles, under a parent and select
Cut. When you paste the selected resources, or roles, at the destination, the selected
resources, or roles, will be removed from the original location and added to the destination,
as siblings for the selected resource. When you select a parent row, the child rows will be
selected; therefore, if you select Cut and paste the selection in the destination, then both the
parent and the child rows will be removed from the original location and added to the
destination.

» Copy or Paste: The copy and paste function is similar to the cut and paste function, except
that the rows selected will be copied into destination row and will not be removed from the
original location. When the row is pasted in the destination, by default the ID will be shown
as "Copy of <Source Resource ID>" and the Name will be "Copy of <Source Resource
Name>." The Paste option will not be shown in the gear menu until you select a new row
and click Cut or Copy.

Assigning Standard Rates, New Rates, and Rate Breakdowns

You can assign Standard Rate and Rate Breakdowns for the resources that were created
manually, or through CSV import, in the Master Rate Sheet.

Once the resource has been created, the right-hand pane displays the Rates tab which will
allow the creation of the Standard tab for the created resource.

The toolbar in the Rates tab, for the selected resource, will have the Create option. The Create
option, enables you to open a rate breakdown structure grid and define the standard rates and
rate breakdowns, by using the rate breakdown structure.

In the New Rate Breakdown window, you can add new rate breakdown, modify or remove an
existing rate breakdown, and you can define the rates per effective date. The Effective From
field, the New Rate Breakdown window, is editable and displays the current date. By default,
the row which shows the rate per unit with the effective data will show the latest effective date
that rate becomes active. The Code Type and the Rate Type fields (drop-down) display
Standard and Direct, by default. You can use the Price / Unit field to add rate.

You create a new rate breakdown by using a copy of an existing rate (right-click on a row and
select Copy). The generated grid title will be shown as the Copy of Rate Breakdown with the
effective date editable, and all of the existing rate breakdowns copied over. To complete creating
a new breakdown, click Save.

Master Rate Sheet Resource

The following explains:

» Master Rate Sheet: Resource - P6

» Master Rate Sheet: Resource - All Sources (resource generic)

Master Rate Sheet: Resource - P6

In the Resource- P6 view, all of the resources that are received from P6 will be seen. The
following resource fields are read-only:

Note: Depending on your Unifier version, you might not receive any
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calendars from the resource, when resources are integration by way of
gateway integration.

ID

Name
Type
Status
Currency

v v v v Vv

Also, two additional columns will be displayed:

» Calendar
» Units/day

The columns above are editable in this view.
By default:

The Calendar column will contain the calendar information that is coming from P6, if P6 has
a calendar with the same name. You can assign a user-defined calendar in the Calendar
column.

Note: The application does not receive calendars from a source when
resources are created through gateway integration.

The company calendar which is set as default will be assigned to all of the resources that are
created from P6. For Labor type and Non labor type resources, the default value of the
Units/day will be 8.00 units/day.

Master Rate Sheet: Resource - All Sources (resource generic)

In the Resource - All Sources view, all of the resources that are received from P6, and are
created in Unifier, will be seen. The following resource fields are read-only:

» ID
Name

4

» Type

» Status

» Currency

Also, two additional columns will be displayed:

» Units/day
» Status

The columns above are read-only in this view.

The values in the Source column will populate with the source of the resource created (User
Defined or P6).

All of the data seen in this view is read-only.

By default, the ID column will be sorted in ascending order.
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Master Rate Sheet: Role - All Sources

In the Role - All Sources view, all of the resources that are received from P6, and are created in
Unifier, will be seen. The following resource fields are read-only:

ID

Name
Source
Currency
Calendar

v v v v Vv

Also, two additional columns will be displayed:

» Units/day
» Status

The columns above are read-only in this view.

Adding Roles Manually
You can add user-defined roles in a similar way that you add the user-defined resources.

If you have the Create permission, when you navigate to View > Role, then Unifier displays a
toolbar option that enables you to add, update, or remove roles.

When you add a role, the values for the ID and the Name fields are required, and the value for
the Currency field will be USD, by default. You can change the role currency and the maximum
number of units per day. By default, the role status is set as Active.

Note: The system validates the uniqueness of the values in the ID and
Name columns in the role.

You cannot create a role with the same ID across all roles (user-defined, P6, or both). When you
define the role in the Role - User Defined view, the following columns show default values:

» Currency: Set to the company currency

» Units/day: Set to 8.00 units per day

» Status: Set to Active.

If you try to change role details such as ID, Currency, and so forth, you must assign the
standard rate and rate breakdowns for the custom roles. Once you create the role, the right

pane displays the Rates tab. In the Rates tab you can create the Standard tab for the created
resource.

When you click the Add Rate option, the Rate Breakdown Structure window opens. In this
window, you can define the standard rates and the rate breakdowns. You are able to define the
rate according to the effective date. By default, for the standard rate the cost type and rate type
will be Standard and Direct.

Adding Standard Rates and Rate Breakdowns

You can assign Standard Rate and Rate Breakdowns for custom roles.
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Once the role have been created, the right pane will show the Rates tab which will allow you to
create the Standard tab for the created resource. The Add Rate option, on the toolbar, opens
the Rate Breakdown Structure window. In the Rate Breakdown Structure window you can
define the standard rates and the rate breakdowns. You can define the rates per effective date.
By default, for the standard rate the cost type and rate type will be Standard and Direct.

You can add new or modify or remove existing rate breakdown and click Save to create a new
breakdown with different effective date.

You can edit the existing rate and effective date. By default, when you expand the row, the row
will display the rate per unit, with the latest effective date from which point the rate becomes
active.

You can create a new rate breakdown by copying (Copy From) an existing rate (a row). In this
scenario, a new rate breakdown grid will be displayed above the existing rate breakdown. The
grid title will be "Copy of Rate Breakdown," and the effective date is editable.

Importing Resources, Roles, and Rate Breakdown

You can create resources by way of CSV import. When you select Resource or Role as the
view, the Menu option will allow for import or export.

When you select Resource as the view, the following export options are available:
Export > Resource Template

Resource Rate Breakdown

The Resource Rate Breakdown option is available in the Menu option, for P6, Resource,
and Role views.

Import

Resource Rate Breakdown

The Resource Rate Breakdown option is available in the Menu option, for P6, Resource,
and Role views.

When you select Role as the view, the following export options are available:
Export

» Role Template
» Role Rate Breakdown

Import

» Roles
» Role Rate Breakdown

You can create resources in the custom view by using the Menu option Import > Resources.

When you select Export > Resource Template, Unifier exports the CSV template which lists all
of the columns that are seen in the Master Rate Sheet, along with the rate breakdown columns.

The following fields are required in the CSV template:

» Resource ID
» Resource Name
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If you do not provide values for the following fields, then the system uses the default value:

> Type

» Calendar
» Units/day
» Status

You will encounter an error if the CSV template that is being imported contains rows with the
same ID, when adding resources or roles by using the CSV template import.

You can import resources in a hierarchy by using ~~ (two consecutive tilde symbols) between
parent ID and child ID.

You need to include the entire path (for the ID) in the CSV template in order to be able to import
the resources or roles in a structure.

Ensure that you verify the validity of values in the following columns:
Type:
» Labor

» Non Labor
» Material

The default value is Labor.
Unit of Measure:

The default value is the value that has been set, as default, in the Unit of Measure field in the
Data Structure Setup.

» Status
» Active
» Inactive

The default value is Active.
Currency:

All of the currency symbols along with currency names that are available under the Standards &
Libraries > Currencies. Default value is company currency.

Units/day:
A valid decimal value (any number between 1 to 999,999).

Rate Breakdown Import

Note: The following fields are supported for Rate Breakdown Import
only. The following additional columns will be available for the rate
breakdown import, for existing resources and roles. More details are
available in the "CSV Import for Role and Resource Rates" topic. This
topic explains the import of resource and role breakdowns for the
Resources and Roles created in 'Resource' drop-down.

Effective date:
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It is a date only column and only dates are allowed. All the date-related validations will be
performed, according to the date preferences.

Price/Unit:
Any positive decimal value. The value cannot be a negative number.
The following columns are displayed in the exported Role Template:

» RolelID

» Role Name
» Currency
» Units/day
» Status

Only the Role ID and Role Name are required in the exported CSV template. The other columns
will take default values, if the values are not provided in the input CSV file.

You can import new resources using the downloaded CSV file. When creating resources
through CSV import, the resources are always appended to the existing resources in the
Custom - Resource view.

The following explains the CSV import validations:

You can enter ID in hierarchy by using: <Parent ID> ~~ <Child ID>.

You can verify the uniqueness for the ID when you are creating the resources/roles using
CSV import.

Unifier sorts the added resources/roles according to the column sorting.

When a resource is created through CSV import, the ID and Name fields will be required
fields and must have unique values. Additional columns like Currency, Calendar, Units/day,
and Status will show default values if no value is provided in the CSV file.

» When importing resources and roles, if the parent already exists, then the child will get
created. Similarly, you can import both parent and child together provided that the parent
only is in one row and a parent with child is in a separate row, in the input CSV file.

CSV Import for Role and Resource Rates

When you use a CSV file to export role rates or resource rates, the following additional columns
are added:

» Cost Type
» Rate Type

Use these columns to provide rate breakdowns.

When you use a CSV file to export role breakdown, the file shows the roles with existing
breakdowns, similar to the resource breakdown.

Note: You cannot import a role or resource without cost-type value or
rate-type value.

An exported CSV must show the cost-type and rate-type values, as they are required.
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Activity Manager

The Activity Manager node, or module, contains the following sub-nodes, when available:

» Activity Sheet
» OBS Sheet
» Rate Sheet
» WBS Sheet

To access the Activity Manager node:

1) Go to your shell in User mode.
2) Click Activity Manager node to expand.

The following table provides summary details about each sub-node.

Note: To view the Activity Sheet, or other sheets, you must have the

appropriate permissions.
You can create user-defined reports (UDRSs) from the Activity Sheet Data Elements (DES).
cost loaded schedule, we don't do any calculations in Unifier and use the data directly from P6.

The Activity Manager node contains the following sub-nodes:

Sub-node Description

name
Activity The Activity Sheet sub-node contains a list of activity sheets listed in the
Sheet Activity Sheets log window. You can have multiple activity sheets.

An activity sheet captures scheduling data from the mapped P6 projects
and role and resource rates from the company-level Master Rate Sheet
(default) or shell-level rate sheets, and calculates the Earned Values
metrics and derivatives. It is the primary source of data for the Earned
Value Analysis.

37



Earned Value Management User Guide

Sub-node Description
name
Rate Sheet | The Rate Sheet node captures the list of resources and roles (based on

the latest data available in activity sheet) and corresponding rates from
the master rate sheet.

In P6, users can assign a role, or resource, to an activity under the
Assignments tab of an activity for any project. In P6, rates are assigned to
a role or resource at global level. To maintain the consistency, we will
import the P6 global data to Unifier company workspace. This data will be
captured under a new entity called Master Rate Sheet. The rate sheet
being created through P6-Unifier integration will be saved as 'Master Rate
Sheet' under a new node in company workspace called Master Rate
Sheet.

The rates (Price/Unit) for assigned roles and resources are managed at
global level in P6, which can then be used in a project while doing the
costing (calculating Present Value, Earned Value, etc.) of the project
depending on the rate source (resource, role or override) corresponding
to that assignment in an activity.

For a resource loaded schedule, we need rates corresponding to roles
and resources for costing of any project in Unifier. There will be two types
of rate sheets:

» Master Rate Sheet (at company workspace)
» Rate Sheet (at Shell) explained in the subsequent sections.

A company will only have one Rate Sheet called the "Master Rate Sheet."
So, users are not allowed to create a copy sheet of the Master Rate
Sheet under company workspace. This sheet will contain rates for both
roles and resources, users will be able to toggle between resource and
role rates from the display. By default, the rates present in master rate
sheet will be used across all the resources and roles present in all activity
sheets across all shells unless user has assigned another rate sheet
present at the shell level to the activity sheet/project.

Refer to the Unifier Earned Value Management User Guide for details.
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Sub-node
name

Description

WBS Sheet

A WBS Sheet (Work Breakdown Structure sheet) contains the following
information:
» Planned Units
Planned Total Cost
Actual Units
Actual Total Cost
Remaining Units
Remaining Total Cost
At Completion Units
At Completion Total Cost
The WBS Sheet node log displays the only available WBS sheet.
Refer to the Unifier Earned Value Management User Guide for details.

v v v v v v Vv

OBS Sheet

An OBS Sheet (Organization Breakdown Structure sheet) contains the
following information:
» Full Name
Short Name
Unifier User
Title
Department
Status
WBS Name
Contract No
Weekly Capacity
The OBS Sheet node log displays the only available OBS sheet.
Refer to the Unifier Earned Value Management User Guide for details.

v v v vV vV v v Vv

This chapter provides information about the System Activity Sheet. For information related to
the manual activity sheets refer to the Unifier Managers User Guide.
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Activity Sheet Sub-Node: Activity Sheets Log and System Activity Sheet

The Activity Sheet sub-node contains a list of activity sheets, including the System Activity
Sheet, and they are all listed in the Activity Sheets log window.

You can use an activity sheet to capture the scheduling data from P6 or Primavera Cloud. A
single activity sheet (called System Activity Sheet) is mapped to multiple source projects, by
way of integration.

The source project (P6 Project) drop-down field is visible at the top of the system activity sheet
as, "<Source name> Project : <Project ID>." The source project drop-down contains a list only if
the activity sheet received activity data from multiple source projects. The link to the source
project is base on the source URL (provided in the company properties). Also:

When connected to P6 or Oracle Primavera Cloud applications:

» |f the selected project is open in the application, then the data for the
corresponding project (along with other projects, if they exist) is displayed.

= |f a project other than the selected project is open in the application, then only the
data for the project other than the selected project is displayed. In this scenario,
the data for the selected project is not displayed.

» |f no project is selected in the application, then the Open (projects) window is
displayed that enables you to select the project for which you want to view the
schedule

When not connected to P6 and Oracle Primavera Cloud applications:
The source application login page is displayed.
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You have the option to view the activities (from the mapped source projects) by using the project
drop-down field which contains a list of all source projects mapped to your shell.

The Activity Manager enables you to create, consolidate, and monitor activities that must be
completed on a schedule.

You can have multiple activity sheets.

A System Activity Sheet captures the scheduling data from the mapped P6 projects and role
and resource rates from the company-level Master Rate Sheet (default) or shell-level rate
sheets, and calculates the Earned Values metrics and derivatives. A System Activity Sheet is
the primary source of data for the Earned Value Analysis.

After P6-Unifier integration has been run and P6 projects mapped in the Integration tab of shell
details, a single System Activity Sheet can be created in the Activity Sheets log of the shell
(Shell > User mode > Activity Manager > Activity Sheet > Activity Sheets log).

Each P6 project is associated with a baseline project sheet and a current schedule project
sheet. The activity sheet allows you to switch between baseline and current project types and
view the specific scheduling information - activities, assignments, dates, and so forth.

Once produced, the baseline project sheet cannot be altered; however, you can update the
current project sheet, per Data Date.

If you update the project baseline in p6, then the project baseline will get updated in Unifier
(when running the sync by selecting the Baseline option for the respective project).

P6 projects in the System Activity Sheet are classified as:

Project Description
Classification
Duration The Duration Based projects bring activity duration data only. They do

Based projects | not include resource assignment or cost related information, and are,
therefore, not available for Earned Value analysis.

Resource The Resource Loaded projects load duration and resource
Loaded assignment information but not cost related information from P6. You
projects can assign a rate sheet and costing to calculate resource costs in the

projects. After costing is completed, they are available for Earned
Value analysis.

Cost Loaded |The Cost Loaded projects bring duration, resource assignment, as
projects well as cost information from P6. No further cost calculation is
necessary. You can directly use the Earned Value module for cost
comparisons and analyses in these projects.

After integration, the data brought in to the System Activity Sheet are constrained by project
categories, and the constrains govern the behavior of the System Activity Sheet.

The following explains the Activity Sheets log elements, followed by information specific to the
System Activity Sheet.
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Activity Sheets Log and System Activity Sheet

The Activity Sheets log lists the activity sheets which capture project scheduling data coming
from P6.

To access the Activity Sheets log, go to the shell (User mode), click to expand the Activity
Manager module, and click Activity Sheet sub-node.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the Activity Sheets log to access your System Activity Sheet.

Note: In the Activity Sheets log, if you open an activity sheet that has
more than 1000 activities, then the system will take time to prepare the
list.

Activity Sheets Log (Toolbar Options)

If you have the Create Manual Activity Sheets permission, or the Full Access permission (see
the Activity Sheet in Shell (User Mode) Permissions topic in this document), then the toolbar
options in the Activity Sheets log are as follows:

Toolbar Description
Option
Create Enables you to create new activity sheets. This option is enabled when the

user has at least the Create permission for the manual activity sheets.
The Create option has two additional sub-options to support the manual
creation of an activity sheet and creating an activity sheet from Activity
Sheet templates (when the Activity Sheet templates is made available in
the admin mode).

When you click Create, Unifier checks for manual activity attribute form, if
a system activity sheet has been created by using the system activity
sheet attribute form.

If there is no system activity sheet attribute form defined, or there is no
manual activity attribute form, in the design, then the application uses the
canned form for the activities in the activity sheet.

An activity attribute form must be defined in order for you to be able to
create custom activity sheets. If a system activity attribute form is defined
in uDesigner, but there is no manual activity attribute form, then Unifier
displays this message: Activity attribute form must be defined
in order to create custom activity sheets.
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Toolbar Description

Option

View Enables you to select how to view the list of the activity sheets that are
available.

To be able to see any activity sheets in the Activity Sheets log, you must
have the View permission, or above.

The View drop-down field displays the following out-of-the box, or default,
options:

All

To display all of the activity sheets.

Active

To display all of the activity sheets with active status. Available if there are
activity sheets in the log that have active status.

Note: The System Activity Sheet will be active (Status) at all times, and
the status cannot be changed.

Actions To set permissions and import options:
Permissions

To assign a rate sheet to the activity sheet:
Assign Rate Sheet

To assign activity sheet-level permissions similar to the record-level
permissions set for the non-Workflow BPs.

Import (Microsoft MPP or P6XML)
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Toolbar Description

Option

Get Data |Enables you to create a System Activity Sheet for the first time, or update
] an existing Activity Sheet with the most recent data from P6.

Get Data | The Get Data synchronization that created the activity sheet also

into populates the activity sheet with the:

System » Scheduling data (activities along with assignments and spread data)
Activity from the P6 projects mapped to the current shell in the Integration
Sheet tab.

» Role and resource rates data from the Master Rate Sheet for the
mapped projects.

Subsequent updates of Role and Resource Rates in P6 will not trigger the
updates in the Master Rate Sheet; however, subsequent updates of CBS
Code for activities in P6 will trigger the updates in the Activity Sheet CBS
assignments.

The Get Data option will be enabled when you have the Get Data
permission at the node level in the Permissions tab. This option enables
you to receive the schedules from P6 or Primavera Cloud based on
synchronization selected in Gateway settings.

Use the Get Data option to:
» Create an activity sheet for the first time.

» Update an existing activity sheet with the most recent activity spread
data from the Oracle Primavera Cloud project.

Updating an existing activity sheet triggers a new OOTB import
synchronizations if you have selected the Select Synchronization to
Exchange Activity Data option in Gateway integration settings drop-down
list.

All of the synchronized Oracle Primavera Cloud project activities, planned
dates, actual, at completion dates, and associated WBS Code will be
displayed in the activity sheet.

Note: A WBS code assignment is applicable to only manual activity sheet;
whereas, a CBS code assignment is applicable to both manual and
system activity sheet.

If the shell is not active (inactive shell), then Gateway integration will fail.

When you select Get Data, the system checks for the Oracle Primavera
Cloud project that as defined in the Integration tab and then brings the
Oracle Primavera Cloud project activity data and their schedules into the
activity sheet based on the import synchronization defined in Gateway
settings, and if Oracle Primavera Cloud and Unifier projects are linked.

If you select Get Data and there is no Project ID added in the Integration
tab, the system will display this message: Valid Project ID is not specified
in the Shell Integration Tab.

The system does not bring the baseline (project data) from Primavera
Cloud.
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Toolbar Description

Option

Send Data |Enables you to send data from Unifier to P6. This will trigger the

> synchronizations at Gateway level.

Send Data | The Send Data option will be enabled when you have the Send Data
from permission at the node level in the Permissions tab. This option enables

System you to receive the schedules from P6 or Primavera Cloud based on
Activity synchronization selected in Gateway settings.

Sheet Use the Send Data option to run the export synchronization in order to
send the updated activities and schedules from Unifier Activity Sheet to
the Oracle Primavera Cloud.

The data elements in the business processes, or the shell attribute form,
which have been set to reverse auto-populate (RAP) back to the Oracle
Primavera Cloud Activity Sheet (using P6 Activity Picker) will get the latest
updates into the Oracle Primavera Cloud Activity Sheet.

You can send the updated Activity Sheet data (such as: updated Actual
Start Date or Finish Dates) to the Oracle Primavera Cloud project which is
linked by way of the OOTB export synchronization option: Update Unifier
Activity data in to Primavera Cloud.

The Schedule tab, in the Activity Sheet log, shows this option, and you
can set the scheduled send data based on frequency.

Before the initial synchronization, the Get Data is the only toolbar function
available in the log. Click Get Data to initiate synchronization and create
the Activity Sheet.

Refresh To retrieve the latest number of activity sheets created in the log.

Print To print the log contents into HTML, CSV, or Excel formats.

Find on To search in the log.
Page

If you do not have the Create Manual Activity Sheets permission, or the Full Access
permission, then the toolbar options in the Activity Sheets log will not display the Create option.

Activity Sheets Log (Columns)

The Activity Sheets log contains the following columns:

» Refresh

A refresh icon will be displayed in this column if the activity calendar is edited in the following
areas:

=  Working and Non-working days
=  Working hours
= Start time of working day

Use the Refresh toolbar option to update the sheet based on the new calendar values. The
refresh will be captured in the History tab of the sheet.
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» Name

The name of the manual activity sheet.
» Description

The description for the manual activity sheet.
» Source Type

To show whether the source for the manual activity sheet is standard, project or shell, or
custom.

Note: The Source Type for a System Activity Sheet is P6.

» Status
To show whether the manual activity sheet is active, or not.
Last Updated On
Creation Date
Created By

Activity Sheets Log (System Activity Sheet Gear Menu)

Go to the shell (User mode) > Activity Manager module > Activity Sheet node to open the
Activity Sheets log which lists the System Activity Sheet as well as the manual activity sheets.

The System Activity Sheet, listed in a row in the log, has a gear menu ( % ) which enables you
to open (Open) the System Activity Sheet.

Activity Sheets Log (System Activity Sheet Properties Tabs)

In the Activity Sheets log, when you click and select the System Activity Sheet, the following
properties tabs appear in the right pane:

» Mapped Projects tab

» Schedule tab

» History tab

The following describes the tabs listed above.

Mapped Projects tab
Toolbar options

» Assign Rate Sheet

To select Planning and Actuals specifications. You can select a rate sheet from the list
and specify the project to which the rate sheet will be assigned (from the Project).

» Recost

To roll up the CBS costs (Cost Loaded), or to re-calculate all costs (Resource Loaded). It
enables you to perform the cost calculations in an activity sheet, for type selected (i.e.,
current schedule or baseline schedule).

» Refresh
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To refresh the Mapped Projects tab log items.
» Find on Page
To find a particular project in the Mapped Projects tab log items.

Columns

» Project ID

» Project Name

» Project Type

» Project Start Date

» Data Date

» Schedule Type

» ETC Techniques

» Rate Sheet (Planning)
» Rate Sheet (Actuals)

Schedule tab
The Schedule tab enables you to:

» Set Frequency for
Set frequency for getting data or sending data (Set Frequency for).
» Frequency
Select the time frequency.
» Start Date
Set the start date.
» End Date
Set the end date.

History tab

The History tab enables you to see a history (the history of all events that have been performed
across project sheets present in the activity sheet) of changes made on the system activity
sheet.

Toolbar options

» Refresh

» Find on Page
Columns

» Action

» Requestor

» Initiated On

» Start Date

» End Date

» Status
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When you click on a item in the History tab, the History Details split screen appear at the
bottom of the page which provides more details about the selected item.

Mapped Projects Tab (System Activity Sheet)

The Mapped Projects tab lists the P6 projects drawn from the Integration tab of shell details
into the Activity Sheet.

The Mapped Projects tab toolbar options are:
The toolbar options are:

» Assign Rate Sheet
See below for details.
» Recost
See below for details.
» Refresh
» Find on Page

Use the toolbar options to assign a shell-level rate sheet to selected projects, recost resource
loaded or cost loaded projects, refresh page, and find an item displayed on the page
respectively.

The Mapped Projects tab columns are:

Project ID

Project Name

Project Type: The values are Current or Baseline

Project Start Date

Data Date: The date a project is updated in P6

Schedule Type: The values are Duration, Resource, or Cost

ETC Technique: The formula used to calculate the Estimate to Complete. For example: PF =
1/CPI; PF = 1; (1/CPI)*(BAC - EV); 0.75 * (BAC - EV)

v v v vV vV v Vv

Note: When entering the percentage values in your sheet, if you are
working in Classic View, then enter the value by using decimal number
format. For example, for ten percent, enter: 0.1, and if you are working in
Standard View, then enter the value by using percent format. For
example, for ten percent, enter: 10%. The value that Unifier uses to
validate the value of the Percentage column, when applicable, will be:
0-100.

» Rate Sheet (Planning): The Master Rate Sheet or a shell-level rate sheet used to calculate
the costs.

» Rate Sheet (Actuals): The Master Rate Sheet or a shell-level rate sheet used to calculate
the costs.

Assign Rate Sheet

When you click the Assign Rate Sheet sub-tab, the Assign Rate Sheet window opens which
contains the following fields:

48



Working with Earned Value Analysis

» Planning
» Actuals

You can click the Select icon ( ...... ) to open the Select Rate Sheet window and select a sheet.

By default, the resource and role rates in the activity sheet are retrieved from the Master Rate
Sheet and applied across all the projects. If you have created shell level rate sheets, you can
assign a rate sheet to one or more projects.

1) Select one or more projects in the tab.

2) Click Assign Rate Sheet to open the Assign Rate Sheet window. The Assign Rate Sheet
window has the following options:

a. Planning

If you are familiar with the rate sheets in the shell, you can click the drop-down arrow to
select a rate sheet, or Master Rate Sheet, as the source. If you need more details about
the rate sheets, click the select icon (next to the drop-down arrow) to open the Select
Rate Sheet window and review the details of the available rate sheets before selecting.

Alternatively, you can enter the name of the rate sheet in this window that you want to
use to calculate the respective cost.

b. Actuals

If you are familiar with the rate sheets in the shell, you can click the drop-down arrow to
select a rate sheet, or Master Rate Sheet, as the source. If you need more details about
the rate sheets, click the select icon (next to the drop-down arrow) to open the Select
Rate Sheet window and review the details of the available rate sheets before selecting.

Alternatively, you can enter the name of the rate sheet in this window that you want to
use to calculate the respective cost.

3) Click Assign (or click Cancel to exit without making any changes).

Note: An alert “No Rate Sheets to Assign” is displayed if no rate sheets
exist. You can Assign Rate Sheet only to Resource-loaded projects in
the Activity Sheet.

The role and resource rates are applied to the activities/assignments in the selected projects,
when refreshed. You must perform Recost in order to apply rates from the new assigned rate
sheets.

When a different rate sheet is assigned to a project, Unifier displays the following alert message:
Perform Recost to see updated costs.

Recost

The Recost sub-tab enables you to perform the cost calculations in an activity sheet, for type
selected (i.e., current schedule or baseline schedule). Upon initiating this option, Unifier
refreshes the rates for Price/Unit for each assignment, based on the rate source from the rate
sheet assigned using the latest rates present. The field will be updated (or used) in recost
according to the following rules:

» If the rate source is Resource, then the system gets the corresponding data from the
resource rate sheet.

49



Earned Value Management User Guide

» If the rate source is Role, then the system gets the corresponding rate from the role rate
sheet.

» If the rate source is Override, then the system updates the Price/Unit and uses the Price/Unit
for the respective assignment present in the Activity Sheet.

This functionality applies to Resource loaded projects. Recost for Cost-loaded Projects also
takes care of applying the exchange rates for Cost fields if P6 Currency is different than Unifier
Company Currency or Shell Currency. Use Recost to perform cost calculations in the Activity
Sheet for the schedule type selected (current or baseline).

Note: Recosting cannot be performed on Duration-based projects.

The Recost action must be manually triggered by the user after the following actions are
performed in the Activity Sheet, or the Rate Sheet:
Assigning CBS
This option can be used to assign a CBS code to a resource and/or role. Select Assign
CBS and select a code in the CBS field.
Assigning Rate Source
Select Assign Rate Source to assign a rate source to an assignment.
The Rate Source drop-down list has the following options:
- Resource (default)
- Role
- Override
Assigning Price/Unit

Unifier updates the rates for price/unit of each assignment after retrieving them from the
corresponding source fields in the rate sheets as follows:

- If the rate source is Resource, the data is fetched from the Resource Rate Sheet.
- If the rate source is Role, the data is fetched from the Role Rate Sheet.
- If the rate source is Override, the Price/Unit data is not refreshed.

- In this case, you must manually specify the value. To do so, click Rate Source and
follow the prompts. The Assign Rate Source is only applicable for Resource-loaded
projects.

The system rolls up the assignment values to calculate values at the activity level.
Updating Data in actions button inside the activity sheet.
Changing Rates for any of the resources/roles in the Rate Sheet, in case the resources/roles
are referred in Assignments.

By default, the Master Rate Sheet is used to perform costing; however, if a shell level rate sheet
is assigned, then values are derived from it instead.

When you activate recost, the following fields (within activities and assignments) are refreshed
using the spread data and rates from the assigned rate sheet.

See the following topics for details:

» Recost - Activity Attributes (on page 157)
» Recost - Assignment Attributes (on page 161)
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The values are taken from the baseline or the corresponding baseline values from the current
schedule.

The activity attributes are re-calculated by using the spread data and rates from the assigned
rate sheet.

The corresponding values at the activity level are calculated by rolling up the values from the
assignments.

Note: For recosting, if price/unit and resource/role rates are not defined
in the Activity Sheet, a default value of 0 is used, and a warning is
displayed. If the values are defined, then the project currency is used for
the calculations. The rate is multiplied by the number of units to get the
cost.

Unifier applies the following logic to recosting:

The calculations are triggered while doing re-costing for the Activity Sheet. Once the application
receives all the rates, it proceeds according to one of the following scenarios:

Scenario One

Resource Currency = Company Currency = Shell Currency
No changes are required.

Scenario Two

Resource Currency <> Company Currency = Shell Currency

The application calculates all the spread data (currency fields) that is present in the Activity
Sheet (in the company currency) by using the resource/role rates applicable at each spread
Data Date field.

If the resource rate currency is different from the company currency, then the exchange rate
will be applied at each spread Data Date field to calculate the spread data.

The spread data will then be rolled up to the respective currency field.
These calculated values in the company currency are used to calculate any dependent field
(for example, CPI, SPI, etc.) as part of recosting.

Scenario Three

Resource Currency = Company Currency <> Shell Currency

Unifier calculates all the spread data (currency fields) that is present in the Activity Sheet (in
the company currency) by using the resource/role rates applicable at each spread Data Date
field.

The spread data will then be rolled up to the respective currency field.

These calculated values in the company currency are used to calculate any dependent field
(for example, CPI, SPI, etc.) as part of recosting.
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Note: Only Scenario Three is applied to the cost-loaded.

The values in the shell currency will be calculated by using the applicable exchange rate for
that shell currency at each spread Data Date field for all currency fields. The system uses
these values to calculate any dependent field (for example, CPI, SPI, etc.) as part of
recosting.

Note: Despite being in the Activity Sheet user interface, you can only
see the Activity Sheet data in the Shell currency.

Scenario Four

Resource Currency <> Company Currency <> Shell Currency

Apply the steps indicated in Scenario Two and then apply the steps indicated in Scenario
Three.

Schedule Tab (System Activity Sheet)

The following fields are available in the Schedule tab:

Set Frequency for

Set the frequency of synchronizations to automatically get data from P6 or send data from
Unifier at daily, weekly, monthly, or quarterly intervals (Frequency).

Start Date and End Date

Define the start and end dates for the scheduled syncs.

Note: The Schedule tab will be seen for the users who have full access
permission to the Activity Sheet sub-node.

History Tab (System Activity Sheet) and (Manual Activity Sheet)

The History tab, for both the system and manual activity sheets, displays the history of all
scheduled jobs that are performed across the projects included in the Activity Sheet. The toolbar
has the Refresh and Find on Page options. The columns include:

»

v v v v Vv
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Action

Displays actions related to Get Data, Send Data, Recost, and Cost Roll up
Requestor

Initiated On

Start Date

End Date

Status

Displays Failed, Running, or Completed
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Creating System Activity Sheet

The System Activity Sheet (P6 or OPC) is used to calculate ETC or EV. The Get Data option is
used for System Activity Sheet.

The System Activity Sheet can be created using the following synchronizations:

» Get Activity data from P6
» Get Activity and Assignment data from P6 for EVM
» Send Primavera Cloud Activity data to Unifier

Note: For an activity sheet, the blocks and fields on the right-hand pane
can differ based on the synchronizations.

You have the option to view activities present in a P6 Project mapped to Unifier Shell, in the
Activity Sheets log, by selecting the corresponding P6 Project ID in the Project drop-down
present inside the Activity Sheet log, when you open the system activity sheet from the Activity
Sheets log.

The Project drop-down will contain the list of all P6 projects mapped to the shell and selecting a
project from this drop-down will load the respective scheduling data (activities) in the Activity
Sheets log.

A project in P6 can be a current schedule project or a baseline schedule project. Over the
project life span, a user can create multiple baseline projects which are mapped to a current
schedule project.

While sending data from P6, a baseline project sheet is created for the Project baseline (and not
for Primary baseline, Secondary baseline, or Tertiary baseline, etc.). As a result, every project
from P6 will have a baseline project sheet and current schedule project sheet (which will have
the scheduling information i.e. activities, assignments, etc.).

If a P6 project has only current schedule, then the system treats the planned data in current
schedule as the baseline.

The project sheets, which are created by way of integration, are grouped under a single activity
sheet that can be selected to perform Earned Value (EV) analysis.

The fields related to costing can be updated in Unifier and re-costed for a resource loaded
schedule.

You can assign a rate sheet to a resource-loaded projects present in the Activity Sheet log,
when you open the system activity sheet from the Activity Sheets log, but if you want to
perform an operation at the project sheet level, then you can open the activity sheet, select the
project and schedule type, while working on the activity sheet.

To create a System Activity Sheet, go to the Activity Sheets log window, click Get Data to
open the Get Data window.
1) Choose one of the following options:

a. Click to select the All Projects field and populate the field box with all available projects.
You can use the x in front of the project name to remove it from the field box.

b. Click the field box to see the list of projects and then click on the project that you need.
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2) Select the project type: Type. You may have to scroll down, if you select all projects.
3) Click OK to apply your selection and close the window.

When the Activity Sheets log window opens, you will see the following additional options on the
toolbar:
» Send Data: Use this to send activity sheet data to the projects in P6. This will trigger the
synchronizations at Gateway level.

To learn how to create a manual activity sheet, refer to the Unifier Managers User Guide (User
Help).

System Activity Sheet Log Default

The Activity Sheets log captures project scheduling data coming from P6 or Primavera Cloud
(OPC). A single System Activity Sheet, in Unifier, will be mapped to multiple project schedule
sheets, which are created by way of integration.

When you open the System Activity Sheet, (<shell> > User mode > Activity Manager node >
Activity Sheet sub-node > Activity Sheets log > System Activity Sheet > gear menu > Open)
that is created by way of integration with P6, or Primavera Cloud, it will list all of the activities in
the Activity Sheet log. The log, the list of all activities are displayed in a flat grid.

The log (named Activity Sheet in the image, below) enables you to set up the log to show either
the baseline project view, or the current project view (from the top right corner of the log. The link
to view the baseline project is displayed next to the source project (top right-hand), where you
can select the link to view the baseline data for the selected source project. If there are no
baselines received for the selected source project, then this link is not displayed.

The log has the following toolbar options:

Actions

View

The Default view shown in the image, below. You can use the View toolbar option to:
» Create New View

» Manage Views

Edit View

Refresh

Print

Find on Page

Menu Options

Use this toolbar option to export activities or assignments, import CBS code for activities or
assignments, or color the rows.

» Gantt

The log has the following fixed columns:

v v v v Vv

» Sequence No.
» Activity ID
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» Activity Name

All of the other columns seen in the grid are in the same order as showing the activity attribute
form. The column labels are derived from the activity attribute form.

When you select an activity in the log, the following properties tabs will display:

» General

» Assignments
» Activity Spread
» Audit Log

The following topics explain the elements of the log.

System Activity Sheet Log Toolbar options

There are two sets of toolbar options based on the following project schedule types:

» Current project view
» Baseline project view

The following explains the toolbar options for each project schedule type.

Current Project View
The current project view of the log has the following toolbar options:

» Actions
This option is available in the current project view log, only.
» Apply CBS Code to All Assignments
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Using this option enables you to apply the CBS Code assignments to all of the resources

associated to the highlighted activities. You can also use the gear menu ( ¥ ) option
"Apply CBS Code to all Assignments" to highlight multiple activities and apply the
same CBS Code to the assigned resources.
» View

Within the System Activity Sheet, the default name of the view is Default.

» Default
The default view is not editable.
You can create new views based on the default view, when editing the view settings. This
is similar to the default view available in WBS Sheet.

» Create New View
Use this option to create a custom view. Custom views appear in the View list.

» Manage Views
Use this option to reorder, show or hide views, and delete custom views.

Note: Any existing views that were created prior to the 20.10 upgrade
will not be seen in the View drop-down field.

» Edit View

Enables you to select which columns to be displayed or remain hidden, apply filters, group
and sort by available fields and to save custom views.

» Inthe Columns tab, add/remove/reorder columns in the default view. You can save as a
custom view.
» In the Filter tab, add conditions to filter the results of a column.
» Inthe Group By tab, create or modify groups using column elements. For example,
activity status.
» Inthe Sort By tab, define the sorting order (Ascending or Descending) of columns.
» Refresh
To update the information displayed on the screen.
» Print
» Export To CSV
» Export To Excel
» Find on Page

To filter results displayed on the screen. In any column, begin typing in the field below the
header to trigger results.

» Menu Options

All of the actions related to the export of the activities and the assignments, and the import of
the CBS Code assignments to the activities and the assignments, can be done by way of the
Menu (the icon with three horizontal lines), on the right-hand side of the window.

» Export
= CSV Template for Activities
= CSV Template for Assignments
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= All Activities

= All Assignments

= Audit Log
» Import

= CBS Code for Activities

= CBS Code for Assignments
» Row Coloring

= Multi-Color

= Single-Color

Baseline Project View
The baseline project view of the log has the following toolbar options:

> View
Within the System Activity Sheet, the default name of the view is Default.
» Default
The default view is not editable.

You can create new views based on the default view, when editing the view settings. This
is similar to the default view available in WBS Sheet.

» Create New View
» Manage Views

Note: Any existing views that were created prior to the 20.10 upgrade
will not be seen in the View drop-down field.

Edit View

Refresh

Print

» Export To CSV
» Export To Excel
Find on Page
Menu Options

All of the actions related to the export of the activities and the assignments, and the import of
the CBS Code assignments to the activities and the assignments, can be done by way of the
Menu (the icon with three horizontal lines), on the right-hand side of the window.

» Export
= CSV Template for Activities
= CSV Template for Assignments
= All Activities
= All Assignments
= Audit Log
» Import
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= CBS Code for Activities

= CBS Code for Assignments
» Row Coloring

= Multi-Color

= Single-Color

System Activity Sheet Log Columns

The following explains the columns in the Activity Sheet log (System Activity Sheet

4

v v v v v Vv

v v v v v Vv
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Sequence No.

This is a read-only column, with a sequential number starting from 1 (one).

The numbering sequence of activities. The column cells are pre-populated with the sequence
number provided in the activity sheet properties. The sequence number is a unique value.
This column displays the row number and errors, if any.

To select an activity, click inside the corresponding Sequence No. cell.

Note: The task icon should be populated in this column for a particular
Activity ID. The color of the task icon is blue for 'Not Started' activities.
Similarly, the color of task icon will be orange for 'In Progress' activities,
and green for 'Completed' activities.

Activity ID

Activity Name

WBS Path

WBS Code

WBS Name

CBS Code

The CBS Code column is an editable column, for all of the activities, and the picker is
displayed when you double-click the CBS Code column cell.

You can assign the CBS codes to the activities by selecting the picker, or by using the
type-ahead functionality. You can assign a single CBS code to multiple rows by dragging.

The CBS code initially assigned to an activity automatically assigns the same CBS code to
all of its resources. Unifier does not push to the resources any subsequent updates of the
CBS code, at the activity level.

You can assign the same CBS code to multiple activities by selecting multiple consecutive
cells, in the CBS Code column, and adding a CBS code. Similarly, you can remove a CBS
code assignment by selecting the Clear option in the picker column.

Activity Type
Activity Status
Activity % Complete
Planned Start
Planned Finish
Planned Duration



Working with Earned Value Analysis

Currency amount
Planned Total Cost
Actual Start

Actual Finish

Actual Duration

Actual Total Cost
Remaining Early Start
Remaining Early Finish
Remaining Duration
Remaining Total Cost
Start

Finish

At Completion Duration
At Completion Total Cost
Secondary Constraint

VvV VvV vV vV vV vV vV vV VvV VvV vV vV v v v

The Activity Sheet overlay page has columns that provide more details such as:
Activity ID

Activity Name

Activity % Complete

Activity Status

Activity Type

The following provides details about the columns:

Control Accounts (Editable)

v v v v Vv

This is Unifier specific field and is editable in the tab. This can also be updated using import
CSV. The accepted values are Yes/No.

Activity ID

This is a unique identifier of the activity. In order to identify and track activities, P6 assigns each
activity a unique Activity ID that is the result of joining the Activity ID Prefix with the Activity ID
Suffix and then adding an Increment value. For example, a prefix of PROJ-A# combined with a
suffix of 2500 and an Increment of 5 will yield the following activity IDs: PROJ-A#2500,
PROJ-A#2505, etc.

Type
Determines how duration and schedule dates are calculated for an activity.

Task Dependent:

Activities are scheduled using the activity's calendar rather than the calendars of the
assigned resources. Choose task dependent when you want to control the duration of the
activity yourself (that is, no resources are assigned), or when one or more resources
assigned to the same activity can work according to the same calendar.

For example, you might have an activity to cure concrete; you know how long the task takes
and the addition of resources won't complete the task any earlier. You would designate this
activity as task dependent.
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Resource Dependent:

Activities are scheduled using the calendars of the assigned resources. This type is used
when several resources are assigned to the activity, but they might work separately. Choose
resource dependent when you want to schedule each resource according to his/her own time
schedule, or resource calendar, not the activity calendar. The assigned resource availability
determines the start and finish dates of the activity. Typically, you use this type when multiple
resources assigned to the same activity can work independently, or when availability can
affect the activity's duration.

For example, an activity that requires an Inspector might be delayed if that resource is
assigned to multiple projects or is on vacation.

Level of Effort:

Activities have a duration that is determined by its dependent activities and are typically
administration type. Choose level of effort to indicate that the activity's duration depends on
its predecessor and/or successor activities. A level of effort activity is usually one that is
ongoing, such as clerical work, Change Management, or project management tasks. For
example, site cleanup could be considered a level of effort activity; it occurs repeatedly and
is dependent on the completion of a phase.

Start or Finish Milestone:

Milestone activities are zero-duration without resources, marking a significant project event.
Choose start milestone or finish milestone to indicate that the activity marks the beginning or
end of a major stage in the project. Milestones have zero duration. A primary resource or an
activity owner, and expenses can be assigned to a milestone. In an office building addition
project, examples of milestones might include Project Definition Complete, Structure
Complete, or End Bidding Process.

CBS Summary:

Activities that are used to aggregate date, duration, and percent complete values for a group
of activities that share a common WBS code level. Choose WBS Summary to indicate that
the activity is a summary-level WBS activity. A WBS Summary activity represents a group of
activities that share a common WBS level. The summary-level WBS activity enables roll-ups
of dates for the activity group. The duration of a WBS Summary activity extends from the
start of the earliest activity in a group to the finish of the latest activity. WBS codes control
which activities are part of a WBS Summary activity; P6 incorporates any activities that share
a component of the WBS Summary activity's WBS code into the WBS Summary activity. For
example, all activities whose WBS codes begin with A (A.1, A.1.1, A.1.2, etc.) can be part of
one WBS Summary activity whose WBS code is A. At a lower level, all activities whose WBS
codes start with A.1 (A.1.1, A.1.2, etc.) can be part of a WBS Summary activity whose WBS
code is A.1.

CBS Code (Editable)

The CBS code to which you want to link an activity, assignment, or expense. This is and editable
field and can also be updated using import CSV.

Performance % Complete

The percentage of the activity, or project, planned work that is currently complete. The
Performance % Complete is used to calculate earned value (EV). It can be based on the activity
percent complete, on the 0/100 rule, on the 50/50 rule, depending on the technique for
computing earned-value percent complete for the activity's CBS.
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Actual Start

If work has started, the date work on the activity, CBS, project, or EPS began. If resources
(labor, non-labor, or material) or roles are assigned to the activity, the actual start date is the
earliest among all the resource or role assignments. For a CBS, project, or EPS, the actual start
date is the earliest actual start date among all activities within the CBS, project, or EPS. When
P6 is integrated with Primavera Unifier, the Actual Start date might have been imported from
Primavera Unifier rather than calculated by P6.

Actual Finish

The date on which the item, such as an activity, assignment, or project, is complete. When P6 is
integrated with Primavera Unifier, the Actual Finish date might have been imported from
Primavera Unifier rather than calculated by P6.

Planned Duration

The expected amount of time required to complete an activity. The planned working time is
calculated in P6 using the activity's calendar. The duration is measured from the activity's
planned start date to its planned finish date.

Actual Duration

The total working time from the activity Actual Start date to the Actual Finish date for completed
activities, or the total working time from the Actual Start date to the data date for in-progress
activities. The actual working time is computed using the activity's calendar.

Remaining Duration

The total working time from the activity remaining start date to the remaining finish date.The
remaining working time is calculated using the activity calendar. Before the activity is started, the
remaining duration is the same as the planned duration. After the activity is completed the
remaining duration is zero.

At Completion Duration

The total working time from the activity's current start date to the current finish date. The current
start date is the planned start date until the activity is started, and then it is the actual start date.
The current finish date is the activity planned finish date while the activity is not started, the
remaining finish date while the activity is in progress, and the actual finish date once the activity
is completed. The total working time is calculated using the activity's calendar.

Activity Attributes (Units)

Planned Total Units

The planned units of work for the activity.

Actual Total Units

The exact number of units that have been expended on the selected activity.
Remaining Total Units

The remaining units of work to be performed by the resource on the activity. Calculated as
Planned Units minus Actual Units.

At Completion Total Units

The sum of the actual units and remaining units for the resource assignment on the activity.
Calculated as Actual Units plus Remaining Units.
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Activity Attributes (Cost)

Planned Total Cost

The expected total cost of the activity, consolidating costs of all assignments.

Actual Total Cost

The actual non-overtime plus overtime cost for all the resource assignments of the activity.
Remaining Total Cost

The remaining cost of all the resource assignments for the activity.

At Completion Total Cost

The sum of the actual costs plus remaining costs for the resource assignment on the activity.
Calculated as Actual Costs plus Remaining Costs.

Activity Attributes (Earned Value)
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Planned Value

The portion of the baseline total cost of the activity or project that is scheduled to be
completed as of the project data date.

Earned Value

The portion of the project baseline total cost of an activity or all activities in the project that
are actually completed as of the project data date. Budget at completion is calculated from
the project baseline. Calculated as Budget At Completion multiplied by Performance Percent
Complete. The method for computing performance percent complete depends on the Earned
Value technique selected for the activity CS.

Estimate to Complete

The estimated cost to complete the activity, CBS, or project. Calculated as Remaining Total
Cost for the activity or the Performance Factor multiplied by (Budget At Completion minus
Earned Value), depending on the Earned Value technique selected for the activity CBS
(calculated from the primary baseline). Budget at completion is calculated from the project
baseline.

Schedule Performance Index

A measure of the work accomplished as a percentage of the work scheduled. Schedule
Performance Index indicates whether you are meeting earned and planned values within
your schedule. A value less than 1 indicates that less work was performed than was
scheduled. Calculated as Earned Value divided by Planned Value.

Cost Performance Index

A measure of the value of work accomplished as a percentage of the actual costs. Cost
Performance Index (CPI) indicates whether you have spent money over the budget to date.
On the My Preferences page, you can set performance thresholds for CPI calculated values
to determine whether you need to take corrective action. Calculated as Earned Value Cost
divided by Actual Cost. A value less than 1 indicates that the actual cost has exceeded the
planned value.

Cost Schedule Index
Product of Schedule Performance Index & Cost Schedule Index
Schedule Variance
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The measure of schedule performance on a project. A negative value indicates that less
work was actually performed than was scheduled. Calculated as Earned Value minus
Planned Value.

Cost Variance

A measure of cost performance on an activity, CBS, or project. A negative value indicates
that the actual cost has exceeded the planned value. Calculated as Earned Value minus
Actual Cost.

Complete Performance Index

The ratio of the remaining work to the remaining funds. Calculated as (Budget at Completion
minus Earned Value) divided by (Estimate at Completion minus Actual Units or Cost).

Estimate at Completion

The expected total cost of a schedule activity, a work breakdown structure component, or the
project when the defined scope of work will be completed. Calculated as Actual Cost plus
Estimate to Complete Cost. The method for calculating estimate to complete depends on the
earned value technique selected for the activity CBS.

Budget at Completion

The planned total cost through activity or project completion. Calculated as Planned Labor
Cost plus Planned Nonlabor Cost plus Planned Expense Cost plus Planned Material Cost.

Variance at Completion

The difference between the baseline total cost and the current estimate of total cost. A
negative value indicates an estimated cost overrun. Budget At Completion is calculated from
the current baseline. Calculated as Budget At Completion minus Estimate At Completion.

System Activity Sheet Log Gear Menu Options

In the log, click an activity and then click the gear menu to access the following options:

» Apply CBS Code to All Assighments

To assign the CBS Code to all of the resources under that activity. Once the CBS Code is
updated at the activity level, you can assign same CBS Code to all of the resource
assignments of the activity by using right-click on the activity and selecting the option Apply
CBS Code to all Assignments. This selection causes all of the assigned resources CBS
Code to be updated.

Once you assign or update the CBS Code, both at the activity level and the assignment
level, Unifier updates the contents of the Audit Log tab.

You can select multiple activities and update the CBS Code to the resources of the selected
activities by right-clicking and selecting the option Assign CBS Code to All Assignments.

Use the Assign CBS Code to All Assignments to apply the CBS Code value to the
resource assignments. When you select the Assign CBS Code to All Assignments, the
CBS codes for the selected activities will be added to resource assignments.

» View Activity Spread

To go to the Activity Spread tab (right pane), click the gear menu and select View Activity
Spread to open the Activity Spread tab. You can select your options from the following
fields to display the results on the Activity Spread window:

» Frequency

63



Earned Value Management User Guide

» Cost Type

Note: When you assign resources or roles that have multiple rates to an
activity sheet, in order to update the total cost (Total Cost value), you
must reschedule, or recost, the activity sheet; otherwise, the system will
assign earliest assigned resources or roles rates (price/unit) to the
activity sheet, and you will not be able to view the correct accumulated
cost.

System Activity Sheet Log Properties Tabs

In the log, you can view the activity details by selecting a row and clicking on the split screen
icon to open the right panel and see the details of the activity in the following tabs:

» General tab

» Assignment tab

» Activity Spread tab
» Audit tab

These tabs are explained in the following topics.

General Tab

Contains all of the details related to the activity sheet, which are defined in activity attribute form
including the WBS Details. The data elements and the order of the data elements, shown in the
General tab, are based on the activity attribute form. The hidden data elements are not shown in
the General tab. You can dock this pane to the right side of the screen. If you dock the pane at
bottom, or right side, manually, Unifier retains your choice after closing the Activity Sheet
window. You can expand the bottom pane by using the expand icon on the right-hand side.

The General tab displays the attributes for the selected activity in groups:

WBS Attributes

Activity Attributes (General)
Activity Attributes (Schedule)
Activity Attributes (Units)

Activity Attributes (Cost)

Activity Attributes (Earned Value)

v v v v v Vv

Actual Dates

» An activity progress <uuu_P6PercentComplete> will be editable once the
<uuu_P6ActualStart> has been entered, or the <uuu_P6ActivityStatus> has changed to 'In
Progress'. If <uuu_P6ActualStart> has been entered, then the uuu_P6ActivityStatus will be
changed from 'Not Started' to 'In Progress' and vice versa, automatically.

» When <uuu_P6ActivityStatus> has changed from ' In Progress' to 'Completed' the
<uuu_P6ActualFinish> will be populated with current date and vice versa.

» When <uuu_P6ActivityStatus> has changed from ' Not Started' to '‘Completed' the
<uuu_P6ActualStart> and <uuu_P6ActualFinish> will be populated with current date.
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» Actual Start Date <uuu_P6ActualStart> cannot be entered in future date (cannot be different
from the current date).

» Actual Finish Date <uuu_P6ActualFinish> cannot be entered in future date (cannot be
different from the current date).

Assignment Tab
Use this tab to view the resources and roles assigned to the activity selected in the main grid.
The gear menu options in the Assignments tab vary depending on the project type.
There is only one option for Cost-loaded and Schedule-based projects:
» View Assignment Spread
The following options are available for the Resource-loaded projects:

» View Assignment Spread

» Assign CBS

» Assign Rate Source

Click on a resource row, click on gear menu icon for that row, and select View Assignment

Spread. This option (for any selected resource) displays the spread data for that resource, in a
split screen "Assignment Spread of ..." at the bottom, as shown.

You can view the daily spread data of the resource. The Frequency drop-down field and the
Cost & Rate Type field will show additional options to select.
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» Inthe Frequency list, change the granularity level of the spread to Week, Month, or Year.
» Inthe Cost & Rate Type list, select Cost or Units. Column headings change accordingly.

The "Assignment Spread of ..." pane also displays spread details, such as Period Start,
Panned Units, and so forth in columns.

All of the resources associated with the activity are displayed. Both the CBS Code and the Rate
Source columns are editable. By default, the picker icon is not displayed until you click on the
cell of the columns.

» Resource Name

» Role Name
» Rate Source

You can double-click in the Resource Source cell and select one of the following rate sources:

» Resource

In the case of the resource.
» Role

For the roles.
» Override

You can edit the price or unit for planning and actuals if the value for the Rate Source is
selected as: Override.

» Cost Code

You can edit the value of the CBS Code field for a particular resource and assign the same
CBS Code field value to other resources by dragging the CBS Code to multiple rows.
Planned Units

Actual Units

Remaining Units

At Completion Units

Price/Unit (Planning)

Price/Unit (Actuals)

Planned Cost

Actual Cost

Remaining Cost

At Completion Cost

Vv vV vV vV vV vV vV v v v

The Cancel and Save options appear when you attempt to edit the Rate Source value, or the
CBS Code, or other fields based on the Rate Source in the Assignments tab. If you try to
navigate to an activity sheet without saving the tab information, then Unifier notifies you.

Activity Spread Tab
Enables you to select the values for:

» Frequency
The Frequency drop-down field enables you to select the frequency of the spread in:
» Day
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» Week
» Month
» Year
» Cost & Rate Type
Enables you to select:
» All Cost Types |Direct
» All Cost Types |Indirect
» Standard |All Rate Types

You can view the activity spread data by using the gear menu option (View Activity Spread) or
by navigating to the Activity Spread tab.

In Activity Spread tab, you can see the spread data of the selected activity.

The Activity Spread tab will show all of the data (both for costs and for units) in one spread
sheet. The costs and units spread data appears on one single sheet. You can expand the
screen to view more spread data. The order of the columns in the Activity Spread tab are as
follows:

Period Start

Cost & Rate Type
Planned Total Units
Actual Total Units
Remaining Total Units

At Completion Total Units
Planned Total Cost
Actual Total Cost
Remaining Total Cost

At Completion Total Cost

You can view the spread data for each activity by navigating to different activities under the
spread column.

v

v vV vV vV vV vV v v Vv

Note: Only one activity spread data is displayed. If you select multiple
activity rows, then Unifier displays: "Details of multiple activities
cannot be viewed."

Audit Log Tab
The following information will be captured in the Audit Log tab:

Date

Event
Action
Field Name
Old Value

v v v v Vv
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»
»
»

New Value
User Name
Proxy User

CSV Import and Audit Log

For the existing activities, the Audit Log tab displays the entries for the fields that have been
updated by way of CSV import as follows:

»

Date

Populated with date and time for the event.

Event

The value is "Import," in the case of adding or updating the activity.
Action

For the new activities, the value is populated with, "Create." For the existing activities, the
value is populated with, "Update."

Field Name

Populated with the field that was updated.

Old Value

Populated with the existing value in case of an update.
New Value

Populated with the new value.

Note: If a new activity is created by way of the CSV import, then the
Audit Log provides an entry.

Activity Sheet User Defined Report (UDR)

You can create User-Defined Reports (UDRs) from the data present in your activity sheet.

The Create User-defined Report window lets you define the following fields for your UDR
(template or individual reports):

4
4
4
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Note: The same fields will be available for system and permission-based
data sources.

The elements (Currency/Decimal) in the OOTB Activity Sheet, along with any user-defined
column, will be available as DEs for your report.

Note: Only the data elements available in the Activity Sheet will be
available in the respective UDR.

Data for reports can be imported to Unifier from the CSV file. You can import data for Date Field,
only (if it is in the same format as in the Unifier client). In cases where the client is using
mm/dd/yyy, you have to create custom settings in the CSV file.

In Excel, add the new custom formats as follows:

1) Right-click the applicable cell and select Format Cells.
2) Onthe Number tab, select the Custom category, and specify a mm/dd/yyyy format.

Roll Up Activity Sheet to Cost Sheet

The Column Properties window enables you to select your cost sheets.
The Type field enables you to select the following:

» Worksheet
» Activity Sheet

The Name/ID field displays the name of the worksheet that you have selected; otherwise, this
field displays the Activity Sheet, using the following naming conventions:

» Activity Sheet 01 (Activity) - for Activity Sheet with ID 01
» Activity Sheet 01 (Resource)

If there is no data or sheet for that ID, then Unifier displays an error message when you click
OK, after making the selection, and the value will be zero in the Cost Sheet for that column.

The Column field enables you to select the currency and decimal fields from the Activity Sheet
that are available to be rolled up into the Cost Sheet as a column.

Assignments

uuu_P6PlannedCost (Planned Cost - cost)
uuu_P6ActualCost (Actual Cost - cost)
uuu_P6AtCompletionCost (At Completion Cost - cost)
uuu_P6RemainingCost (Remaining Cost - cost)
uuu_P6PlannedUnits (Planned Units- Units)
uuu_P6ActualUnits (Actual Units- Units)
uuu_P6AtCompletionUnit (At Completion Units- Units)
uuu_P6RemainingUnits (Remaining Units- Units)

v vV vV vV vV v v Vv

Activity
» uuu_P6PlannedTotalCost (Planned Total Cost - cost)
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uuu_P6ActualTotalCost (Actual Total Cost - cost)
uuu_P6AtCompletionTotalCost (At Completion Total Cost - cost)
uuu_P6RemainingTotalCost (Remaining Total Cost - cost)
uuu_P6PlannedTotalUnits (Planned Units - units)
uuu_P6ActualTotalUnits (Actual Units - units)
uuu_P6AtCompletionTotalUnits (At Completion Units - units)
uuu_P6RemainingTotalUnits (Remaining Units - units)

vV v vV vV v v Vv

Note: The decimal type Data Element (DE) is available in the cost
formula.

The Column Name field, in the Cell Details window, displays the DE field label in the respective
Activity Sheet.

Note: You can have from 1 to 100 predefined cost DEs created in the
Cost Sheet.

Roll up of Earned Value Analysis Sheet Columns to Cost Sheet

You can roll up the EV analysis sheet columns (created on a manual activity sheet) to the cost
sheet, similar to the EV analysis sheets that were created through the System Activity Sheet.
All of the existing options for an EV analysis sheet column in the cost sheet (columns, data
format, etc.) will be available for EV analysis sheet that was created using a manual activity
sheet. The EV analysis sheet column for a manual activity sheet is identified by using the
template ID, similar to the System Activity Sheet.

Roll up of Earned Value Analysis Sheet Columns to WBS Sheet

You can roll up the EV analysis sheet columns (created on a manual activity sheet) to the WBS
sheet, similar to the EV analysis sheets that were created through the System Activity Sheet.
All of the existing options for an EV analysis sheet column in the WBS sheet (columns, data
format, etc.) will be available for EV analysis sheet that was created using a manual activity
sheet. The EV analysis sheet column for a manual activity sheet is identified by using the
template ID, similar to the System Activity Sheet.

Supported Objects for P6 XML Import (System Activity Sheet)

The following table lists the supported objects when you are importing a P6 XML file in order to
create a project schedule.

The activity sheet selected will have the project schedule start date updated from the source, if
there are activities with the start date earlier than the project schedule start date. In this case,
the earliest start date will be the project schedule start date. If the project schedule start date is
set to begin from the project start date defined in shell attributes, in the case of activities earlier
than schedule start date, then Unifier displays an error message.
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Business Objects

Description

Unifier

Project Information
(Project)

This is the highest level of
information related to the
project schedule.

With the import of P6 XML, the
following project properties will
be added to the activity sheet
properties: Project Schedule
Start Date, Calendar (if exists
in Unifier; otherwise, the
default project or shell
calendar will be used), and
Data Date.

Activity (Elements
under Activity)

This is the parent node to all
child business objects
connected to any activity.

The import process will map
non-complex type child
elements from the Activity to
Unifier Activity data elements.

Relationship (Elements
under Relationship)

The <Relationship> element
exists directly under the
project. It stores predecessor
and successor relationships
between activities. It also
supports relationships
between activities from
different projects.

The import process will only
look at predecessor and
successor relationships
between activities in the same
project.

WBS (Elements under
WBS)

The WBS element wraps one
or more activities. WBS
elements can itself contain
other WBS elements.

The import process will map
all WBS Summaries from
source to Unifier WBS data
elements in WBS Sheet.

Assignment (Elements
under Assignment)

The <Assignment> element is
a child of <Activity>.

The import process will import
all assignments for each task.
Assignment properties will be
imported based upon data

mapping.

Resources/Roles
(Elements under
Resource/Role tags)

The resources assigned to
the activities under
assignments tab.

The import process will map
all resources/roles from
source to Unifier
resources/role in Master Rate
Sheet. If not available then
new resources will be created.

Rate Sheet Node

There are two types of rate sheets:

» Master Rate Sheet (company level)
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» Rate Sheet (shell level)

Note: No calculations are needed for a cost loaded schedule. The
Earned Value Analysis module directly uses the data imported from P6.

A Rate Sheet is a subset of the Master Rate Sheet in a shell. You can create one or more rate
sheets to assign rates to all or selected projects in the Activity Sheet of a shell. The rate sheets

retrieve the resources and roles from the activity sheet of that shell and attain the corresponding
rates from the Master Rate Sheet.

Note: By default, the rates present in the Master Rate Sheet are used
across all the resources and roles present in the activity sheets across
all shells unless you assign a shell-level rate sheet to the Activity Sheet
in that shell.

A rate sheet provides the rates for the roles and resources assigned to activities of resource
loaded schedules. This is required to perform costing and subsequent earned value analysis in
Unifier. You can have multiple rate sheets. These rate sheets are listed in the Rate Sheets node

log.
The Rate Sheet (at Project/Shell) log does not show any record at the shell level. The first time
that you use the Rate Sheet, you have to create a subset of the Master Rate Sheet by clicking

on the Create option. The Create option can be used subsequently to create a rate sheet
directly from Master Rate Sheet.

You can define the rate breakdowns manually by using a formula to establish rates based on
other cost types. When you edit the cell Price/Unit, you can click the formula icon to open the
formula window. When you select the formula, Unifier displays the formula builder. The left-hand
pane displays the rate breakdowns defined for the rate that you have selected. You can select
more than one breakdown and add a formula.

The Rate Sheet node log contains a list of rate sheets listed in the Rate Sheets log window.
You have the following options for a rate sheet at shell level (in the Rate Sheet):

» Create

If you click Create, then the system creates a rate sheet, with the required activity sheet as
the list of roles and resources, and gets the corresponding rates from the Master Rate
Sheet, automatically.

» Copy

You can select a rate sheet from the log at shell level (Rate Sheet) and click Copy. In this
scenario, the system does not check the roles and resources list in activity sheet and just
creates a copy of the rate sheet selected with user entered name through a window.

Note: To view Rate Sheet, you must have appropriate permissions.

There are some minor differences in the log layout for rate sheet between Master Rate Sheet
(at Company Workspace) and Rate Sheet (at Project/Shell).
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Rate Sheets Node Log Window

To access the Rate Sheets log, go to the shell (User mode), click to expand the Activity
Manager module, and click Rate Sheet.

Note: The location may differ in your implementation based on the
Project/Shell UserMode Navigator configuration.

You can use the Rate Sheets log to:

» See a list of rate sheets.

» Review the following information (on the right-hand pane of the log) about a selected activity
sheet:

» Audit Log
» Permissions
» Schedule

The Rate Sheets log has the following toolbar options:

Toolbar option Description

Create To create a new rate sheet by copying a
data from Company Workspace and
Activity Sheet.

Refresh To refresh the contents of the page.

Delete To delete an item

Find on Page To find an item on the page.

The Rate Sheets log has the following columns:

Column Description

Name The name of the rate sheet entered in the
Create Rate Sheet dialog.

Description The description for the rate sheet entered
in the Create Rate Sheet dialog.

Last updated The date the sheet was last updated
manually or through Refresh.

Created By The name of the user who created the rate
sheet.
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The Rate Sheets log lists the rate sheets and each rate sheet row has a menu options that you

can access by way of the gear menu ( € ). The following table explains the gear menu ( %)
options for each rate sheet:

Option Description

Open To open a rate sheet.
Note: You can also double-click to open
the sheet.

Copy To select a rate sheet and create a copy of

that rate sheet. Enter a name and
description and then click Save to
complete the action.

Delete To delete one or multiple rate sheets.

Note: The Delete option in the toolbar
allows you to delete multiple rate sheets
simultaneously. If a rate sheet is being
used in the Activity Sheet, then it cannot
be deleted.

74



Working with Earned Value Analysis

Option Description

Refresh To refresh a rate sheet based on
resources and roles that are used in the
system activity sheet of the shell.

Select a single or multiple rate sheets and
click Refresh to update the list of
resources and roles based on the latest
data available in the Activity Sheet, and
the corresponding rates from the Master
Rate Sheet. Click Yes in the Confirmation
window to update.

On refresh, the following updates are
implemented:

» If a resource/role has been removed in
the Activity Sheet in the shell, then
the role/resource and corresponding
rates are removed from the rate sheet.

» If a resource/role has been added to
the Activity Sheet in the shell, then
the new role/resource is added to the
rate sheet and its corresponding rates
are retrieved from the Master Rate
Sheet.

» If the resource/role exists in both
Activity Sheet and the rate sheet,
then the system updates the
resource/role name, if applicable
(using resource or role ID as the
identifier).

Export CSV Use the options to export Role or
Resource Rate Breakdown as CSV. This
comprises the list retrieved from the shell
Activity Sheet. The structure includes ID,
name, status, effective date, cost type, rate
type, and price/unit information.

» Export Role Rate Breakdown: To
export role rates data.

» Export Resource Rate Breakdown:
To export resource rates data.
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Option Description

Update Data Use the options to import the modified
Role or Resource Rates CSV files in order
to update role and resource rates.

» Import Role Rate Breakdown: To
update the role rates using an imported
CSV and making changes to the data
from Export CSV (Export Role
Rates).

» Import Resource Rate Breakdown:
To update the resource rates using an
imported CSV and making changes to
the data from Export CSV (Export
Resource Rates).

The Rate Sheets log displays the rate sheet properties on the right-hand pane within the
following tabs:

Tab Description

Audit Log tab To provide the following information:

Date

Event
Action
Field Name
Old Value
New Value
User Name
Proxy User

Vv v vV vV VvV vV v Vv

Permissions tab To provide information about:

» Selected Users/Groups
» Permissions

Schedule tab To set Frequency for Refresh Rates.

Tip: Click the expand icon, in the right pane, to better view the tab details.
The following explains each tab in details.

Rate Sheets Log Window Tabs
The following explains the tabs in the Rate Sheets log window:
Audit Log
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The Audit Log tab tracks all the events of the rate sheet and the component roles and
resources.

Permissions

Use the Permissions tab to add users and groups and assign permissions for the specific rate
sheet:

» Modify Permission

Users who have this permission will be able to modify the setup.
» Edit & Refresh
> View

The creator of the rate sheet is assigned all permissions by default.
Schedule

You can use the Schedule tab to set a frequency for automatic refresh of rates in the rate sheet
at daily, weekly, monthly or quarterly intervals between the specified start and end dates.

Creating a Rate Sheet

The Create option on the Rate Sheets log window enables you to manually create a rate sheet
and retrieve resources and roles information from the Activity Sheet and the corresponding
rates from the Master Rate Sheet.

You can create multiple rate sheets as per business needs. For example, you can create an
Internal Rate Sheet to apply internal rates for the resources and roles in the project. If they work
on client sites, create another called External Rate Sheet. Other examples can include an
Overtime and Standard rate sheets. Use the same rate sheet across the individual projects in
the Activity Sheet or apply different rate sheets to the individual projects.

Note: Creating rate sheets is optional.

To create a Rate Sheet:

1) From the toolbar, click Create to open the Create Rate Sheet window.
2) Enter a name in the required Name field.

3) Optionally, add a description.

4) Click Create. (Click Cancel to exit the Create Rate Sheet dialog.)

The new rate sheet appears in the Rate Sheets log window.

Rate Sheet Window

Go to the shell (User mode) > Activity Manager module > Rate Sheet node to open the Rate

Sheets log which lists the rate sheets. Each rate sheet has a gear menu ( % ) that can be used
to open the rate sheet.

Note: You can also double-click to open the rate sheet.

The rate sheet log window has the following toolbar options:
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View

Print

Refresh

Find on Page

Expand All Groups, or Collapse All Groups

v v v v Vv

The View toolbar option (the Resource view as is the default view) enables you to view the
attributes of the rate sheet derived from the activity sheet. From the View toolbar option, use the
Resource or Role option to switch between Resource or Role views respectively. The main
log, or grid, and the Rates tab layout are identical in the two views.

In the main log, or grid, you can see the following columns:

» ID
» Name

» Type (not available for the Role view)
» Status

» Currency

Select any item to view and the Rates tab displays the details.

Rates
In the Rates tab, there are two columns:

» Effective Date
» Price/Unit
Information is retrieved from the Master Rate Sheet. You can create multiple rate instances for

a resource/role for different effective dates. The Cancel and Save options appear when you
make a change.

From the gear menu ( ) of a rate, click Add to add a row above it. Complete the Effective
Date and Price/Unit fields. Click Save to save changes.

Note: The effective date and rates entered in the tab are not overwritten
on refresh. Clicking Refresh in the Rate Sheets log pulls any additional
resources and roles from the Activity Sheet.

On the Rates tab, you can click the Create option to open the Create Rate Breakdown window.
The Create Rate Breakdown window has the following columns:
» Cost Type

To select the cost type corresponding to the rate which is being created for the role or
resource.

» Rate Type
To select the type of rate which is being created for the role/resource.
» Price/Unit

To provide a price or unit by way of selecting from the drop-down field Manual (Price/Unit)
from the method. This can be done manually or by using the Formula Builder (click the
calculator icon in the Price/Unite cell).
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WBS Sheet Node

To access the WBS Sheet node log, go to the shell (user mode), click to expand the Activity
Manager module, and click WBS Sheet sub-node.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use a System WBS Sheet and:

» Define the work breakdown structure (WBS) for the entire project, by using CSV import. The
System WBS Sheet is used across all of the manual activity sheets.

» View the rolled-up costs (such as planned total costs/units, actual total costs/units, at
completion total costs/units, and remaining costs) associated to the WBS codes in the
System WBS Sheet.

Define custom attributes for additional formulas (such as CPI, SPI calculations, and so forth).
Capture the actuals incurred from the business processes, by using WBS pickers.
Filter WBS data based on the Used By column.

View planned, actual, remaining, and at completion costs and units from all activity sheets
into default columns.

v v v Vv

You can create the System WBS Sheet rows manually, by:

» Using Add Child and Add Sibling option.
» Using CSV import and RESTful services.

You can use the System WBS Sheet log (the name of the WBS Sheet sub-node log) window
to:

» See the list and properties of a WBS sheet.
» Access a WBS sheet.

The System WBS Sheet log window is divided into two panes:

» Grid or table (left-hand)
» Properties tab (right-hand)

The WBS Sheet node log displays the only available WBS sheet, the System WBS Sheet. In
the System WBS Sheet log, or page, you can click on a WBS item and use the three vertical

L )

dots icon (*) to expand the screen and see the properties of the item, if necessary.

Note: The EVM data sources should not be seen in the WBS Sheet
columns for customers without the EVM license.

The Work Breakdown Structure (WBS) code assignment is applicable to the manual activity
sheet, only. The Cost Breakdown Structure (CBS) code assignment is applicable to both the
manual and the System Activity Sheet.

You can use a System WBS Sheet and:
» Export WBS template
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Import WBS codes using CSV

Create WBS structure using RESTful services

Set the Used By Column and filter data

Define columns using numeric logical source and select multiple Activity Sheets
Default columns to show costs and units from all the custom Activity Sheets

v v v v Vv

A System WBS Sheet grid contains information about:

WBS Code

WBS Name

Linked Record

ETC Technique

Planned Units

Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost

At Completion Units

At Completion Total Cost
Planned Units

Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost

At Completion Units

At Completion Total Cost

VWV VvV ¥V VvV VvV VvV ¥V VvV VvV vV vV VvV VvV vV vV VvV VvV v v v

System WBS Sheet Log Toolbar options
The following explains the System WBS Sheet log toolbar options:

Add Column ([D])

Enables you to create a new column by providing values for the following mandatory fields:
» Name

» Type

» Datasource

» Data Format

» Display Mode

» Total

» Column Position

View > Create New View - Manage Views
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Enables you to change the view of the WBS Sheet window. You can use this option to
access created views, create new views, or manage the existing views.

Edit View
Enables you to select which columns to be displayed or remain hidden, apply filters, group

and sort by available fields and to save custom views.

» Inthe Columns tab, add/remove/reorder columns in the default view. You can save as a
custom view.

» In the Filter tab, add conditions to filter the results of a column.

» Inthe Group By tab, create or modify groups using column elements. For example,
activity status.

» Inthe Sort By tab, define the sorting order (Ascending or Descending) of columns.
Print > Export To CSV - Export To Excel

Enables you to print or export the System WBS Sheet contents.
Refresh

Enables you to see the added values to the columns of the System WBS Sheet.
Find on Page

Enables you to search a for a System WBS Sheet on the worksheet (window).
Expand All Groups or Collapse All Groups

Enables you to expand or collapse a System WBS Sheet to see the subordinates. The
tree-like structure displays the summarized WBS and corresponding values of the project
selected in the Projects list. You can export the WBS structure from the sheet.

Menu Options ( =)
Enables you to do the following:
Import
Enables you to import Column Details.

The Column Name drop-down list in the Import Column Details window displays all of the
direct cell entry columns that have been added to the sheet. You can select any one column
and import the values into the column, using the exported CSV file.

Export

Enables you to export WBS Details, Column Details or Summary WBS Sheet. When you
select Summary WBS Sheet, the exported file will contain the entire System WBS Sheet
information including all WBS Codes and columns data.

Columns

Enables you to hide or unhide (Unhide) columns as well as Copy Column Data.
Row Coloring

Enables you to apply Multiple Colors or Single Color to the columns.

Variance Analysis Setup

Enables you to set up the variance analysis by selecting the BP, workflow, record owner, and
trigger conditions.
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Create Variance Analysis Record

Enables you to create the variance analysis records for all of the WBS Codes in the sheet.
Before creating a Variance Analysis Record, you must set up the Variance Analysis at WBS
level. Ensure that the business process that you select is active; otherwise, the Unifier
displays this message: "Business Process has not been selected."

Audit Log

Enables you to open the Audit-Log: System WBS Sheet window and see a list of
associated events related to the sheet.

System WBS Sheet Log Columns
The following columns appear in the System WBS Sheet log:

Sequence No.

WBS Code

WBS Name

ETC Technique
Planned Units
Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost
At Completion Units
At Completion Total Cost

VvV VvV vV vV vV vV vV vV VvV v v v

The values for the following columns are coming from P6 directly:

Note: The General tab of each WBS code will not display these
columns. In addition, formula values that depend on these columns will
not display.

Planned Units

Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost

At Completion Units

At Completion Total Cost

v vV v vV vV vV v Vv

When you right-click on each column heading, depending on which column on the grid, some or
all of the following options will be made available:

Lock after this Column
To lock or release the position of a column on the grid.

Insert

82



Working with Earned Value Analysis

To insert a column through:
Business Process Data Source
Direct Cell Entry

From EVA Sheet

From Activity Sheet

WBS Custom Attributes
Formula

g. Hidden

Hide this Column

~o Q0o p

To hide the column that you had selected.
Delete

To delete a column.
Properties

To open the Column Properties window and review or change (with limitations) the
properties of a column.

When you hover over each column heading, Unifier displays information about that column.

System WBS Sheet Log WBS Gear Menu
When you click on a row (WBs code) in the System WBS Sheet log, you can click the gear
menu icon ( &) to:

» Create Variance Analysis Record
Available if you have Edit permission for the System WBS Sheet.

Enables you to create the variance analysis records for all of the WBS Codes in the sheet.
Before creating a Variance Analysis Record, you must set up the Variance Analysis at WBS
level. Ensure that the business process that you select is active; otherwise, the Unifier
displays this message: "Business Process has not been selected.”

» Expand Row
» Collapse Row

System WBS Sheet Log Properties Tabs
The following explains the properties tabs of the System WBS Sheet log:

On the right-hand pane, you have the option to use the icons (on the right) to expand the pane
or to dock the pane.

The following is a list of applicable properties tabs for each item in the System WBS Sheet log:
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Note: Users who have at least the view permission for the auto-created
record should be able to view the record by double clicking.

» WBS Line Iltems tab
Displays the title, description, and amount, or quantity, of the WBS Line Items.
» Cell Details tab
Displays the following information:
» WBS Code
» Currency
» WBS Name
» Cell Total Quantity
» Column Name
» Status
» General tab

Displays details about the WBS Attribute Form such as the CM WBS name, code, and WBS
type, ETC Technique, and EVM PV.

» Earned Value tab
Enables you to select a technique for computing ETC.
» Variance Analysis tab
Enables you to access information about the BP setup, workflow, and record owner. The tab
also enables you to see the trigger conditions. Once finished adding values, click Create
Now, or click Save to keep your changes.
This tab displays the following information:
Setup block
Business Process
You can select the Business Process at WBS Code level similar to the Variance Analysis
Setup done at WBS Sheet. The drop-down menu lists of all project level or shell level
BPs, enabling you to select a new value or modify the existing value.
Bypass Initiation Step during auto creation
If you select this option, then the auto-created BP record will bypass the initiation step
and land on the second step of the workflow.
Select Workflow
You can select a workflow if your selected BP has multiple workflows. The Select
Workflow field function is similar to the Variance Analysis Setup window.
Record Owner

You can select the record owner at WBS level. This field lists all of the OBS Pickers, User
Pickers, and User Data Pickers added to the WBS Attribute form. When you select
the OBS Picker as the record owner, then the picker in general tab displays the OBS
users that you had selected.

Trigger Conditions block

84



Working with Earned Value Analysis

Multiple trigger conditions can be defined for each WBS level. Adding trigger conditions is
similar to adding at WBS Sheet level setup. You can add one or more additional
conditions to indicate trigger condition of the current WBS. The Data Element,
Condition, and Value must be specified exactly the same way as specified in the
Variance Analysis setup at WBS Sheet level.

The Create Now option is enabled once you select the required fields on the tab. Use the
Create Now option to auto-create the business process record manually if a BP is
present in the setup. If the record owner is not specified, then Unifier uses the
auto-creator in the destination BP (auto-creation tab) as the record owner.

Note: Any trigger conditions defined are ignored in case you select the
Create Now option.

» Linked Records tab

Enables you to access the records that are linked the sheet by listing all of the linked records
and details about each link such as record number, BP name, and so forth.

For a WBS code, the Linked Record column indicates if there are any associated
auto-created records for the WBS code, or not. When you click on the link, the right-hand
pane opens, with Linked Records tab highlighted.

The Linked Record column can be empty if no auto-creation of variance analysis record has
been triggered.

All the auto-created records are shown in the Linked Records tab for each WBS code.
The following explains the toolbar options:
» Refresh: To refresh the items based on the latest records.
» Find on Page: To enable you to conduct a text-based search for each column.
The following explains the columns:
» Record Number: System auto-created business process record number.
» BP Name: The name of the Business process.
» Title: the title value from the business process record.
» Status: The current status of the auto-created record, including the terminated records.
» Created By: The username of the user who is creator of the auto-created record.
» Creation Date: The date that the record is auto-created.

» Variance Analysis History tab
Enables you to access history details for associated actions related to the sheet.

When a variance analysis record auto-creation fails, when you hover over the link cell, the
following message is will be displays: "<failure reason>. Click to see history details.”" When
you click, the right-hand pane displays the history details. Here are some of the failure
reasons:

» Business Process is not configured.

» Record owner does not have create permissions.
» Record owner is not active.

» Trigger conditions are not satisfied.

85



Earned Value Management User Guide

If the rotate icon is displayed instead of the link icon, then the auto-creation of the record is
still in progress. The link icon is displayed after the auto-creation is complete.

This tab captures the list of failed auto-creation for each WBS code, in case business
process is inactive or trigger conditions have not been met, etc. The following is a list of the
columns in this tab:

» Event: Displays, "Error" for failed auto-creations.

» Action: Displays, "Auto Create."

» Field Name: This will be WBS code where the auto creation failure occurs.
» New Value: Displays the error text.

Creating a WBS Sheet
When an activity sheet is created, Unifier creates the WBS sheet, automatically.
About Auto-Creation

A BP record can be created automatically or manually from the WBS sheet. A new BP record
can be created for any WBS, and the BP record will be permanently linked to the WBS. A WBS
can be linked to one and only one BP record at a time.

In a Project, if any of the WBS Codes (the WBS Codes with line item data removed from P6)
have line item data, the system dismisses the data and sets the WBS Status
(uuu_cmwbs_Status) as inactive.

Note: In the scenario above, you will notice a discrepancy between P6
and Unifier.

When you attempt to create new line items, or records, in CBS- or WBS-type BP, the WBS
Picker will not display inactive WBS Codes.

In the EVM Sheet, the WBS Picker displays the all of the WBS Codes, regardless of the status.
This is so you can see the actuals for the WBS Code that you select.

Manual WBS Sheet

WBS Sheets Log

A default WBS Sheets log, where there is no System WBS Sheet, contains the Create option,
if you have the "Create" permission, which enables you to create a manual WBS Sheet.

If you do not have the "Create" permission for manual WBS Sheet, then the Create option will
not be available. If the System WBS Sheet has been created, then the embedded sheet will be
seen (with project drop-down) by default showing the current project name. You can navigate to
the other source project data (received from P6) by using the project drop-down.

When a manual WBS Sheet has been created, the WBS Sheets log displays the sheet title as:
Project WBS Sheet. The Project drop-down (on the top section) displays the current project as
the selected project. This Project drop-down will be seen all the time, and the value defaults to
the current shell name for the Project WBS Sheet.
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You can select another source (project) in the Project drop-down. The Project drop-down will
show the source if there is WBS data integrated from P6 or Primavera Cloud. The Project
drop-down will show the projects received from source (P6 or Primavera Cloud). When you
select a P6 project the WBS data that is related to the selected project will be displayed.

In addition to other options (explained in the previous topics), the toolbar within the WBS Sheets
log displays the following options:

» Add Sibling

» Add Child

The above options are available when the current project, for example Project WBS Sheet, is

displayed. If you navigate to a P6 or Primavera Cloud project, then the above options will not be
available.

The remaining options in the toolbar will be the same as seen for the WBS data received from a
P6 or Primavera Cloud project.

The Project WBS Sheet view has the default project row with:

» The project or shell number as WBS Code.
» The project or shell name as WBS Name.

The default project row is a read-only row in the sheet.

When you add a parent WBS Code, by using the Add Sibling option, a new WBS row will be
created with required fields such as WBS Code and WBS Name.

It is only after the creation of a new WBS row that the Cancel and Save options become
available. You cannot save your entry until the required fields are entered.

The condition above applies when you select the Add Child option.

Menu

The Menu option (the icon with three horizontal lines) contains the following options and
sub-options:

» Import

You can import the WBS codes by using a CSV file. The CSV import works similar to the
import of CBS codes in the Cost Sheet. When you select the current project, the following
options are available:

»  WBS Details
To create WBS codes along with hierarchy, using CSV file.

You can import the WBS Details in bulk by means of CSV import. This option, if you
select the current project in the project drop-down, enables you to:

- Add new WBS hierarchy and WBS codes.

- Update ETC technique (see below for more information) and other attributes for an
existing WBS hierarchy.

When you import new WBS codes, using CSV file, Unifier checks for duplicate WBS
codes. Your import will fail if:

- You have modified an existing WBS hierarchy in the CSV file.
- You have removed an existing WBS hierarchy, or WBS Code, in the CSV file.

87



Earned Value Management User Guide

4

88

When you import the WBS codes successfully, the new WBS codes will be appended to
the existing codes in the activity sheet. The audit log (Audit Log) entry for the creation of
the WBS code, using CSV import will be:

- Date: The date and time of the event that has occurred.
- Event: WBS Details
- Action: Import
- Old Value: Not applicable.
- New Value: Not applicable.

» Column Details

Export

You can export the WBS codes by using a CSV file. When you select the current project, the

following opptions are available:

»  WBS Details
To export the existing WBS rows in the Project WBS Sheet.
All of the columns that are seen in the WBS Sheet will be exported as column headers, in
the CSV file.
The entire WBS path will be seen in the first column, for the WBS Code. All of the existing
WBS codes will be exported in order to add new WBS codes at the end, by appending
the new WBS codes along with the hierarchy in the CSV file. You cannot remove the
existing WBS rows in the CSV file. Always new WBS Codes will be added using CSV file.
You cannot remove the existing WBS rows in the CSV file. New WBS codes will be
added using CSV file, always.

» Column Details
The following columns will be required and shown as required in the exported CSV file
(the first two columns of the CSV file):
WBS Code
WBS Name

» Summary WBS Sheet

Columns

Row Coloring

Variance Analysis Setup

» Create Variance Analysis Record

Earned Value Setup

This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. This option allows you to set an ETC technique (see below for more
details) that can be used in ETC calculations that will be performed at the WBS level. The
technique selected here will be applied to all the WBS Codes in the sheet. The technique will
override the individual WBS Code ETC technique selected, if one exists.

Properties

This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. This option will show the Project WBS Sheet default properties.

Audit Log
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This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. There are no changes to the events that get audited in System WBS
Sheet. For Project WBS Sheet audit log will capture the creation, update and removal of
WBS Codes in the Sheet. Besides any updates done manually in the Sheet will be audited.
The details of audit log in Project WBS Sheet is explained in further section.

The current project log, for example Project WBS Sheet, contains the following columns:

Column Description

Row number | This is a read-only column. This column does not have a header.
When you enter a new row, delete a row, or reorder rows, the row
numbers will get updated throughout the grid. You can use this column
to capture errors in the grid. For example, if you miss entering data in
a required field, or when validation fails, the cell for the corresponding
row displays a red triangle. You can click the triangle to see the errors
in a box, similar to a business process line item grid.

WBS Code This is an editable column and required when a new row is created by

(uuu_cm_wbsc |using the Add Sibling or Add Child options.

ode) The WBS Code value is unique across the hierarchy. The system
notifies you if you enter a duplicate WBS Code by way of an error
message.

The value of the WBS Code cannot contain dots (.) because dots are
used as separators in the WBS Path. Also, when creating or updating
WABS codes in a sheet, ensure that the value of WBS codes within a
CSV file (CSV import) or REST service do not include any dots. If the
system detects dots in the value of the WBS Code, then the following
message is displayed: Invalid data entered in the following field(s).

WBS Name This is an editable column and required when a new row is created by
(uuu_cm_wbsn | using the Add Sibling or Add Child options. The WBS Code value is
ame) unique across the hierarchy.

Linked This is a read-only column. This column is populated with the linked
Records record associated to the WBS Code. Unifier populates the icon of the

WBS Code that has the variance analysis record created.

Other columns | The other columns appear as defined in the column properties.

The fixed columns will be seen along with the user-defined columns. If
you do not define any user-defined columns, then by default all of the
fixed columns will be seen, only.

You can drag the child WBS codes to another location, below any parent. The WBS Codes
cannot be dragged to any row beyond the parent or hierarchy. You cannot drag a parent WBS
Code.

Gear menu (& ):
The gear menu is not available if you select multiple WBS rows (parent and child rows).
» Add Sibling
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To add a sibling to the row.
» Add Child

To add a child to the row.
» Copy

You can copy one or more WBS rows at the same level. This option is not available if the
selected rows are in a hierarchy. This option is available when you select multiple WBS child
rows, only.

» Paste

This option becomes available if you have copied a row. Use this option to paste the copied
rows in the desired location, in the sheet. This option is available when you select multiple
WABS child rows, only.

» Remove

This option becomes available if the WBS row is not associated to any activity sheet, or there
are no costs allocated. This option is not available if at least one WBS row is associated to
an activity sheet or has rolled up cost. This option is available when you select multiple WBS
child rows, only.

Rows Added to WBS Sheet

The WBS Sheet, with the WBS rows added, will be seen on the left-hand side of the log. When a
WBS Code is associated to the manual activities, the activity sheet name will be populated in the
Used By column field, displayed in the WBS Details in the right pane. The Used By column field
is a read-only field and displays all of the activity sheets that this WBS Code is associated with.
The Used By column field will be available in the General tab only, for the Project WBS Sheet.
It is shown as a first field in the tab.

The WBS rows that are associated with an activity sheet cannot be removed. You can edit, or
enter the data, in the editable columns in the sheet (the Cancel and Save options will become
available at this stage). The WBS Picker (in the cost business process) will show the current
projects WBS that are associated with the activity sheet along with the source projects WBS
codes. You can create transactions against the WBS codes of the current project.

Earned Value at Project Level

You can set up the earned value at project level. Under the Menu option (the icon with three
horizontal lines), use the Earned Value Setup option to open the Earned Value window and
select an ETC technique that can be applied to all of the WBS codes. The selected ETC
technique overrides the existing ETC technique defined at the WBS Code level.

In the Earned Value window, you can select the technique for computing estimate to complete
(ETC). By default, the ETC = Remaining Cost of activity option is selected. When you select
ETC = PF * (Budget at Completion - Earned Value), ETC is equal to a performance factor
(PF) multiplied by (Budget at Completion minus Earned Value), you can select one of the
following to set a value for the performance factor:

» PF=1

Performance Factor equals 1. This method yields an optimistic result with ETC equal to the
Budget At Completion (BAC) minus Earned Value Cost. This is the default option selected.

» Performance Factor =1/ Cost Performance Index
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Performance Factor equals 1 divided by the Cost Performance Index (CPI), where CPI
equals the Earned Value Cost divided by Actual Cost.

» PF=1/(Cost Performance Index * Schedule Performance Index)

Performance Factor equals 1 divided by the Cost Performance Index multiplied by the
Schedule Performance Index (the Earned Value Cost divided by the Planned Value Cost).

» PF = <select a value>
Performance Factor is specified by you. If you select this option, you must enter a value
(factor) in the field.

After you select an option and save your selection, Unifier displays the following message: The
selected ETC technique will be applied to all WBS Codes in the Sheet. Do you want to
continue? If you select to continue, then:

» The selected ETC technique will be applied to all WBS Codes.

» The audit log (Audit Log) of the WBS Code displays an entry of the ETC technique update.

If you select not to continue, then the selected ETC technique will not be applied to any WBS
Code.

Earned Value Setup at WBS Level

For the WBS level, in the Project WBS Sheet log (bottom portion of the log), you can click the
Earned Value tab to see the options for selecting a technique for computing the estimate to
complete (ETC). The Earned Value tab is available for both the summary level and leaf level
WBS codes. Once you select a technique, for the summary level WBS codes, you can apply the
ETC technique to all child WBS codes (Apply the ETC Technique to all child WBS Codes).

WBS Path Behavior in WBS Sheet

The General tab (in the Project WBS Sheet log (bottom portion of the log) contains a data
element (uuu_P6WBSPath) that shows the WBS Path.

Example

Projectl
w1
W2
Activity 1
For the WBS W2, the WBS Path will be displayed as Projectl > W1 > W2 so that any activity

created using W2 (as WBS Code) will show WBS Path as Projectl > W1 > W2, using the
auto-populate definition.

WBS Sheet Properties Window

You can use the Menu option (the icon with three horizontal lines) in the Project WBS Sheet or
System WBS Sheet to access the Properties.

When a manual WBS Sheet is created (through the Create option in the log), Unifier creates the
following properties, automatically:

» Name
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The name of the WBS sheet. For example, Project WBS Sheet. This field can be 100
characters long.

» Description

The description of the WBS sheet. This field can be 4000 characters long.
» Last Modified

This is a read-only field. The date the WBS sheet is created or updated.
» Created By

This is a read-only field. The signed in user who created the WBS sheet (using the Create
option).

Project WBS Sheet (Audit Log)

You can the Menu option (the icon with three horizontal lines) to access the System WBS
Sheet and Project WBS Sheet audit log (Audit Log). The audit log captures the details for all of
the manual WBS sheets (including their attributes) that have been created, updated, and
removed. The audit log entries for the events such as manual creation or update of the WBS
Codes and Earned Value Setup will be as follows, and all of the events are audited similar to
the System WBS Sheet:

Attribute Update Reason |Date Event |Action |Field Old |New
Valu |Valu
e e
WBS Code create Date and |Projec |Create |[<WBS Code> Not |<Ne
time event [t WBS appli |w
occurred |Sheet cabl |Valu
e e>
Fields in WBS attributes |Date and |Projec |Updat |<WBS Code> > <Old |<Ne
updates either from time event [t WBS |e <Field Name> valu |w
sheet or from form view |occurred |Sheet e> |Valu
e>
WBS Sheet level setups | Date and |Earne |Create | Project WBS Sheet |Not |<Ne
time event |d > Earned Value appli |w
occurred |Value Setup > All WBS cabl |Valu
Setup Codes e e>
WBS Sheet level setups | Date and |Earne |Updat |Project WBS Sheet |<Old |<Ne
updates time event | d e > Earned Value Valu |w
occurred |Value Setup > All WBS e> |Valu
Setup Codes e>
Rearrange of WBS Date and |Rearra|Cut, <WBS Code> <old |<ne
Codes will be audited time event | nge Copy, locat |w
occurred and ion> |locati
Paste on>
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Adding Columns to a WBS Sheet

You can add WBS custom attributes to a WBS sheet, as columns. The WBS Sheet window

toolbar menu drop-down (the icon with three horizontal lines) = enables you to add columns
to the WBS Sheet.

Note: By default, all of the predefined columns that are in hidden block in
the WBS Attribute Form will display when you open the WBS sheet.

The following explains how to add a column by way of creating a new column or copying an
existing column.

To add a new column:

1) On the toolbar, click the Add Column icon [m(the three vertical bars) to open the New
Column window.

2) Enter or select values in the following mandatory fields:
Name
Type
Datasource
Data Format
Display Mode
Total
Column Position
The following fields are optional and enable you to customize you newly added column:
» Data Format
» Display Mode
» Total
3) Click Save, or Save & Add New to continue.

No VA WD~

The following explains the mandatory fields:
Name

The name of the column that you want to add. The value in this field is pre-populated
according to the selected Datasource; however, you can override the pre-populated value.

Type
This field has the following options:

» Business Process Data Source: When you select this option, all of the data elements,
based on SYS BP Decimal Amount and SYS BP Currency Amount which are added on
the WBS Attributes Form, are displayed in the Datasource drop-down list. Select this
option if want to pull the roll up information for the new WBS (Type-cost BP). The
Datasource drop-down list will be displayed followed by the Formula creator option
which enables you to create the query for the column. When you select the Formula
Picker, the Formula creator window displays the list of new Cost-type BPs with different
statuses where you can select BPs to see the roll-up amount.
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» Direct Cell Entry: When you select this option, all of the data elements, based on SYS
Numeric and Date logical data sources, are displayed. You can define manual entry
column by using the logical sources. You can copy the data in the Direct Cell Entry field
and paste it into other manual entry column.

» From EVA Sheet: When you select this option, all of the data elements, based on SYS
Numeric logical data sources as data sources, are displayed. Select this option if you
need to populate data into WBS sheet from an EVA sheet. When you select the logical
data source, you can select the sheet name and available DEs, per selected sheet, are
displayed as columns to add.

» From Activity Sheet: Select this option if you need to populate data in to the WBS Sheet
column from an Activity Sheet. When you select this option:

= All of the data elements are displayed in the Datasource field (based on SYS
Numeric logical data sources and SYS Date logical sources).

= The logical data source, you can select the sheet name and available DEs, per
selected sheet, are displayed as columns to add.

= When you select the SYS Date logical data source, all of the date columns (like
Planned Start, Planned Finish, etc.) from the Activity Sheet will be available to
pick.
» WBS Custom Attributes: When you select this option, all of the custom attributes that
are added in WBS Attributes Form are displayed.

» Formula: When you select this option, all of the data elements are displayed in the
Datasource field (based on SYS Numeric, SYS Date logical data sources, and SYS
Integer Amount). If you select Formula as the type, then the Datasource field displays
the following:

= Alist of all of the SYS Numeric and SYS Date logical source data elements that
allow formula-type entry. The logical source data elements that already have been
used to create a column will not be listed.

= A formula creator window (Formula Creation Window) that you can use to create
the formula for the column. The formula window shows the list of all numeric
columns tha can be created as formula.

Datasource

The drop-down list displays a list of all SYS Numeric and SYS Date logical source data
elements which allow the formula-type entry. The sources that have been used to create a
column will not display in the list. The Datasource drop-down list will be displayed followed
by the Formula creator option which enables you to create the formula for the column. The
Formula window shows all of the list numeric columns (all Numeric Columns) that can be
created as formula.

Data Format

The data format options are:
» Currency
» Decimal

The Data Format option is available only when SYS Numeric logical source Datasource is
selected, and by default the Currency must be selected. There are no data format for Date-
and String-type data elements.
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If you select the SYS BP Currency Amount data element, then the default option will be
Currency.

If you select the SYS BP Decimal Amount data element, then the default option will be
Decimal.

When you select Decimal, and proceed to choose a number, Unifier displays the choice of
decimal places (values are zero to eight).

Summary Rows

Within the formula columns, in the WBS Sheet, you can select the type of summary rows that
you want to display. The options under the Summary Rows block enable you to display the
roll-up value from children (Sum of All Rows), or to display the formula value (Use Formula

Definition). Your options are:
» Blank

» Sum of All Rows

» Use Formula Definition

Display Mode
The display mode options are:

» Show
» Hide

Total

The total options are:

Blank

»  Sum of All Rows

» Use Formula Definition: This option is available for a formula column.

Column Position After

To position the newly added column.

» If you choose a column in the Cost sheet and then select to add a column, then the
Column Position After drop-down will be pre-populated according to the name of the
selected column in the WBS sheet.

» If you select no column and then select to add a column, then the Column Position
After drop-down will be pre-populated according to the name of the last column in the

WBS sheet.
To add a new column by way of copying an existing column:

I.  On the toolbar options, click the menu drop-down (the icon with three horizontal lines) =

2. Click Columns.
3. Click Copy Column Data to open the Copy Column Data window.
4. Select values in the following fields:

=  Copy from Column (mandatory)

= Percentage

= Past to Column (mandatory)
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5. Click Save to continue.
The following explains the fields:

Copy from Column (mandatory)
Displays all of the existing manual-entry or formula-based numeric columns for you to select.
Percentage

To enter the percentage value. The value must be greater than zero and less than or equal
to 100.

Paste to Column (mandatory)
Displays all of the existing manual-entry numeric columns for you to select.

If you right-click on the Direct Cell Entry of a numeric column, you can hide, lock, copy (the
column data), paste (the column data) into, delete, or see the properties of that column. The
Copy Column Data option is available only for:

» Direct Cell Entry columns
» Custom elements that have been added as columns

The Copy from Column field will be pre-populated with the name of the selected column;
however, you can change the source to any other source.

If you right-click on the column header, you can see some or all of the following options:
» Insert

» Hide this Column

» Lock after this Column

» Delete

» Properties

Entering WBS Code into a System WBS Sheet

Additional ways to enter the WBS code into a System WBS Sheet are by using import CSV or
REST services.

Note: The REST service data corresponds to the columns in the CSV
template.

You can import bulk WBS codes by way of CSV. When you use a CSV template to import data:
The value for the ETC Technique mandatory field, in the CSV template, is the remaining
cost for the activity, by default, if you do not enter any other values.

The values, or codes, for the allowed ETC Technique are:
1 = Remaining cost for the activity
2 = 1*(BAC-EV)
3 = 1/(CPI)*(BAC-EV)
4 = (1/CPI*SPI)*(BAC-EV)
5 = Performance Factor * (BAC-EV)

For a WBS, you can enter "Yes" as the value for the Apply ETC Technigue to Child WBS field
to use the same ETC Technique value to the child WBS.
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The default value for the WBS Status is Active.

Once you finished preparing the CSV template, you can save the file and proceed to import the
CSV file into the System WBS Sheet. To import:

1) Open the System WBS Sheet.

2) Click Menu Options, click Import, and click WBS Details.

3) Navigate to the location of the CSV file, select it, click Open, and confirm the import. You
can see that the values are added in the columns (WBS Codes, WBS Name, and so forth).

Editing the Default Values of the Columns

In the System WBS Sheet log, you can edit the default values of the columns (Planned Units,
Actual Units, and so forth).

1) Click on the column header to select.
2) Right-click and click Properties.

3) Proceed to update the fields in the Column Properties pop-up window. You can change the
default columns structure in the Column Properties window.

Roll-up Value

In the System WBS Sheet log, you can add columns and conduct a roll-up value for the added
column, either by using all manual activity sheets or a single activity sheet.

When you add a new column, you can select the (right-click in the Sheet Name field of the New
Column window) All Manual Activity Sheets option to get the data (roll-up) from all of the
activity sheets, and not just one. You can do the roll-up from activity sheets with Active status,
only.

Auto-Creating Variance Analysis BP Records

The WBS Sheet window toolbar menu drop-down enables you to set up the variance analysis.
Click the toolbar menu drop-down icon and click the Variance Analysis Setup option. Use this
option to set up the auto-creation of business processes for all of the WBS Codes. The option
enables you to open the Variance Analysis Setup window and select the following elements in
order to be able to create the variance analysis record:

» Business Process
The Business Process field enables you to select the business process (BP) record that
must be auto-created. You can select from a list of all BPs that are active in the current
project or shell, one BP at a time.

» Initiation step

Selecting the Bypass Initiation Step during auto creation option enables you to create
workflow BP records by passing I-Step during auto-creation and land on the second step of
the workflow. In case of a non-workflow BP, an auto-created record will be in submitted
mode.

» Workflow
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The Select Workflow field is available when multiple workflow schemas are available for the
BP that you have selected. If the selected BP is a Non-Workflow BP, then the Workflow field
will be disabled.

Record Owner

You can see the User Pickers, OBS Pickers, or User Data Pickers that have been added in
the WBS form.

» Trigger Conditions

You can add one or more conditions to determine the trigger condition of the WBS. For
example, the WBS Type can be CA. Once you select the trigger condition, click the plus icon
(+) to see an empty row in trigger conditions. A trigger condition is not required to save the
variance analysis setup. The Trigger Conditions block lists the following information:

- Data Element
- Condition
- Value
- Message
» Schedule

Under the Schedule block (scroll down on the Variance Analysis Setup window) you can
schedule auto-creation of the BP record and set frequency.

Range of Recurrence
You can determine a range for auto-creation to reoccur.

Create Variance Analysis Record

Note: Before creating a Variance Analysis Record you must set up the
variance analysis (Variance Analysis Setup).

When you click the Create Variance Analysis Record option you trigger the auto-creation of
the BP that you have selected during the variance analysis setup for all the WBS Codes.

Viewing a WBS Sheet

The View option enables you to change the view of your WBS Sheet window. You can use this
option to access created views, create new views, or manage the existing views.

» Default

» Create New View

» Manage Views
You can click the three vertical dots on the left-hand side of the window, or the three horizontal

L ]

dots at the bottom of the window,(* or *+#) to expand the window and see the properties of
any selected WBS Code.

The Default view provides a view similar to the BP log view, Cost Sheet log view, or other logs
with the Standard View option.

To create a new view for the WBS Sheet worksheet window, click Create New View, then:
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Use the Save View As field to name your new view. If you save a new view without selecting
any columns, then a new view is created with the WBS Code and WBS Name columns.

Use the following tabs for adding columns, filtering, grouping, and sorting:

4
4
4
4

Columns tab
Filters tab
Group By tab
Sort By tab

The Available Columns box displays all user-defined columns that you may need for your
newly created view, including the Linked Record. The Selected Columns box displays all of
the columns that you select. You can move columns in and out of the Selected Columns box.

Note: By default, Unifier includes the WBS Code and WBS Name
columns in the Selected Columns box; therefore, these two options are
not listed in the Available Columns box.

Use the following fields to set the position of the new view:

» Left Lock after Column

Displays a list of all columns, except the last column from the selected columns list. By
default, the "None" option is selected, which means that you have chosen no column to be
locked, from the left of the sheet.

Right Lock after Column

The default value is "None," which means that you can select not to right-lock the column in
the view. Other values in this field are based on the value that you have selected in the Left
Lock after Column.

The Filters tab enables you to filter the rows by WBS Sheet column data, or by WBS Attributes.
For WBS Sheets, there are two sections in this tab: WBS Attributes and Sheet Columns.

The Search Parameters block displays all of the DEs from the WBS Attribute form that are
added in uDesigner (this includes elements from WBS Attribute form that are added as
columns). The list also includes the fixed 8 columns that will be seen in WBS Sheet.

When a filter is applied, the view shows all of the WBS rows that match the filter criteria, with
their Summary Codes.

Additional check box for filtering rows with Linked BP records is also available (WBS Codes
with Linked BP Records). When you select this option, when filtering, then only the WBS
Codes that have linked records will be filtered.

The Group By tab has two columns:

» Group By
Displays all of the attributes that are added in the WBS form, which includes all of the
custom DEs. By default, "None" is selected, and you can select any field to set the Group
By. All columns include linked records column.

» Order

By default, the Ascending Order is selected, but you can select to show the contents of
the column in Descending Order, when groups are displayed.
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The Sort By tab has two columns:

» Sort By

Displays all of the columns that are added in the WBS Sheet. By default, "None" is
selected, you can select any field and set Sort By.

» Order

By default, the Ascending Order is selected, but you can select to show the contents of
the column in Descending Order, for the data to be displayed in selected Sort By
column.

To manage the view for the WBS Sheet worksheet window, click Manage Views, and select
which of the available views (under the View Name block) you want to become visible to the
user. The Cancel and Save options enable you to cancel your changes (no changes will be
saved and window gets closed) or save any changes that you have made and close the window.

The Edit View option enables you to change the view of your WBS Sheet window. The function
of the Edit View option is identical to Create New View.

WBS Sheet with User-Selected View

When you select a user-defined view in the WBS Sheet worksheet window, you will notice the
following changes:

Toolbar options:
In the toolbar options, the Add Column option is not available, but the following toolbar
options are available:
» Edit View
» Print
» Refresh
» Find on Page
» Collapse All Groups
» Expand All Groups

Menu options (the three-horizontal lines with drop-down arrow):

» Row Coloring (Multiple Colors, Single Color)
» Variance Analysis Setup
The row coloring changed in the view will be temporary.

Gear menu (% ):

The gear menu ( % ) options available (for each WBS Code) enable you to expand or
collapse the component.

The gear menu ( £ ) options available (for each WBS Code component) enable you to
Create Variance Analysis Record in addition to expanding or collapsing the component.

Column menu options and cell properties:

The column menu actions are not available when you right-click the column header.
When you click in a cell, the right pane opens with the following editable tabs:
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» General tab
» Variance Analysis tab
» Linked Records tab
» Variance Analysis History tab
You can use:
= The Expand icon to expand the right pane.
= The Doc Bottom icon to move the right pane under the WBS Sheet worksheet.

Drag and Drop columns option:

You can drag and drop columns to different locations on the WBS Sheet worksheet. When you
do so, the user-defined view name (nhame is shown in the View field of the toolbar) will get the
prefix: (Modified).

Edit View toolbar option:

Use the Edit View toolbar option to modify the user-defined view. You can modify the list of
available columns, apply filters, change grouping, or change sorting.

In the Group By tab, you have the option of grouping based on appropriate rows grouped

within, in the view. Once you set the first option for group by, you can use the gear menu ( &
) to add the second option. The header of each group, with its appropriate rows, appears as
an additional column before the WBS Code Column. Once you set the group-by to the view,
the group summary row displays the summary value based on the group by column
Properties > Total option. The summary, sum of all rows, formula definition will be blank.

The data seen in the user-defined view will be based on the filters selected in the view.
For the numeric columns, the filter total will be shown along with the column total.

WBS Sheet views when you switch between P6 Projects

After applying a user-defined view, if you switch to another P6 Project, then the data will be
filtered based on the selected view. Also, when drag and drop a column in a user-defined view,
the view name will be prefixed with: (Modified). In this case, if you switch to a different P6
Project, still the (Modified) view name is displayed until you close the WBS Sheet. Position of
the columns and sort order of the columns remain as is, when you shift between different P6
projects, for a user-defined view.
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OBS Sheet Node

An Organization Breakdown Structure (OBS) sheet contains the following information:

Full Name

Short Name
Unifier User
Title

Department
Status

WBS Name
Contract No
Weekly Capacity

Vv vV vV vV vV VvV vV v Vv

The OBS Sheet node log displays the only available OBS sheet.

In This Section

OBS Sheet Node LOG WINAOW .......ccooiiiiiiiiii e 103
ACCESSING aN OBS SHEEL ... e 104
Creating an OBS SNEEt.........uuuuuiiiiiiiiiiiiiii e 105

OBS Sheet Node Log Window

To access the OBS Sheet log, go to the shell (User mode), click to expand the Activity
Manager module, and click OBS Sheet.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the OBS Sheet log window to:

» See the list of OBS sheets with corresponding general information.
» Access an OBS sheet.

The OBS Sheet log window is divided into two panes:

» Grid or table (left-hand)
» General tab (right-hand)
» Audit Log tab (right-hand)

When you click on an OBS sheet on the grid, the General tab display the details about the OBS
sheet. The Audit Log tab displays a list of events with details. In the General tab, the Name
field will be editable as long as the OBS sheet is not used anywhere. The Description field will
always be available for changes. If you have View and Modify permissions, you can export the
Audit Log into a CSV file. A CSV export contains all the fields in the OBS sheet.
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Accessing an OBS Sheet
To open an OBS sheet form the OBS Sheet log window:
1) From the OBS Sheet log window, click on a row.

2) Click to open the gear menu ( ).
3) Click Open to open the OBS Sheet log.

The OBS Sheet log has the following toolbar options:

» Add Sibling

Enables you to select a record and add an associated member.
» Add Child

Enables you to select a sibling and add an associated member.
» Actions

Enables you to import or export data.
» Find on Page

Enables you to search a for an OBS sheet on the log.
» Expand All Groups or Collapse All Groups

Enables you to expand or collapse an OBS sheet to see the subordinates. The tree- like
structure displays the summarized OBS and corresponding values of the project selected in
the Projects list. You can export the OBS structure from the sheet.

The OBS Sheet log displays the following required information about each OBS sheet:

» Full Name
» Short Name
» Status

The OBS Sheet log displays optional information about each OBS sheet such as:

Unifier User
Title

Department
WBS Name
Contract No
Weekly Capacity

You can click the X icon to close the OBS sheet, exit the OBS Sheet log, and return to the OBS
Sheet log window (Activity Manager module > OBS Sheet node).

v v v v v Vv

Additional information

OBS structure can also be generated through CSV import. Template can be exported using the
Export Data.

OBS Picker

The OBS picker will be available for assigning an OBS to WBS Sheet. The OBS Picker will
display only the OBS records with Active status.
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Note: The OBS picker supports both "And" and "Or" query conditions.

Creating an OBS Sheet

When there are no OBS sheet available, you can go to the OBS Sheet log window (shell > User
mode > Activity Manager module > OBS Sheet node) and create one.

Note: Once an OBS sheet is created, the Create option will no longer be
available because a shell can have one OBS sheet, only.

To create an OBS sheet, when there are none:

1) Click the Create drop-down menu and click to select one of the following options:
a. New

To open the Create OBS Sheet window and complete the fields required for creating a
new OBS sheet.

When finished, click Create.
b. From Template

To open the Templates window and select the required template for creating a new OBS
sheet.

When finished, click Select.
c. From Project

To open the Projects window and select the required project for creating a new OBS
sheet. You can select one project, only.

When finished, click Select.
2) Click Save to complete creating an OBS sheet.

About Unifier and P6 Integration

You can integrate multiple P6 projects into one Unifier project.

» When you integrate (Project ID mapping) a P6 project into a Unifier project through the
General tab of the Shell Attribute form, the application updates the Schedule Type field in
General tab.

The General tab is mostly used for one-to-one integration (one P6 project mapped to one
Unifier project).

» When you integrate (Project ID mapping) multiple P6 projects into one Unifier project through
the Integration tab of the Shell Attribute form, the application does not update the
Schedule Type field in the General tab.

In the Integration tab, the Schedule Type column is updated.

The Integration tab is mostly used for many-to-one integration (many P6 projects mapped to
one Unifier project).

Prior to the Unifier 20.7 release:
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When you performed Get Data from the Activity Sheets log, if the P6 Project ID was not
defined in the Shell Attribute form (General tab and Integration tab), then the system
would use the first import synchronization: Select Synchronization to Exchange Activity
Data.

When you performed Get Data from the Activity Sheets log, if the P6 Project ID was
defined in the Shell Attribute form (General tab and Integration tab), then the system
would the second import synchronization: Select Synchronization to Exchange Activity
and Assignment Data.

Starting with the Unifier 20.7 release:

When you performed Get Data from the Activity Sheets log, whether the P6 Project ID is
defined, or the P6 Project ID is not defined, in the Shell Attribute form (General tab and
Integration tab), the system uses a single import synchronization: Select Synchronization
to Exchange Activity Data.

The drop-down field (Select Synchronization to Exchange Activity Data) displays all of
the import synchronizations defined in Gateway for Unifier deployment, including the import
synchronizations to get activity and assignment data which is used for EVM.

The system refers to the drop-down field (Select Synchronization to Exchange Activity
Data) for the import synchronization selected in all of the following cases:

a. P6 Project ID is added in the Integration tab
b. P6 Project ID is added in the Shell Attribute form

c. When the project number in the Shell Attribute form matches with the P6 project
number.

Update of CBS Codes from P6

You can get the latest CBS Codes updates assigned to activities from P6 into the activity sheet,
using gateway integration.

The Get Data synchronization that creates the activity sheet populates the following data:

4

Scheduling data (activities along with assignments and spread data) from the P6 projects
mapped to the current shell in the Integration tab.

CBS Codes assigned to the activities.
CBS Codes assigned to the resource and role assignments.
Roles and Resources along with rates assigned to the activities.

Note: Subsequent updates of Role and Resource Rates in P6 will not
trigger the updates in the Master Rate Sheet; however, subsequent
updates of CBS Code for activities in P6 will trigger the updates in the
Activity Sheet CBS assignments.

You can use P6 to capture duration as well as resource assignments (resource units, resource
CBS assignment, resource units spread, actual resources consumed till date, and so forth). The
Activity Sheet, in this case, can receive all of the resource units, CBS assignments, and
calculate costs using P6 data and rates.

106



Working with Earned Value Analysis

Note: The export of CBS Cost codes from Unifier remain as is.

You can receive the latest updated CBS assignments to Activities and Resources and Role
assignments when P6 data is pulled into the Activity Sheet. After the latest Get Data, you will be
able to see that the CBS assignments updated in the Activity Sheet and re-costing sums the
costs, by the latest CBS assignments. This applies to the existing Activities and Resources and
Role in the Activity Sheet.

Note: All of the cost calculations will be updated based on the CBS
assignment updates. In addition, any new earned value analysis (EVA)
created will show the EVM data according to updated CBS Codes.

The following scenarios explain how to get the latest CBS codes updates assigned to activities
from P6 into the activity sheet using gateway integration:

» CBS Code assigned to the activity are updated from P6, and the CBS Code received is
inactive in project cost sheet

If the CBS Codes that are assigned to the activities, and updated, in P6, and the CBS Codes
are not active in Unifier Cost Sheet, then the Earned Value Analysis will not show those CBS
Codes even though they are updated in the activity sheet. In this case, you will not be able to
create BP actuals as those codes will not be shown in the CBS Picker.

If the CBS Codes updated for an Activity in P6 is no longer active in the Unifier Cost Sheet,
then do not update the current CBS assignment for the activity. There will be no change in
cost calculations.

The History tab log will show the following message: The CBS Code <CBS codel> received
from the P6 in Resource < Resource Name> of Activity <Activity ID> is inactive in the Unifier
Cost Sheet and cannot be updated. This indicates that the activities (where the CBS
assignments are) have not been updated.

For CBS Code assigned to the resources are updated from P6 and CBS Code received is
inactive in project cost sheet:

If the CBS Code (updated for the resource in P6) is no longer active in the Unifier Cost
Sheet, then do not update current CBS assignment for the resources. There will be no
change in the cost calculations.

In this case, the history log will show following message: The CBS Code <CBS codel>
received from the P6 in Resource < Resource Name> of Activity <Activity ID>. This
indicates that the activities where the CBS assignments are, have not been updated.

If the CBS Code is updated both at the activity and at the resource assignment level in
P6, and the updated codes are inactive, then the following two messages will be seen in
the history log:

The CBS Code <CBS codel> received from the P6 in Resource < Resource Name> of
Activity <Activity ID> is inactive in the Unifier Cost Sheet and cannot be updated.

The CBS Code <CBS Codel> received from the P6 in Resource < Resource Name> of
Activity <Activity ID> is inactive in the Unifier Cost Sheet and cannot be updated.
Similarly, if the CBS Code that has been updated for the role in P6, and the CBS Code is
no longer active in the Unifier Cost Sheet, then do not update the current CBS
assignment for roles. There will be no change in cost calculations.
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The History tab log will show the following message: The CBS Code <CBS codel>
received from the P6 in Role < Role Name> of Activity <Activity ID> is inactive in the
Unifier Cost Sheet and cannot be updated. This indicates that the activities (where the
CBS assignments are) have not been updated.

» CBS Code is removed for Activity or Resource assignment in P6:

If the CBS Code assignment do exist for the activity in Unifier Activity Sheet, then do not
clear the CBS assignment (with the latest data from P6). This is the case where CBS Code
assigned to an activity is removed in P6 projects, and you received the latest activity data
from P6 using the Get Data option.

The History tab log will not show any additional warning messages; however, the system
ignores any cleared CBS assignments from P6.

» CBS Code is changed in Activity or Resource assignment in P6 and the activity sheet is
updated with latest CBS assignments:

The existing EVA will start to show the PV or AC, CV, and so forth for both the old CBS
Codes and the new CBS Codes.

The BP actual will no longer show the actuals that have line items with the old CBS Codes in
the EVM Sheet (default view).

About Unifier and Oracle Primavera Cloud Integration

In the Activity Sheet overlay page, you can use the Open Project in <source name> option
(see System Activity Sheet) to open the Oracle Primavera Cloud page and open the source URL
either in P6 or Oracle Primavera Cloud, in a new tab. The Activities tab points to the relevant
project data (the project that is selected in the drop-down provided there is an active login
session).

The login on the new tab for P6 or Oracle Primavera Cloud will be displayed where you ender
your login credentials to sign in and see the relevant project data.

Note: You can see the project is opened even when that particular
project is closed in the source server.

Selecting this icon will open the source application in a new tab provided there is a valid URL
specified. If no URL is defined in the company properties page, then this link will not be shown in
the Activity Sheet.

Also, when you switch to Baseline, the link is not displayed.

Source Application Link in Activity Sheet

In order for the link to open a project in P6, from the Unifier Activity Sheet, you must manually
add the mappings, as seen on the left hand side for project mapping template in the "Sync P6
and Unifier Projects."”
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Note: The mappings are not available in the project mapping template.

Parameters needed for the project mapping template in "Sync P6 and Unifier Projects:"

P6 Gateway Unifier
WBSObjectld p6_wbs_id uuu_int_internal_WBSObjectld
Objectld InternalProjectid uuu_int_internal_proj_id

Similarly, in order for the link to open a project in Oracle Primavera Cloud, from the Activity
Sheet, you must manually add the mappings, as seen on the left hand side for project mapping
template in the "Send Primavera Cloud Project data to Unifier."

Parameters needed for project mapping template in "Send Primavera Cloud Project data to
Unifier:"

P6 Gateway Unifier
projectid InternalProjectid uuu_int_internal_proj_id

Activity Sheet Created from P6 through Gateway

Activity sheets capture the project scheduling data that is coming from either:

a) P6 project, or
b) Oracle Primavera Cloud project.

The project data (both current and baseline projects) from P6 or Oracle Primavera Cloud that is
brought over to Unifier by way of non-EVM synchronizations will be added to the activity sheet
which can further be used in cash flow analysis.

The costs associated to the activities can be rolled up to the cost sheet. In general, you can
assign a CBS code to the activities in the Activity Sheet when the activity sheet is created by
using non-EVM synchronizations. This enables you to use the schedules, or costs, associated
with the CBS code in your cash flow analysis. In particular, you can:

» Assign CBS Codes (cost codes) to the activities in the Activity Sheet created using non-EVM
synchronizations.

» Assign CBS Codes (cost codes) to the activities in the Activity Sheet created using EVM
synchronization for duration based schedules.

» Remove CBS assignments (assigned cost codes) to the activities, and resource
assignments, in the Activity Sheet.

» View the planned, actual, at completion, remaining units, and costs associated with the CBS
Codes (cost codes) in the cost sheet.

You can create an activity sheet, from the Activity Manager, by using the Get Data option, by
way of P6 or Oracle Primavera Cloud integration with the following OOTB synchronizations
available in Gateway Integration Settings:
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a) Get Activity data from P6
b) Get Activity and Assignment data from P6 for EVM
c) Send Oracle Primavera Cloud Activity data to Unifier

When you create an activity sheet by using the "Get Activity data from P6" or the "Send Oracle
Primavera Cloud Activity data to Unifier" synchronization, and using the "Get Activity and
Assignment data from P6 for EVM" synchronization for duration-based project, you can assign
CBS codes to the activities in the Activity Sheet regardless of the schedule type. This ability is
applicable to Activity Sheet created with:

» Duration schedules.
» Resource-loaded schedules.
» Cost loaded schedules.

Note: You can bring CBS codes from P6 using the "Get Activity data
from P6" and "Get Activity and Assignment data from P6 for EVM"
synchronizations for the resource-loaded and cost-loaded schedules.

In an existing activity sheet that has been created by using "Get Activity and Assignment from
P6 for EVM" synchronization,

» The Assign CBS options in the Actions field changes to Assigh CBS Code, and the
Assign CBS window label changes to the Assign CBS Code.

» The Assign CBS option in the gear menu ( ) changes to Assign CBS Code.

In an existing activity sheet that has been created by using any source-application (for all types
of schedules: Duration-based, Resource-loaded, and Cost-loaded):

» The Assign CBS Code option, in the gear menu ( % ), allows you to add a CBS code to the
activity sheet that uses the Duration-based schedule. You can select a CBS code from the
cost code picker. The cost code picker enables you to select an active CBS code from the
project cost sheet.

In the Assign CBS Code window, the General tab displays the associated CBS codes.
The Assign CBS Code option in the Actions field enables you to assign or update a single
CBS code for multiple activities (in bulk), one at a time. In this case, the General tab of each
activity sheet shows the updated CBS code.

» Any CBS code updates that have been made to an activity sheet will be audited and
displayed in the Audit tab.

» Use the Export CSV option, in the Actions field, to export the CBS code assignments for
the Resource-loaded and Cost-loaded schedules.

» The Remove CBS Code option, in the gear menu ( % ), enables you to remove the existing
CBS assignment for the activity sheet. This option is only available if the activity sheet has a
CBS code assigned to it.

For Duration-based schedule, when you select the Remove CBS Code option:

» If you select Yes, then the system removes the CBS code assigned to the activity sheet.
The audit log will have an entry for an assigned CBS code that has been removed for the
activity sheet.

» If you select No, then the assigned CBS code remains as is.
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In an existing activity sheet that has been created by using Resource-loaded and
Cost-loaded schedules, when you select the Remove CBS Code option:

» If you select Yes, then the system removes the CBS code assigned to both the activity
sheet and the resource (Resource/Role). The audit log will have an entries for an
assigned CBS code that has been removed for the activity sheet and the resource.
Oracle recommends that you perform recost in order to calculate the costs (based on the
CBS code update).

» If you select No, then the system informs you that you can only remove the CBS code
assigned to the activity sheet. If you select Yes, then the system removes the CBS code
assigned to the activity sheet. The audit log will have an entry for an assigned CBS code
that has been removed for the activity sheet. Oracle recommends that you perform recost
in order to calculate the costs (based on the CBS code update).

For Resource-loaded schedule, when you select the Remove CBS Code option:

» If you select Yes, then Unifier removes the CBS code assigned to the resource
(Resource/Role). The audit log will have an entry for an assigned CBS code that has
been removed for the resource (Resource/Role).

» If you select No, then the assighed CBS code remains as is.

To assign a CBS code or remove a CBS code for activities, in the Activity Sheet:

1) Go to your shell and from the left Navigator click Activity Manager to expand the node.
2) Click the Activity Sheet sub-node.

3) Inthe Activity Sheet log, click to select the activity that you want.

4) Click the gear menu ( %) to open the menu and select one of the following options:
a. Assign CBS Code

When you select Assign CBS Code, the Assign CBS Code window opens which
enables you to use the cost code picker to select the cost code that you want to assign to
the activity sheet. The cost code picker displays only the active CBS codes within the
Cost Sheet.

The CBS code that you select to assign will become inactive after you assign it to the
activity sheet; however, the existing activity sheet data will roll up to the cost sheet and
you can view the data, for the Resource-loaded and Cost-loaded schedules.

For the inactive CBS codes, the new activity sheet data that is coming from P6 will not be
rolled up to the cost sheet. The CBS code assignments to the activities are audited and
the added or updated CBS codes are displayed in the audit log. This includes the CBS
code updates coming from any source by way of Get Data.

Using Get Data enables you to get the Manage CBS Assignments to the activities, from
P6 by way of integration.

You can update a CBS code by way of Get Data from the Activity Sheet log, and the
Cost Sheet will be updated accordingly.

If you do not have permission to update the Activity Sheet, then the gear menu ( ¥ ) and
the Actions menu will not display the Assign CBS Code, or the Remove CBS Code
options.

b. Remove CBS Code
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Audit tab of the Activity Sheet

For every Activity Sheet, the Audit tab displays the audit log for each activity whenever the
following CBS Code updates are done at the activity level:

» New CBS Code assigned to the activity.

» Updating a CBS code assigned to the activity.
» Removing the CBS code assigned to the activity.

The audit log columns display information such as:
Event

Displays "Assign CBS Code" or "Update CBS Code," corresponding to the events that resulted
in adding or updating a CBS code. This column also displays "Remove CBS Code" in case of
removing the CBS code assigned to an activity.

» Field Name
Displays the activity ID.
» Old Value

Displays the existing CBS code. When you remove an assigned CBS code, this column
displays the existing CBS code.

» New Value

Displays the assigned CBS code. When you remove an assigned CBS code, this column
does not display any data.

Assigning a CBS code to multiple activities in the Activity Sheet created by using EVM
synchronization for Resource-loaded and Cost-loaded schedules:

Similar to assigning or updating a CBS code for an activity sheet, you can use the Assign CBS
Code option in the Actions field to assign or update a single CBS code to multiple activities (in

bulk), one at a time. In this case, the General tab of each activity sheet shows the updated CBS
code.

When you select the Assignh CBS Code option, in the Actions field, for an activity sheet, the
Assign CBS Code window opens. You can select a CBS code from the cost code picker. The
cost code picker enables you to select an active CBS code, from the project cost sheet, and
assign it to the selected activities. The audit log will have an entry for an added or updated CBS
code.

Assigning a CBS code to multiple activities, in the Activity Sheet created by using
Duration-based schedule, using the Export CSV option:

Use the Export CSV option in the Actions field to assign a CBS code to multiple activities (in
bulk), one at a time. Unifier will automatically performs validations (valid CBS code and active or
inactive CBS codes) regarding the assigned CBS code.

Removing a CBS Code from multiple activities in the Activity Sheet created by using
Duration-based, Resource-loaded, and Cost-loaded schedules:

Use the Remove CBS Code option in the Actions field to remove a CBS code assigned to
multiple activities (in bulk), one at a time. When you select the Remove CBS Code option:
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» If you select Yes, then the system removes the CBS code assigned to selected multiple
activities (in bulk). The audit log will have an entry for an assigned CBS code that has been
removed. For the Activity Sheet created by using Resource-loaded and Cost-loaded
schedules, Unifier requires your confirmation. If you select Yes, then the system removes
the assigned CBS code for the selected activities and all of the associated resources
(Resource/Role). If you select No, then Unifier displays messages regarding the removal of
the assigned CBS code for the selected activities for the activity sheet, only.

» If you select No, then the assigned CBS code remains as is.

Using CSV import to assign CBS Code to multiple activities

In a Activity Sheet with all of the schedule types, you have the option to import CSV to multiple
activities, in bulk.

To import the CSV template to multiple activities:
1) Click Actions.

2) Click Update Data.

3) Click Activities.

4) Click Import CSV.

You can export the CSV template, using Export CSV, and bulk assign the CBS codes to multiple
activities, in Duration-based schedules.

All of the validations (CBS codes, active, and inactive CBS codes) regarding the assigning of the
CBS codes to multiple activities take place during the CBS code assignment.

Activity Sheet Created from Oracle Primavera Cloud Project through Gateway

When you create an activity sheet by way of integration with Oracle Primavera Cloud, you can
assign CBS codes to the activity sheet.

In the Activity Sheet log, click and select the activity that you want.

Click the gear menu ( ¥ ) to open the menu and select one of the following options:

a) Assign CBS Code
b) Remove CBS Code

In the activity attribute form, the General tab displays the associated CBS code.

For details about the functionality for assigning, updating, and removing CBS code from an
activity (in Activity Sheet) from P6 using both non-EVM and EVM synchronizations, see the
preceding topic: Activity Sheet Created from P6 Through Gateway (on page 109).
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Using CSV import to assign CBS Code to multiple activities

In a Activity Sheet with all of the schedule types, you have the option to import CSV to multiple
activities, in bulk.

To import the CSV template to multiple activities:
1) Click Actions.

2) Click Update Data.

3) Click Activities.

4) Click Import CSV.

You can export the CSV template, using Export CSV, and bulk assign the CBS codes to multiple
activities, in Duration-based schedules.

All of the validations (CBS codes, active, and inactive CBS codes) regarding the assigning of the
CBS codes to multiple activities take place during the CBS code assignment.

Unifier Activity Manager for Oracle Primavera Cloud Schedules

You can also integrate multiple Oracle Primavera Cloud projects into multiple Unifier projects.

In Oracle Primavera Cloud, if two or more projects have the same Project ID, then when
integrating those projects into a single project, Unifier will randomly select only one of the Oracle
Primavera Cloud projects that have same Project ID and integrates that project into Unifier.

Note: You can access the Activity Manager module for setting up
Oracle Primavera Cloud schedules the same way as accessing the
Activity Manager module in a shell. The Activity Sheets log
components (for setting up Oracle Primavera Cloud schedules) are also
the same as the Activity Sheets log in a shell.

The following explains the information specific the Activity Sheets log for Oracle Primavera
Cloud schedules.
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Get Data | Use this option (Get Data) to:

a) Create an activity sheet for the first time.

b) Update an existing activity sheet with the most recent activity spread
data from the Oracle Primavera Cloud project.
Updating triggers a new OOTB import synchronizations if you have
selected the Select Synchronization to Exchange Activity Data option
in Gateway integration settings drop-down list.
All of the synchronized Oracle Primavera Cloud project activities,
planned dates, actual, at completion dates, and associated WBS Code
will be displayed in the activity sheet.

If the shell is not active (inactive shell), then Gateway integration will fail.

When you select this option (Get Data), the system checks for the Oracle
Primavera Cloud project that as defined in the Integration tab and then
brings the Oracle Primavera Cloud project activity data and their schedules
into the activity sheet:

» Based on the import synchronization defined in Gateway settings, and
» If Oracle Primavera Cloud and Unifier projects are linked.

If you select this option and there is no Project ID added in the Integration
tab, the system will display this message: Valid Project ID is not specified in
the Shell Integration Tab.

Note: Unifier does not bring the baseline (project data) from Primavera

Cloud.
Send Use this option (Send Data) to run the export synchronization to send the
Data updated activities and schedules from a Activity Sheet to the Oracle

Primavera Cloud.

The data elements in the business processes, or the shell attribute form,
which have been set to reverse auto-populate (RAP) back to the Oracle
Primavera Cloud Activity Sheet (using P6 Activity Picker) will get the latest
updates into the Oracle Primavera Cloud Activity Sheet.

You can send updated Activity Sheet data (such as: updated Actual Start
Date or Finish Dates) to the Oracle Primavera Cloud project which is linked
by way of the OOTB export synchronization option: Update Unifier Activity
data in to Primavera Cloud.

The Schedule tab, in the Activity Sheet log, shows this option, and you can
set the scheduled send data based on frequency.
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Mapped
Projects
tab

The Mapped Projects tab has the following toolbar options:

»

»

The Mapped Projects tab displays a list of all of the mapped Oracle
Primavera Cloud projects. The following columns are available in this tab:

4

To refresh the log items for both the Mapped Projects tab and the
History tab.

To conduct a search for items on the list.

Refresh

Find on Page

Project ID: Displays the linked Oracle Primavera Cloud Project ID.
Project Name: Displays the project name.

Project Type: Displays the value of either Current or Baseline. If you
receive the current schedule information, the Project Type column
shows: Current.

Project Start Date: Displays the start date of the project.

Data Date: Displays the last refreshed date from Oracle Primavera
Cloud.

Schedule Type: Displays Duration as schedule type.

Schedul
e tab

The Schedule tab enables you to set the frequency for Get Data along with
a table that shows the schedules based on the frequency. This is applicable
to all projects in the activity sheet. Other drop-down values for the Set
Frequency for will be Send Data. You can select Send Data, but the OOTB
synchronization option is not available for sending the updated activity data
back to Oracle Primavera Cloud.

History
tab

The History tab displays the history of all of the events that are being
performed across the Oracle Primavera Cloud projects that are present in
the activity sheet.

When you open an activity from the Activity Sheets log, the Activity Sheet overlay page

opens.

The Activity Sheet overlay page displays all of the activities data, in columns, such as:

v v v v Vv

Activity ID

Activity Name
Activity % Complete
Activity Status
Activity Type

The Activity Sheet overlay page displays the general information about an activity in the
General tab (right-hand pane), categorized by blocks, such as:
» WBS Attributes
» WBS Code (uuu_P6WBSCode): WBS Code associated to each Activity.
»  WBS Name (uuu_P6WBSName): WBS Name associated to each Activity.
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»  WBS Path (uuu_P6WBSPath): WBS Path associated to each Activity.

»  Work Package (uuu_P6WorkPackage): This is the leaf node for every WBS structure and
will have the values Yes/No.

» Activity Attributes (General)

» Activity ID (uuu_P6Activityld)

» Activity Name (uuu_P6ActivityName)

» Status (uuu_P6ActivityStatus)

»  Type (uuu_P6ActivityType)

» Performance % Complete (uuu_P6PercentComplete)
» Activity Attributes (Scheduling)

» Planned Start (uuu_P6PlannedStart)

» Planned Finish (uuu_P6ActualFinish)

» Planned Duration (uuu_P6Planned)

» Actual Start (uuu_P6ActualStart)

» Actual Finish (uuu_P6ActualFinish)

» Actual Duration (uuu_P6ActualDuration)

» Remaining Duration (uuu_P6RemainingDuration)

» At Completion Duration (uuu_P6AtCompletionDuration)
You can use this activity data in a business process using Activity Picker, and the updated

dates can be reverse auto-populated into the activity sheet. The activity sheet data can be sent
back to Oracle Primavera Cloud using the export synchronization selected in Gateway

integration settings.

Activity Mappings in Gateway

The following activity attributes are displayed in the log:

Oracle Primavera Cloud

Gateway

Unifier

activityPercentComplete

PercentComplete

uuu_P6PercentComplete

actualDuration

ActualDuration

uuu_P6ActualDuration

actualFinishDate

ActualFinishDate

uuu_P6ActualFinish

actualStartDate

ActualStartDate

uuu_P6ActualStart

atCompletionDuration

AtCompletionDuration

uuu_P6AtCompletionDuration

finishDate

FinishDate

uuu_P6Finish

activityCode

Id

uuu_P6Activityld

activityName

Name

uuu_P6ActivityName

plannedDuration

PlannedDuration

uuu_P6PlannedDuration

plannedFinishDate

PlannedFinishDate

uuu_P6PlannedFinish

plannedStartDate

PlannedStartDate

uuu_P6PlannedStart
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projectld

Projectld

uuu_int_p6_project_id

remainingDuration

RemainingDuration

uuu_P6RemainingDuration

remainingFinishDate

RemainingFinishDate

uuu_P6RemainingEarlyFinish

remainingStartDate

RemainingStartDate

uuu_P6RemainingEarlyStart

startDate StartDate uuu_P6Start
activityStatus Status uuu_P6ActivityStatus
activityType Type uuu_P6Activitytype
wbsCode WBSCode uuu_P6WBSCode
wbsld WBSObjectld uuu_P6WBSElementld
wbsPath WBSPath uuu_P6WBSPath
wbsName WBSName uuu_P6WBSName

The WBS Sheet will be created if the WBS Structure field mapping template is defined in
Gateway. The WBS Sheet sheet shows the WBS hierarchy, or structure, associated with the
activities.

Note: OOTB synchronization does not provide field mappings for the
WBS Structure. You must define the WBS structure mapping in
Gateway for the WBS sheet that has been created in Unifier.

The WBS Sheet sheet lists the WBS structure. All of the cost and units columns will be zeros
(0s) in Unifier 20.7. All of the predefined eight columns are displayed by default, with cost and
unit values as zeros (0s).

The System Data Elements that are available in the WBS Attribute form are not be editable,
but you can add additional data elements in the WBS Attribute form.

You can add additional columns based on type directly as a cell entry, formula, or from:

» WABS Custom Attributes
» Business Processes
» Activity Sheet

Refer to the FRD ANSI EVM - WBS Sheet - Phase Il regarding additional columns and other
functionalities allowed in WBS Sheet.

Note: For duration based schedules, the WBS Picker does not show the
associated WBS Codes in the business processes, when the EVA
Sheet is not created.

Activity Picker in Business Process or Shells

When an Activity Picker that is based on P6 Activity Picker data definition is placed on a
business process upper form or detail form, or in the Shell attribute form in uDesigner, you can
use that picker to select activities from the Activity Sheet located within that shell.
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When you select an activity by way of a P6 Activity Picker, the system displays the Activity
Picker log, as defined in uDesigner. The Activity Picker log lists all of the Oracle Primavera
Cloud Projects in the Projects drop-down, where you can select the current schedule and select
the activity sheet. After selecting the activity sheet, the hierarchy (similar to the one used in the
activity sheet) will be displayed.

The list of activities from the picker is filtered according to the query conditions defined within the
Data Picker configuration, in Admin mode.

The data elements that can be set to auto-populate from a picker will be populated from the
selected activity in the picker.

The data elements that have been set to reverse auto-populate (RAP) to Oracle Primavera
Cloud will RAP according to the RAP conditions, in uDesigner. If no RAP conditions are defined,
the data elements that have been set to reverse auto-populate (RAP) to Oracle Primavera Cloud
will RAP when the record is moved to next step (for Workflow BPs) and when the record is
marked as: Finish Edited' (for Non-Workflow BPs).

The linked data elements using an activity picker get updated when the activity gets updated by
way of integration.

The auto-population will take place if the picker is set to auto-populate from another picker, and
also is set as a source to auto-populate into other data elements.

If a picked activity is deleted, then the system will remove the picker value, and the data
elements that hold auto-populated from that activity (the deleted activity) continue to display their
values. In such scenario, the system will remove the data elements that hold dynamically linked
values.

Using Activity Sheet Data to Track Baseline, Forecast, and Spends in Cash Flow

Cash Flow Analysis enables you to gain an idea of the financial health and liquidity of your
business, by showing what is actually available to use to meet your business needs.

You can use the CBS-type Cash Flow curve to get the Units, or Cost Data, from the Activity
Sheet as per CBS code either at the Activity level, at the Resource level.

You can use the Baseline Cash Flow curve to get the Planned, Remaining, and At Completion
units. In this case, the total for each CBS Code and Cost comes from the Cost Sheet column,
the Planned, or the At Completion costs (from the Activity Sheet).

Similarly, the Forecast Cash Flow curve brings the Planned, Remaining, and At Completion
units, or the costs per CBS Code (from the Activity Sheet).

You can use the Spends-type Cash Flow curve to get the Actual Costs from the Activity Sheet,
in addition to getting the costs from the Cost Sheet column, or from the P6 Summary Sheets.

You can perform Cash Flow analysis based on the budgets, forecast projections, and actuals
received by using the Planned, Remaining Cost, and Actual Costs received from the Activity
Sheet. In summary, for:

Cash Flow curves: CBS Detail, Baseline, and Forecast (Activity level)

Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Activity
level) selected as a source for distribution or cost. In this scenario:
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The period distribution for each CBS Code will be received at Activity level, from the selected
Activity Sheet. The value is the sum of all the planned units for each CBS code by day which
it will be used to distribute the costs. The schedule will be disabled once you select Activity
Sheet as the distribution source.

The cost distribution for each period can either be calculated based on the units and total
cost received from cost sheet column, or based on the cost spread received from Activity
Sheet (Activity level).

You can get data either from the current project or the baseline.

Cash Flow curves: CBS Detail, Baseline, and Forecast (Resource level)
Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Resource
level) selected as a source for distribution or cost. In this scenario:

The period distribution for each CBS Code will be received at Resource level, from the
selected Activity Sheet. The value is the sum of all the planned units for each CBS code by
day which it will be used to distribute the costs. The schedule will be disabled once you
select Activity Sheet as the distribution source.

The cost distribution for each period can either be calculated based on the units and total
cost received from cost sheet column, or based on the cost spread received from Activity
Sheet (Resource level).

You can get data either from the current project or the baseline.
Cash Flow curves: CBS Detail, Spends (Activity level)

You can define Spends Cash Flow curves when the Activity Sheet (Activity level) is selected
as a source for cost. The value is the sum of all the actual costs for each CBS code per day
across the activities.

Cash Flow curves: CBS Detail, Spends (Resource level)

You can define Spends Cash Flow curves when the Activity Sheet (Resource level) is
selected as a source for cost. The value is the sum of all the actual costs for each CBS code
per day across the activities.

Similar to the P6 Summary Sheet, you can use the Activity Sheet as a source in Cash Flow.

The following table explains the details:

Type CBS

Baseline | Activity Sheet (Activity Level)

(Distributio | Sym all the planned units for each CBS code by day which will be used to
n) distribute the costs. You can select either the current project or the
baseline. (Schedule disabled)

Activity Sheet (Resource Level)

Sum all the planned units for each CBS code by day which will be used to
distribute the costs. You can select either the current project or the
baseline. (Schedule disabled)

Baseline Cost Sheet Column
(Cost) Activity Sheet (Activity Level)
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Sum all the planned costs for each CBS code by day. You can select if
this is from the current project or the baseline.
Activity Sheet (Resource Level)
Sum all the planned costs for each CBS code by day. You can select if the
from the current project or the baseline.
Baseline Schedule is derived from the unit distribution.
(Schedule)
Spends Activity Sheet (Activity Level)
(Cost) Sum all the actual costs for each CBS code by day.
Activity Sheet (Resource Level)
Sum all the actual costs for each CBS code by day.
Forecast |Activity Sheet (Activity Level)
(Distributio | sym all the remaining or at completion units for each CBS code by day
n) which will be used to distribute the costs. (Schedule disabled)
Activity Sheet (Resource Level)
Sum all the remaining or at completion units for each CBS code by day
which will be used to distribute the costs. (Schedule disabled)
Forecast |Cost Sheet Column
(Cost) Activity Sheet (Activity Level)
Sum all the planned costs for each CBS code by day.
Activity Sheet (Resource Level)
Sum all the remaining or at completion costs for each CBS code by day.
Forecast |Schedule is derived from the unit distribution.
(Schedule)

Activity Sheet with Resource-Loaded and Cost-Loaded Schedules

For all of the CBS shells, the following Cash Flow curves can get data from an Activity Sheet:

» Baseline

» Forecast

» Spends
When you are defining a Baseline, Forecast, and Spends Cash Flow curves (when the detail
level is selected as CBS, based on the schedule type of the source project), the Activity Sheet is
available as a source for:

» Distribution

» Schedule

» Cost

The option is not available for Cash Flow curves when the detail level is selected as:
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» By Project
» By Summary
» By Contract

The Cash Flow curve properties window enables you to select to get data from:

Baseline
General
Schedule sheets
P6 Source

» Activity Sheet

4
4
4
4

If you select Activity Sheet, then additional options (Cost, Schedule, and Distribution) will be
made available, based on the type of activity sheet that you select. In the case Resource-loaded
Activity Sheet and Cost-loaded Activity Sheet, the schedule is derived from the source.

The other fields in the Cash Flow curve properties window enable you to select the distribution
method and schedule for the Cash Flow curve based on the source of the Activity Sheet.

An Activity Sheet can be linked to more than one source project.

If an Activity Sheet is linked to two or more source projects, then if at least one source project is
duration-based and the other source projects are resource-based, or Cost-loaded, then the other
fields in the Cash Flow curve properties window will be based on resource-loaded or cost-loaded
projects.

When the source project and the Activity Sheet (Activity level) are selected as source, the
properties window for the Baseline Cash Flow Curve type enables you to select:

Where to get the original data
Activity sheet name

Data type

Cost

Schedule and distribution method
Variance

v v v v v Vv

For Resource-loaded and Cost-loaded schedules, the properties window for the Baseline Cash
Flow Curve type enables you to select cost, schedule, and distribution. When you select Activity
Sheet, as a source, the Sheet Name drop-down field allows you to select one of the following
system activity sheets, from the project activity sheets:

» System Activity Sheet (Activity)
» System Activity Sheet (Resource)

By default, the System Activity Sheet (Activity) option will be selected.

Note: The Baseline Cash Flow curve type will display the data from the
system activity sheet, if the source is a single project.

In the properties window, the Project Type drop-down field enables you to select the following
project schedules:

» Current Project
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» Baseline Project
These options are available based on the schedules that have been received.
Note: If you do not receive a Baseline project spread, then the options
above will not be displayed.
By default, the Current Project option will be selected.

When you select Activity Sheet as the source and Sheet Name as System Activity Sheet
(Activity), the Cost drop-down field allows you to select the following options:

» Manual

» Cost Sheet Columns

» Activity Sheet Columns
The Cost Sheet Columns option enables you to display all of the columns of the Cost Sheet.

The Activity Sheet Data Sources will display the Planned, At Completion, and Remaining
Costs, based on the Sheet Name that you have selected.

In the scenarios above, the Cost options are:
Use the Cost option to select one of the cost sources for the Baseline Cash Flow curve type.
By default, the Manual option is selected.

The Schedule & Distribution drop-down field displays all of the units based on the Sheet
Name and the project type that you have selected. If you select the Cost as Activity Sheet
Columns, then the Schedule & Distribution field drop-down will be disabled while displaying
From Activity Sheet.

The Schedule & Distribution drop-down field displays the following options when you select
Sheet Name as System Activity Sheet (Activity), and the Cost is selected as Cost Sheet
Columns or Manual:

» Planned Total Units
» At Completion Total Units
» Remaining Total Units

By default, the value in the drop-down field will be Planned Total Units.

The following table lists the various selections and results:

When Sheet Project type is Cost options are: | Schedule & Distribution options
Name is selected |selected as: are:
as:
System Activity | Current Project | Activity Sheet From Activity Sheet option
Sheet (Activity) |or Baseline Columns: selected and disabled.
Project » Planned
Total Cost
> At
Completion
Total Cost
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When Sheet Project type is Cost options are: | Schedule & Distribution options
Name is selected |selected as: are:
as:
» Remaining
Total Cost
System Activity | Current Cost Sheet Will show following options:
Sheet (Activity) | Project/Baseline | Columns » Planned Total Units
Project » At Completion Total Units
» Remaining Total Units
System Activity | Current > At From Activity Sheet option
Sheet (Resource) | Project/Baseline Completion |selected and disabled.
Project Cost

» Remaining
Cost

» Planned
Cost
System Activity | Current Cost Sheet Will show following options:
Sheet (Resource) | Project/Baseline | Column

Project

» At Completion Units
» Remaining Units
» Planned Units

The following explains Forecast Cash Flow curve properties for when the Activity Sheet is

selected as a source:

» Start at the end of the actuals. Use the drop-down field and select the actuals curve. The
drop-down field displays all of the actual curves that have been defined with the Cash Flow

curve family.

Note: The Forecast options will be disabled if the Activity Sheet is the
source of data.

Replace the current period Forecast with the actuals on the cut off date.

For the unassigned amount, the auto-distribution options will be enabled. You can select the

redistribution of unassigned amount based on the weighted average calculations.

» The period close settings option is not applicable to Spend, if the period close settings are
received from the Activity Sheet.

The following explains Spends Cash Flow curve properties for when the Activity Sheet is
selected as a source:

In the Spends Cash Flow curve properties, you can select the source of cost as Activity Sheet.
The Spends Cash Flow curve properties has the following Cost and Distribution options, based

on the source that you select:

» Where to bring the approved Spends data from.
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The Bring <Spends Curve name> data from drop-down field displays a list of sources that
you can use to bring the actuals cost and distribution. If you select Activity Sheet from the
list, then the Sheet Name field value will be activated and provides the list of sheet hames,
both at the Activity level and Resource level.

» Sheet name

The Sheet Name drop-down field displays the Activity Sheets in the project, which is a single
activity sheet or the System Activity Sheet. The following are the options available for the
Sheet Name drop-down field:

» System Activity Sheet (Activity)
» System Activity Sheet (Resource)
» Cost
The Cost drop-down field displays:
» The business process columns that are available in the Cost Sheet.
» The formula columns which are based on the business process.

» The Activity Sheet column, Actual Total Cost, if the Sheet Name is selected as
System Activity Sheet (Activity).

» The Activity Sheet column, Actual Cost, if the Sheet Name is selected as System
Activity Sheet (Resource).

» Schedule & Distribution

» This option displays Actual Total Units when you select Cost as the Cost Sheet
column, and the Sheet Name is selected as System Activity Sheet (Activity).

» This option displays Actual Units when you select Cost as the Cost Sheet column, and
the Sheet Name is selected as System Activity Sheet (Resource).

» Variance

The following table shows the various selections:

Sheet Name Cost Schedule & Distribution
System Activity Sheet Cost Sheet Column Actual Total Units
(Activity)

System Activity Sheet Cost Sheet Column Actual Units

(Resource)

System Activity Sheet Actual Total Cost From Activity Sheet text
(Activity) selected and disabled.
System Activity Sheet Actual Cost From Activity Sheet text
(Resource) selected and disabled.

If you select the Cost option, then Unifier draws the Spends Cash Flow curve by using the
Actual Cost spread, Actual Start Date, and Actual Finish Date for each CBS Code, from the
selected Activity Sheet.

The following topics explain the various Baseline and Forecast Budget (Cost Distribution)
Cash Flow curve properties for when the Activity Sheet is selected as a source:
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» Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet

» Baseline curve or Forecast curve when Schedule & distribution and cost are derived
from the Activity Sheet

» Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

» Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

When you select the original source as Activity Sheet for the Baseline Cash Flow curve, the
From and To dates and the spread for each CBS Code will be derived from the selected Activity
Sheet and Project Type. Unifier uses the spread data from the selected Activity Sheet to draw
Baseline Cash Flow curve (the period units are coming from the activity spread, and the cost
will be derived either from the Cost Sheet column, or from the activity spread.

Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet:

You can select the following distribution and cost sources when the data is originating from
the Activity Sheet:

Distribution Cost Cost per CBS Code

Sheet Name: System Cost Sheet Column: | Cost for each unit per CBS Code =
Activity Sheet (Activity) Assigned Budget Total cost from the Cost Sheet
Project Type: Current column/ The number of total units.
Project Cost for each period per CBS Code =
Data Source: Planned The number of units * Cost per unit.
Total Units

Example

Monthly time scale: Sample monthly unit spread for CBS Codel which is coming from
Planned Total Units in the above scenario:

January |February |March April May June July

CBS 100 100 100 100 100 100 100
Code 1

If Total cost per CBS Codel = $70000, then the cost per unit = $70000/700 = $100 and cost
per period will be = 100 * $100 = $10000

Monthly time scale: Sample cost spread for CBS Codel for each period will be calculated as
follows:

January |February |March April May June July

CBS $10000 [$10000 |$10000 |$10000 |$10000 |[$10000 |[$10000
Code 1
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The above Cost spread sample will be distributed in the Baseline Cash Flow curve. If the
user selects Sheet Name: Activity Sheet (Resource level), with resource units selected as
distribution source, and the cost source is coming from the Cost Sheet column, then sum all
of the Planned units for each CBS Code by day which it will be used to distribute the costs.
The Cost per unit will be calculated as shown above. The user should be able to select the
units spread from either the current project or the Baseline. The cost distribution will be done
in the similar way (as shown above) for the other time periods such as yearly scale or
financial periods.

Baseline curve or Forecast curve when Schedule & distribution and cost are derived from
the Activity Sheet:

You can select the following distribution and cost sources for the data that is originating from
the Activity Sheet:

Distribution Cost Cost for each unit per CBS Code
Sheet Name: System Cost in this case is | The cost will be calculated in the
Activity Sheet (Activity) coming from source Activity Sheet itself using the
Project Type: Current Planned Total Cost |units and assigned role or resource
Project spread data at rate at Activity level.
Data Source: Planned | Activity level for each| cost for each period per CBS
Total Cost CBS Code. Code: Sum of all planned costs for
each CBS Code at activity level.

The sample cost spread for the CBS Code 1, when the selected Planned Total Cost in the
above scenario is as follows:

Note: In this case, the cost spread data will be received from the
selected Activity Sheet (either from current project or Baseline).

January |February |March April May June July

CBS $100 $100 $100 $100 $100 $100 $100
Code 1

If you select the new distribution and cost options from the Activity Sheet, then:
» Both the cost and dates will be received from the Activity Sheet spread data.

» The forecast curve, which is set to begin at the end of actuals curve, shows data from the
data date instead of the current period.

» You can select distribution from the Activity Sheet and cost from the Cost Sheet column,
or manual, so that the cost spread will be calculated using the total spread units from the
Activity Sheet, and the total cost received from the Cost Sheet, or entered manually.

» The Project Type drop-down field and the Data Source field enables you to get the units
or cost spread from the Activity Sheet current project or baseline. The values for the
fields are Planned, At Completion, and Remaining. By default, the Planned options is
selected.
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» For the Forecast Cash Flow curve, the spread data (units or costs) comes from Planned,
At Completion, and Remaining costs or units. In the Forecast Cash Flow curve the
default data source is At Completion. The Forecast Cash Flow curve that is set to begin
at the end of actuals shows the actuals received as of current date, from the Activity
Sheet or from the Cost Sheet column, and the remaining periods show the spread data
received from the Activity Sheet (including the redistributed unassigned amount). The
unassigned amount is redistributed in the remaining periods, based on the selected
weighted average option.

Baseline curve or Forecast worksheet when Schedule, distribution, and cost are derived
from the Activity Sheet:

For each CBS Code in the Baseline or Forecast worksheet, when the source is selected as
Activity Sheet:

» From Date will be the earliest date (beginning period from the selected Project spread
data). This can be either at Activity level or Resource level based on the sheet name that
you have selected. Similarly, the dates come from the current project or baseline.

» To Date will be the latest date (from the selected Project spread data). This can be either
at Activity level or Resource level based on the sheet name that you have selected.
Similarly, the dates come from the current project or baseline.

» From Date and To Date are read-only.
» The Profile column remains empty and will be read-only.
» The Period data shows the costs distributed from the spread.

» The distributed costs can be calculated when units are coming from the Activity Sheet,
only (you can bring the costs from the Activity Sheet). The data will be read-only, similar
to the data received from the P6 Summary Sheets.

Note: The project picker will not be available in the worksheet. You can
see the project picker when you are allowed to pick a project as source.
In this case, the data is filtered (in the graph and worksheet) based on
the project.

» The worksheet tab enables you to export.
» The Cumulative and Incremental graphs are available.
» The unassigned amount in the Forecast curve, or Baseline curve, is redistributed in the

remaining periods, based on weighted average option that you have selected.
Spends Curve and Data Distribution
The following explains:

» When both cost and distribution is coming from Activity Sheet

» When the total actual cost is derived from cost sheet and schedule/distribution is derived
from Activity Sheet

When both cost and distribution is coming from Activity Sheet
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You can define the Spends curve to get the actuals spread data from the Activity Sheet for the
Resource loaded or Cost loaded projects. When you select the Activity Sheet as a source for the
Spends curve, the system will derive the distribution and actual costs from the Activity Sheet.
The actual spread data will be coming from the current project.

The From Date and To Date fields are displayed according to the values of the earlier Actual
Start Date and Date which is across the activities, per CBS Code for In progress activities. The
From Date and To Date fields are read-only.

Note: The Data Date field value can be in the past, current, or in the
future. The Actuals are always shown, until the date of the Data.

The Actuals in periods show the spread data coming from the Activity Sheet that you have
selected.
The distribution data is read-only.

The Actual spread data as of the data date is displayed in the Forecast curve worksheet if in the
Forecast curve properties, the curve is set to begin at the end of the actuals.

The graph shows both the actuals (cumulative and incremental values).

The Actual spread data per CBS Code will be until the data date. For example, if the Actual Start
is 02/10/2020 and Data Date is 08/15/2020, then the Actuals cost spread will be shown until the
data date (08/15/2020), in the worksheet.

From |[To Feb Mar Apr May Jun Jul Aug
Date Date

CBS |02/10/2|08/15/2|$100 |$100 |$100 |$100 |$100 |$100 |$100
Code 1 {020 020

Forecast with Actuals

When you select the source as Remaining Total Cost, or Remaining Total Units, the
remaining spread data will be used as source for the Forecast curve. The Actuals will be
seen as of data date, and the remaining spread will start from the data date. For example, in
the table above, the month of August will show the Actuals as of date + remaining Forecast
data ($700 + $100).

From |To Aug |[(Sep |Oct |Nov |Dec |Jan |Feb [|Mar |Apr
Date |Date

CBS |08/15 |04/15 |$800 ($100 |[$100 |[$100 |[$100 |$100 |$100 |$100 [$100
Code |/2020 |/2021
1

When the total actual cost is derived from cost sheet and schedule/distribution is derived
from Activity Sheet

You can receive the Actual spread units from the Activity Sheet, and the total payment amount
from the Cost Sheet column. In this case, the Actual cost can be calculated as the number of
actual units * actual cost per unit. See the following example for the monthly time scale:

January February
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CBS Code 1 50 10

CBS Code 2 0 20

In this example, if the total actual cost (received from the Cost Sheet column) for CBS Code 1 is

$6000, and the CBS Code 2 is $1000, then the actual cost per unit will be as follows:

January February
CBS Code 1 $50000 $1000
CBS Code 2 $1000

Additional Information:

»

If an Activity Sheet has more than one mapped source projects, then Unifier displays the
following message: You cannot view the data because the system activity sheet is mapped
to more than one source project with different data dates.

Note: Cash Flow curves will receive data from the System Activity Sheet
mapped with multiple source projects, if they all have the same data
date.

If you select an Activity Sheet as a source to one or more Cash Flow curves in the Cash
Flow detail curves, then you cannot open the Cash Flow curve in Classic View, and Unifier
displays the following message when you try to open a Cash Flow worksheet, or properties,
in Standard View: The source for one or more curves is Activity Sheet. You cannot view the
curves in Classic View.

If an Activity Sheet has not been created in the project, then the drop-down field will not
display Activity Sheets as an option for the Baseline, Forecast, and Actuals Cash Flow
curves.

The Baseline, Forecast, and Actuals Cash Flow curves show the properties irrespective of
the schedule type for the System Activity Sheet. Furthermore, the Sheet Name drop-down
field displays manual activity sheets that are created in the project.

The Cash Flow worksheet does not show the data for the Cash Flow curves that are based
on the Activity Sheet, if there is no cost spread or unit spread associated with the activities in
the selected Activity Sheet.

P6 Activity Picker in Business Process or Shell Details

When you access a business process form, or a shell attribute form, with activity sheets (both
system activity sheet or manual activity sheets) and create a new form, the Create New <form>
window opens. In this window, you can go to the P6 Activity Picker field, click Activity Sheets,
and open the P6 Activity Picker window.
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In the P6 Activity Picker window, the Activity Sheets field drop-down displays a list of all of the
active activity sheets, in alphabetical order. In the case where the multiple source projects are
integrated with System Activity Sheet, the Activity Sheets drop-down shows the source projects
prefixed with "System Activity Sheet," for example: System Activity Sheet - <Source Project1>,
System Activity Sheet - <Source Project2>, and so forth. You can switch between the activity
sheets and select a specific activity sheet to populate the information on to the business process
or attribute forms.

The activities are filtered according to the query conditions defined within the Data Picker
configuration in uDesigner (Company Workspace > Admin mode > uDesigner > <Business
Process or Shell Attribute form>) where P6 Activity Picker field is added.

The form fields that have been set to auto-populate from P6 Activity Picker field will get
auto-populate from the selected activity attributes.

The form fields that have been set to Reverse Auto-Populate (RAP) to the Activity Sheet will get
Reverse auto-populated from the conditions specified in uDesigner or the latest data will be
reverse auto-populated (updated) back to the Activity Sheet when "Send" in the Workflow, or
"Submit" in the Non-workflow BP, is used. Similarly, when the user clicks "Save" in the shell
properties, the updated date will be reverse auto-populated (RAP) back to the activity sheet.

The form data elements that are linked to the attributes form from a P6 Activity Picker field will
get updated as the P6 activity data gets updated by way of integration.

Auto-population will complete if the P6 Activity Picker field is set to auto-populate from another
picker, and the P6 Activity Picker field is also selected as a source to auto-populate other data
elements on the form.

If you delete a selected (picked) activity sheet, then Unifier clears the picker value for the
existing records, but the auto-populated values will remain as they are. Similarly, the system
clears the linked data elements if the selected (picked) activity sheet no longer exists.

Additional Information about P6 Activity Picker

» The P6 Activity Picker is supported when creating records through CSV import and RESTful
services.

» When more than one P6 project is associated with the System Activity Sheet, the CSV
template, or the RESTful call, accepts the following format for P6 Activity Picker value: <P6
Project ID> ~~ <Activity ID>

» If the project has manual activity sheets defined, then the following format is allowed in the
input CSV file and RESTful services to select an Activity: <Activity sheet Name> ~~ <Activity
ID>

» If the Unifier project has System Activity Sheet with multiple projects, or a single
source-project, then the following format is allowed in the input CSV file and RESTful
services for the selection of Activity ID: <System Activity sheet - P6 Project ID> ~~ <Activity
ID>

Activity Picker

The activity picker in business process and attribute forms allows you to choose an activity from
a selected project. The activity picker supports reverse auto-population for multiple P6 Projects.

Selecting a project:
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1) Inthe View drop-down list, select a project. If there are a large number of projects, use
Search or Find on Page to quickly locate the project.

2) Highlight a project on the Activity Picker log and click Select.

WBS Picker in a Business Process

The WBS Picker field in a business process form has an additional toolbar option (Source) that
shows the source value as either P6, Primavera Cloud, or Custom. The Source field drop-down
will display "Custom" by default and all of the WBS Codes from the Project WBS Sheet will be
shown.

You can switch between different sources (P6 or Primavera Cloud and Custom) if your project
has both Project WBS Sheet and System WBS Sheet. The WBS Codes created from the
selected source will be shown in the Picker window.

To select the code, the WBS Code shows the entire path.
You can select a unique WBS Code to add a cost transaction.
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The Earned Value Manager enables you to do the following by using one of the nodes.

» Perform earned value analysis corresponding to the activity sheet (System or Manual) in a
shell.

» Run the earned value analysis of cost loaded projects directly.
» Generate reports on EVA scenarios.

The Earned Value Manager module contains the following nodes:

» Earned Value Analysis
» Earned Value Analysis Report

To access the Earned Value Manager module:

1) Go to your shell in user mode.
2) Click Earned Value Manager module to expand.

The following provides details about each node.

In This Section

Earned Value ANAIYSIS .......cooiiiiiiiie e 133
Earned Value AnalySiS REPOI ........oi i 151
Earned Value Management PErmiSSIONS.........civiieeiiieeiiiiiei e eeeeeeeies e e eeeeiaaans 155

Earned Value Analysis

The Earned Value Analysis node (Earned Value Manager module > Earned Value Analysis
node) is based on the scheduling set of data (activities and rates) imported from P6 through
integration. The Earned Value Analysis node allows you to:

» Perform earned value analysis corresponding to the activity sheet (System or Manual) in a
shell.

» Run the earned value analysis of cost loaded projects directly.

Note: For resource-loaded projects, you must calculate resource and
role rates before analyzing earned value and other matrices.

Planned Value (PV), Actual Value (AC) and Earned Value (EV) are required to calculate
variances, indexes, and at completion project values. Unifier performs all calculations in the
Activity Sheet and rolls up the values to the Earned Value Analysis scenario. The values
corresponding to each project, WBS (Work Breakdown Structure) or CBS (Cost Breakdown
Structure) are used to plot different graphs, thus providing a visual way to determine the health
of projects, and Forecast future outcomes based on the performance indexes.

Earned Value metrics can be categorized as under:
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Planned Value (PV)
Actual Cost (AC)
Earned Value (EV)

Basic

Cost Variance (CV)
Schedule Variance (SV)

Variances

Schedule Performance Index (SPI)
Cost Performance Index (CPI)
Cost Schedule Index (CSI)

Indexes

Estimate to Complete (ETC)
Estimate at Completion (EAC)
To Complete Performance Index (TCPI) by EAC or BAC

Forecast

v v vV |V VvV vV | VvV v| Vv v Vv

Earned Value Analysis Log Window

The Earned Value Analysis log lists the earned value analysis. To access the Earned Value
Analysis log, go to the shell (User mode), click to expand the Earned Value Manager module,
and click Earned Value Analysis.

Note: The location may differ in your implementation based on the
Project/Shell UserMode Navigator configuration.

You can use the Earned Value Analysis log to:

» See a list of analysis.

» Review the following information (on the right-hand pane of the log) about a selected
analysis:

» Preview

» General

» Properties
» Schedule
» History

The Earned Value Analysis log has the following toolbar options:

» Create (see below for details)
» Data Refresh

Use this option to manually update the summarized values retrieved from the shell activity
sheet (System or Manual). The values in the scenario are not updated automatically if there
are changes in the associated activity sheet (System or Manual).

When you perform data refresh, Unifier updates the summary table spread data which will
appear after the most recent data date for each project.

The Historical data will not be refreshed when you click Data Refresh in an existing EVA
Sheet.

» Delete

134



Working with Earned Value Analysis

Use this option to delete the analysis.

The Earned Value Analysis log has the following columns:

VvV vV vV vV vV VvV VvV vV v v

Name

Description

Activity Sheet

Cost Sheet Column

Graph Type

Performance Measurement Technique
Created By

Created Date

Last Refreshed

Last Modified

The Earned Value Analysis log lists the analysis and each analysis has a gear menu ( & ) that
can be used to:

»

Open
To open and view the select EVA.
Open Grid Indicators

To open the Grid Performance Indicators window and color-code the grid values
corresponding to the variances and indexes. Depending on the options that you have
selected, you can define the range to color-code Project, WBS, or CBS performances. The
settings will be applied to all of the sheets in the log. Currently, there is only one EVA sheet
and color-code settings apply only to the existing sheet.

This option is available to all users who have the Create permission.
The Grid Performance Indicator window has the following toolbar options:
» Add: To add a new color indicator.
» Find on page
» Save
» Cancel
The Grid Performance Indicator window has the following columns:
Error (indicator labeled with an x icon)
» No.

» EV Metrics: This is a value selected for the Select Metrics drop-down field. It allows you
to select the metrics that you want to color-code. There are no restrictions on the number
of scenarios that you can create. The following options are available when you
double-click in the cell and activate the drop-down field:

= Schedule Variance

= Cost Variance

= Variance at Completion

= Cost Performance Index

= Schedule Performance Index
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Index

Cost Schedule Index
TCPI (EAC)
TCPI (BAC)

» Condition: This enables you to select the following conditions or values for users who
can create criteria for color-coding (double-click in the cell to activate the drop-down

field):

equals

greater than

greater than or equals
less than

less than or equals
between

To prevent overlapping of conditions or values, the following priority order is used:

Equals will override any other defined condition.
Between will override any other defined condition, except equals.

In case of less than and less than or equals, the lower value will override the
higher value.

In case of greater than and greater than or equals, the higher value will override
the lower value.

In case of conflict between a value which comes under less than/less than or
equals and greater than or greater than or equals, Unifier displays the message:
Overlap in the conditions defined.

» Text box: This field (Value 1 and Value 2) can be a single text box or two text boxes
(condition = between), depending on the condition selected.

» Color: This is a drop-down field that allows you to select the color corresponding to the
criteria that you have created. The following are the values (double-click in the cell to
activate the drop-down field):

Black
Red
Purple
Orange
Yellow
Green
Blue

The gear menu ( ¥ ) Delete option enables you to delete the color indicators.
» Open Performance % Completion

To open and view the historical performance percentage completion values of a project
activities against data dates. Unifier uses the values to calculate earned value metrics.

» Delete

To delete the analysis.
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The Earned Value Analysis log displays the analysis properties on the right-hand pane within
the following tabs:

» Preview tab

» General tab

» Properties tab
» Schedule tab
» History tab

Tip: Click the expand icon, in the right pane, to better view the tab details.
The following explains each tab in details.

Preview Tab

The Preview tab enables you to preview the earned value analysis for the P6 projects (cost
loaded and resource loaded) in the activity sheet (System or Manual) without opening the
Earned Value Analysis sheet.

» The upper section in the tab displays a graph with consolidated information of PV and AC
across data dates. A vertical blue bar represents the last data date.

» The lower section shows the Summary Table with columns displaying EV metrics and
derived values, for projects satisfying the last data date:
» BAC, EAC, PV, EV, AC, ETC, RC, CV, SV, VAC, CPI, SPI, CSI, TCPI(EAC), TCPI(BAC).
The lower section (Cumulative Values and Indices) is also referred to as the EV analysis
sheet columns. When you click and open an EV analysis sheet from the Earned Value

Analysis log widow, the window that opens has both an upper and lower screens which
display the information that you could see in the Preview tab.

General Tab

The Preview tab enables you to enter details, export details as template, and import data. To
populate the fields in the General tab, you can export a template (use the export icon), enter the
values in the exported template, ensuring that all columns, or conditions, are completed or met,
save the template, and import the template back to Unifier.

Properties Tab
The Properties tab enables you to update the following fields:

Name

Description

Activity Sheet

Graph Type

Progress Measurement Technique

Template ID

Cost Sheet Column

The logical sources will show the entire cost data regardless of the data date.

v v v v vV v Vv
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Below the Cost Sheet Column field, the Technique for computing estimate to complete
(ETC) block enables you to select the ETC calculation method.

The Activity Sheet and Name fields are read-only and populated with the values you entered
when creating the earned value scenario.

The Description field is an editable field.

The Cost Sheet Datasource is editable, so you can update the Cost Sheet Datasource for the
Earned Value Analysis.

Select Graph Type (optional): Data Date or Period Based

Schedule Tab

The Schedule tab enables you to see the frequency for updating the data (Data Refresh). The
Schedule tab is consistent with the Schedule tab in other EVM-related places.

In the Frequency drop-down list, select from Daily, Weekly, Monthly, or Quarterly options,
select start and end dates and click Save.

Select None in the Frequency field to discontinue the automatic refresh of the earned value
analysis sheet.

History Tab

The History tab enables you to see the following information about the past events related to
the activity sheet (System or Manual):

» Action

» Requestor
» Initiated On
» Start Date
» End Date

» Status

The History tab is similar to the History tab in other EVM-related places.

» The grid displays the details of scheduled refreshes only.

» The columns list the action taken (data refresh only), the name of the user who initiated the
scheduled refresh, date and time the scheduled job is initiated, start and end dates for each
refresh job, and the status of the refresh process (Completed, In Progress, or Failed).

» Select an item to view details in the History Details section below. Click Refresh to refresh
the status of an ongoing job.

Creating an Earned Value Analysis Sheet

In the Earned Value Analysis log window, use the Create option to create an EVA sheet by
following the details below:

1) Click Create to open the New Earned Value Analysis window.

2) Inthe Name field, enter a name.

3) Inthe Description field add a description (optional).

4) From the Activity Sheet drop-down select the activity sheet (System or Manual).
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From the Graph Type drop-down select one of the following sources:
a. Data Date Based
b. Period Based

From the Progress Measurement Technique drop-down select one of the following
sources:

a. Cost Based

b. Unit Based

From the Template Id drop-down select one of the Earned Value Analysis (1 through 6).
From the Cost Sheet Column drop-down select a cost sheet column.

Click Save to save the newly created EVA sheet.

You can create multiple EVA scenarios with different properties, performance indicator settings,
and details in general tab. Each EVA will have a different PPC for the activities under the
project. This will enable you to prepare reports, and see the trend depending on their
preferences. You are also able to select the EVA sheet from the rolled up data in Cost Sheet.

Note: Except the grid performance indicator, if you select any other
action, then Unifier displays the alert asking you to select 1 record.

Earned Value Analysis Sheet

To access the EVA sheet:

1)
2)

3)

Go to the Earned Value Analysis log window.
Click to select your sheet.
Click the gear menu ( % ) to open and select Open. The Earned Value Analysis sheet

opens in new window. Alternatively, you can double-click on the sheet to open the sheet
window.

The upper section of the EVA sheet is fixed and viewed across all tabs. It includes the toolbar
functions and a dynamic data table. The following explains the elements.

Filter Y To adjust the view for particular information.
Print & To print the sheet.
Data Date This field has a drop-down menu with historical dates. This is

available for graph based on Data Date.

Projects This field enables you to open the Project Picker window and select

a project. The information is constrained with value in Data Date
field. The Project Picker window enables you to Find on Page.

Period The drop-down list with weekly, monthly, quarterly, half a year,

yearly, and if applicable, financial period that has been selected in
the shell. This is available for graph based on Period.
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WBS or CBS This toggle option is followed by the corresponding picker in the
drop-down adjacent field (WBS Code or CBS Code drop-down). The picker
user interface has Expand, Collapse, and Find on Page. the values
are constrained by selections in the previous fields.

Select the WBS graph and click WBS picker to filter by the OBS.

The WBS picker will also display the WBS codes from the Unifier
project, if the project is selected from the Projects Picker.

WBS Code or Click to open and select from WBS Picker or CBS Picker windows,

CBS Code respectively.

drop-down

Cost & Rate Displays all rate- and cost-type breakdowns available. It enables you
Type to select a rate-type or a cost-type grouping. Once you select the

breakdown rows to filter, then all of the costs will be displayed based
on breakdowns that you had selected.

Apply Click to apply selections in the drop-down fields.

Reset Click this to remove any zoom or filters applied via the curve picker.

The middle section of the EVA sheet contains a Dynamic Data Table.
The headings for the dynamic data table are as follows, depending on the graph type:

» Project
» All is displayed when all projects have the same data date.

» All (Filtered) is displayed when there are projects with differing data dates, and projects
with the selected data date are filtered in the view.

» WBS

Displays the calculated values for the point plotted in the graph.
» Cost & Rate Type

Displays the cost and rate types in the graph.

The other headings may include:

» Date

» Related EV metrics labels based on the tab. For example, in the Cumulative tab, the
columns show PV, EV, AC, ETC, RC, CPI, and SPI.

The middle section of the EVA sheet contains the following tabs:

» Cumulative

» Incremental (only applicable to period based graph.)
» At Completion

» Variance

» Indices

Depending on the tab that you select, you get the pertinent graph.
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Curve Picker: Filter curves you want to view by selecting or clearing the colored boxes in the
legend.

Unit Based

Earned Value Analysis - Graph

All of the Planned Units and Actual Units will be rolled-up for Project, WBS, and CBS from the
Activity Sheet. The EV value will be calculated using the following formula:

EV Units = BAC Units* PPC

Earned Value Analysis - Grid

For the Graph Type Unit based, the Grid will display units instead of costs (Planned units,
Actuals Units, and so forth). The Variances, Indices, and At Completion values will also be
updated based on the values.

Earned Value Analysis - Top bar

For the Graph Type Unit based, the bar will display units instead of costs (Planned units, Actuals
Units, and so forth). he Variances, Indices, and At Completion values will also be updated based
on the values.

Remaining Cost > Remaining Cost/Units
Cost Sheet

After you create multiple EVA graphs, the cost sheet drop-down menu displays all the
cost-based graphs.
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Roll up Actuals to EVA

The Amount and the uuu_quantity fields are going to rollup to the WBS Sheet. They will be
used to feed into the Actuals in the EVM sheet. Unlike the existing column in the Cost Sheet
that creates a new row in the EVM sheet, the new BP will rollup to the WBS and CBS for a P6
project. Since Unifier captures units in the EVM, you can add uuu_quantity and have the units
roll up to the EVM sheet.

Note: The Unifier Actuals that have been assigned to any completed
activity (with the Effective Date before Activity Finish Date) will not roll
up to the EVA Sheet because those Unifier Actuals are considered
Historical data.

Cost Based EVA Scenario

In the EVA Sheet, The Actuals amount will be rolled up by associated WBS when you select a
new Cost-type BP (CBS or WBS) column as the Cost Sheet column source. You can see the
Actuals associated with the selected WBS codes by using filtering.

When you filter by WBS codes in the EVA, the Actuals data will be in two separate rows (both
Unifier and P6 Actuals).

By default, in the Project view, all the Actuals (including the actuals from cost sheet column
source) are displayed.

The Actuals amount will be rolled up by associated CBS when filtered by CBS codes, in
Cost-based EVA scenario. When selected filter by CBS or by P6 Projects, you can see the
Actuals for Unifier and P6 for the filtered CBS codes, separately.

Filtering by CBS codes in EVA Sheet

The Rolled up Actual cost will be displayed in the EVA Sheet for the selected CBS codes
only when there is a valid CBS-WBS combination allocated for the line item. That is to state,
the Rolled up Actual cost will be displayed in the EVA Sheet for selecting any CBS assigned
to receptive Activity and selecting WBS code from the same p6 project.

Filtering by WBS codes in EVA Sheet

The Rolled up Actual cost will be displayed in the EVA Sheet for the selected WBS codes
even when there is an invalid CBS-WBS combination allocated for the line item. That is to
state, the Rolled up Actual cost will be displayed in the EVA Sheet for selecting any CBS
assigned to receptive Activity and selecting WBS code from the same, or different, p6
project.

Units Based EVA Scenario

The WBS Sheet column field is available in unit based EVA scenario as the Actual source. The
list of sources available are all WBS Sheet columns which are of type SYS BP Decimal Amount.
You can select any of the new CBS- or WBS-type BP columns (which are of SYS BP Decimal
Amount added in WBS Sheet as WBS Sheet column source).

The Formula columns which are based on CBS- or WBS-type BP of SYS BP Decimal Amount
should are available to select.
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By default, the Actual Units (per project) include the quantity (rolled up from new Cost-type BP)
when the Actual Units are selected as WBS Sheet column source.

The Actual Units (uuu_guantity) by associated WBS codes are displayed when you filter the
WBS codes.

Similarly, when CBS codes are filtered, the associated Actual Units are displayed. The same is
applicable when other Cost-type BPs are also selected as the Cost Sheet column source. The
graph includes the Actual Units from WBS Sheet column source.

Cumulative Tab

Like the Preview tab in the log, the Cumulative tab displays an upper graph and a bottom pane
(see the EV analysis sheet columns below) with a table summarizing the Cumulative Values
and Indices information . It shows data as of the last Data Date.

Note: All other tabs display a graph only.

As you move the cursor across the curves in the graph, a flagged indicator displays the curves,
dates and values at the selected point in a curve. The indicator is color-coded for specific curves
as per the legend. The tool-tips provide the expanded form of acronyms. The last data date is
represented by a vertical blue bar. If available, data dates preceding the last data date are
displayed. After the last data date, weekly intervals are indicated along the X-axis for the
duration of a year.

The zoom control is enabled by using the mouse wheel; values on X- and Y-axes remain static.
You can also drag the zoomed area along the X-axis; the X-axis intervals remain constant.

The Cumulative Values and Indices section toolbar has Export, Find on Page, and a toggle
Expand or Collapse buttons. While the columns present values for earned value metrics and
derivatives, the rows list the projects for the selected data date in separate rows.

Depending on the selection that you have made in the filter, the grid that is displayed follows
theses scenarios:

Scenario One:

If you select Project with CBS filter:

The Summary (filtered) shows the actuals in the activity sheet (System or Manual) that
corresponds to the P6 project and the CBS selected from the filter.

The Summary (P6) displays the actuals that corresponds to CBS across all the P6 projects
(from the activity sheet (System or Manual)) until the Data Date that has been set or selected
in the filter.

The Summary (Unifier & P6) displays consolidated amount from actuals (summary p6) and
the sum of cost sheet actuals for CBS corresponding to the column selected during the EV
creation until the data date selected in the filter.
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Scenario Two:

If you select Project with WBS filter:
No additional summary row.

Period based graph
EVA Graph (Cumulative, At Completion, Indices & Variance)

If a user selects Graph Type as "Period based" for a particular Earned Value analysis scenario
then:

The data date drop-down does not appear in the graph. Instead, a new drop-down is displayed
(Periods) with the following options:

> Weekly

» Monthly

» Quarterly

» Yearly

» <Financial period name> selected in shell details tab (if applicable)

If the graph type is Periods, you can select multiple projects with same or different data date.

Any Actual value of other projects, after the least data date among the projects, will be
presented as Forecast.

For the existing users, when plotting the graph based on periods, the old financial period data,
using the current baseline, is displayed.
Note: The data for each project is locked until the project data date.

Also, the data which is being displayed in the graph will be updated according to the financial
period that is selected.

Note: The graph shows weekly data points on x-axis and filters the
project with same data date.

If you have selected the period type as financial period, then the data for all, or filtered, projects
will be consolidated and plotted in the graph. The Data points on the x-axis will be the period
end date.

The following two scenarios explain the results of your selections:
Scenario One:

If the user selected weekly, monthly, quarterly, or yearly from the drop-down, then the start
date of the first sub period will be the least project start date across all projects. The last sub
period will be determined based on the last data date across all projects. In other words, the
end date of last sub period should be greater than the last data date across all projects.

Scenario Two:

If the user has selected a financial period defined under Standards & Libraries, then the
graph will only display the data between the first sub period and the last sub period.
Everything else will be filtered out of the graph.

EV analysis sheet (Cumulative Values and Indices section) columns
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Budget at Completion (BAC)

Estimate at Completion (EAC)

Planned Value (PV)

Earned Value (EV)

Actual Costs/Actual Units (AC/AU)

Estimated Time to Complete (ETC)

Real Costs/Real Units (RC/RU)

Cost Variance (CV)

Schedule Vanriance (SV)

Variance At Completion (VAC)

Cost Performance Index (CPI)

Schedule Performance Index (SPI)

Cost Schedule Performance Index (CSl)

To Complete Performance Index (TCPI) - Estimate at Completion (EAC) (TCPI(EAC))
To Complete Performance Index (TCPI) - Budget at Completion (BAC) (TCPI(BAC))

VvV VvV vV vV vV vV vV vV VvV VvV vV vV v v v

Incremental Tab

In Unifier, you can generate the earned value analysis graph based on the data date
corresponding to a P6 Project. The graph shows the EV and Actuals data from project start date
until the most recent data date, and every data date which lies in between.

You can also plot the graph based on periods.
EVA Graph (Incremental)

If you select Graph Type as "Period based" (for a particular Earned Value analysis scenario),
then an additional tab for incremental graph will be displayed along with other graphs. The tab
for Incremental graph will show the incremental curves for planned value, earned value, actual
cost, and forecast for the filters selected in the pickers. In other words, each X-axis data point
shows the consolidate data since last data point. The Y-axis displays the amount (in hundreds,
thousands, millions, etc.), and the value is determined by the graph dynamically showing the
best possible representation based on the data available. The maximum and minimum values
are determined by the maximum or minimum values as explained above.

Pre-requisites

You must have at least one Financial Period defined under Standards & Libraries (Company
Workspace > Standards & Libraries > Period Structure).

You must have selected the relevant financial period in the shell options (Shell Details > Options
> Financial Period).

Once you have performed the steps above you will be able to select the Financial Period from a
newly created drop down “Period” in EVA graph if they select graph type as "Period based"
screen as follows:

Create
Click Create and select the Graph type.
Properties
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In the Properties tab, click on the Graph Type drop-down menu and select your option:

»

Data Date Based
Enables you to continue using the data date to filter projects.
Period Based

Enables you to see the graph in Earned Value Analysis based on the financial period
selected in the shell details tab (weekly, monthly, quarterly, or yearly).

EVA Graph (Cumulative, At Completion, Indices & Variance)

If you select the Graph Type as "Period based" for a particular Earned Value Analysis scenario,
then:

»

Except a custom financial period, the x-axis points for any period will be the period start date.
» The start point will be the earliest project start date.

» The end point will be the farthest project end date.

For custom financial period, the start and end points are period start and end points.

Data date drop-down menu will not appear in the graph. Instead, the Periods drop-down
menu is displayed that contains the following options:

»  Weekly

» Monthly

» Quarterly

» Yearly

» <Financial period name> selected in shell details tab (if applicable)

If the graph type is Periods, then you can select multiple projects with the same or different
data date. The Actual value of other projects (after the least data date among the projects)
will be treated as Forecast.

For existing users, when plotting the graph based on periods. The old financial period data is
generated through using the current baseline. Unifier freezes the data for each project until
the project data date. Also, the data which is being displayed in the graph will be updated
according to the financial period selected. The graph shows weekly data points on x-axis,
and the graph filters the project with same data date.

If you select the period type as financial period, then the data for all or filtered projects will be
consolidated and plotted in the graph. Data points on the x-axis will be the period end date. The
following two scenarios explain your selections:

Scenario one

If you have selected weekly, monthly, quarterly, or yearly from the drop-down, then the start
date of the first sub period will be the least project start date across all projects. Last sub
period will be determined based on the last data date across all projects. In other words, the
end date of last sub period should be greater than the last data date across all projects.

Scenario two

If you have selected a financial period define under Standards & Libraries, then the graph will
only displays the data between the first sub period and last sub period. Everything else will
be filtered out of the graph.

EVA Graph (Incremental)
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If you select the Graph Type as "Period based" for a particular Earned Value Analysis scenario,
then an additional tab for Incremental graph is displayed along with the other graphs. A new tab
for Incremental graph displays the incremental curves for planned value, earned value, actual
cost, and forecast for the filters selected in the pickers. In other words, each x-axis data point
displays the consolidate data since last data point. The y-axis displays the amount (in hundreds,
thousands, millions, etc.), and the amount is determined by the graph dynamically to show the
best possible representation based on the data available. The maximum and minimum value is
determined by the maximum or minimum values as explained above.

At Completion Tab

View VAC, EAC, and BAC curves in the graph. Use the graph features as in the Cumulative
tab.

Variance Tab

View CV and SV curves in the graph. Use the graph features as in the Cumulative tab.

Indices Tab

View CPI, SPI, and CSI curves in the graph. Use the graph features as in the Cumulative tab.

Performance Percentage Completion Sheet

Click the corresponding button to open the Performance Percentage Completion sheet
overlay in the EV Analysis log.

During each synchronization, the performance percentage completion value of an activity gets
updated from P6. Unifier stores the values against corresponding data dates, which are then
used to calculate earned value metrics.

Note: The functionality is only applicable to the current schedule of a
project.

Similar to performing Earned Value (EV) analysis on a System Activity Sheet, you can select
active manual activity sheets and perform Earned Value analysis on those sheets; however, the
following exception will apply when performing Earned Value analysis on the active manual
activity sheets:

» The Performance % Complete option is not required, or available, for EV analysis of active
manual activity sheets.

» The Cost Sheet columns for CBS type of BPs are not required, or available, for EV analysis
of active manual activity sheets.

» After you create an EV analysis sheet (see the Preview Tab (on page 137)) for active
manual activity sheets, if you change the status of any of the activity sheets to inactive, then
you still can update the data through data refresh function, in the Schedule tab.

» The Name column, in the Project picker window, displays the name of the manual activity
sheets.

» The WBS codes for the manual activity sheets appear in the WBS picker window, and the
codes are not suffixed with any text.
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When performing Earned Value analysis on the active manual activity sheets, you can get
information about the:

» Actuals within a created cost-based graph, where the costs that correspond to all of the EV
metrices are included.

» Actuals from the WBS sheet within a created unit-based graph, where the units that
correspond to all of the EV metrices are included.

» WABS codes in the WBS sheet for the respective Manual Activity Sheet in the EV analysis
graph, in the WBS code picker.

Performance Percentage Completion Sheet - Toolbar
The following explains the toolbar options, columns, and rows:

» Actions
» Export CSV
» Update Data

To update historical performance percent completion for the activity against any date,
excluding Data Date coming through P6.

= Export CSV Template
* Import CSV
Columns imported through Import CSV will be marked with an "*" icon.

» Refresh: Click Refresh to update the performance percentage completion values from the
latest synchronization.
Find on Page
Projects drop-down: Select a project to view the performance percentage completion for
each activity against data dates.

Columns

The left pane of the grid displays Activity Id, and Activity Name. The right pane displays a
series of data dates based on the frequency of updates in P6.

Rows

The left pane of the grid displays display the activities of the project selected in the Projects
drop-down. The right pane displays % values against data dates for each activity.

Roll Up Earned Value Analysis to Cost Sheet
The Column Properties window enables you to select your cost sheets.
The following table explains the fields and options in the Column Properties window:

Field Description

Name Sheet name.

Datasource The name of the source.
Element To select the data element.
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Entry Method

The options and sub-options are:
Manual Entry

» Direct entry into cell

» Lineitem content

Sheet

» Type (See below for details)

» Name (See below for details)

» Column (See below for details)
Formula

Data Format

The options are:
» Currency
» Percentage
» Decimal

Display Mode

The options are:
» Show
» Hide

Total

The options are:

» Blank

» Sum of All Rows

» Use Formula Definition

Column Position
After

To indicate where the column must be positioned

Delete To delete the column properties.
OK To accept changes.
Cancel To cancel changes.

The Type field enables you to select the following:

» Worksheet

» Earned Value Analysis (EVA)

» Activity Sheet

The Name field displays the name of the Earned Value Analysis (1 to 6).

If there is no data or sheet for that Name field, then the value will be zero in the Cost Sheet for
that column. Once you refresh the EVA Sheet, the data will be rolled up to the Cost Sheet as a

column.

The Column field enables you to select the currency and decimal fields from the Earned Value
Analysis that are available to be rolled up into the Cost Sheet as a column.

Earned Value Management (EVM)

» pv (Planned Value - cost)
» ev (Earned Value - cost)
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ac (Actual Cost - cost)

cv (Cost Variance - cost)

sv (Schedule Variance - cost)

bac (Budget At Completion - cost)

eac (Estimate at Completion - cost)
vac (Variance at Completion - cost)

etc (Estimate to Complete - cost)
forecast (Forecast - cost)
remaining_cost (Remaining Cost - cost)

Vv vV vV vV vV vV v v Vv

Note: The decimal type Data Element (DE) is available in the cost
formula.

The Column Name field, in the Cell Details window, displays the DE field label in the respective
Earned Value Analysis.

Note: You can have from 1 to 100 predefined cost DEs created in the
Cost Sheet.

Earned Value Analysis User Defined Report (UDR)

You can create User Defined Reports (UDRSs) from the data present in your Earned Value
Analysis.

The Create User-defined Report window enables you to define the following fields for your UDR
(template or individual reports):

» Data Type

» Element

» Report Type
» Tabular
» Cross Tab
» Summary
» Alert

» Access Type
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Note: The same fields will be available for permission-based data
sources.

The elements (Currency/Decimal), in OOTB Earned Value Analysis along with any user-defined
column will be available as DEs for your report.

Note: Only the data elements available in the Earned Value Analysis
Sheet will be available in the respective UDR.

Earned Value Analysis Report

The Earned Value Analysis Report node (Earned Value Manager module > Earned Value
Analysis Report node) in Unifier enables you to access and work with the EVA reports.

Earned Value Analysis Reports Log Window

The Earned Value Analysis Reports log window enables you to create and run reports. The
Earned Value Analysis Reports log window contains the following toolbar options:

Field Description

Create This option is available for users with Create permission, at the node
level. See the Creating an Earned Value Analysis Report for details.

Delete This option is available for users with Create permission, at the node
level.
View This option enables you to view all, create a new view, and manage

views. By default, the All view is selected. To define new views, click
Create New View. You can use the Manage Views option to manage the
user-defined views. Note: Oracle recommends that you do not define a
view with no columns selected.

Edit View |To change the view of the log.

Refresh This option enable you to refresh the report log and view the latest report
definitions that have been added.

Print This option enable you to print the report log information using the
options available.

Find on Enables you to conduct a text-based search for each column in the log.
Page

The Earned Value Analysis Reports log window contains the following columns which
correspond to the fields that you have included in the report when you created one, in addition to
several more fields:

» Name
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Owner

v v v v Vv

Description
Earned Value Analysis Scenario
Report Template

Last Run

The Earned Value Analysis Reports log window contains the following tabs:

General |Enables you to both view and change some of the fields in the report.
When you alter report detail in the General tab, you must save or save and
run the report to ensure that your changes have been applied.

Schedule |Enables you to:

» Set Frequency for Scheduled Report Runs
» Determine the Output Information

The day value will reset to one, if you enter a numeric value that is out of
range.

The report will run on day twentieth of the first month of every quarter, if:

» You select a day between the first and thirty-first.
» You select the twentieth day of each quarter.

The email subscription option enables you to control the type of email
notifications that you want to receive.

In the user Preferences window (User control panel > Preferences >
Email Subscription tab) you can subscribe to receive emails when reports
are scheduled in the EVM reports (Earned Value Analysis Reports >
Results from scheduled EVA reports). This option will be available only
when the Earned Value Manager module is loaded in the company. When
you select the option and have a valid email address, then you will receive
email notification with the report attached. The format of the report is
according to the format selected when the scheduled report was set to run.
The email received contains the report (as an attachment, in Excel format)
with the following information:

Source Name: Displays the shell name.

Report Name: Displays the EVA report name.

Description: Description provided in the EVA report properties.
Unifier Login: To go to the login page.

v v v Vv

The User Preferences Template window (Company Workspace >
Admin mode > Standards & Libraries > User Preferences Template),
Preferences tab, displays the option related to the Earned Value Report
scheduled runs (Earned Value Analysis Reports > Results from
scheduled EVA reports). Unifier uses the active user's preferences
template when creating new users, as default. The other templates can be
used to update preference settings for existing users.
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History Enables you to see the following information:

» Run Date (the date the report was generated)
» Run By (who generated the report)
» Status (if the report is generated successfully)

Each report row has a gear menu ( £ ) that enables you to run a report or delete a report:

» Run Report
You must have View permission in order to be able to run the report, using the gear menu (
i ). This option is shown when you select one report at a time. The report will be displayed
using the format saved in the properties.

» Delete

You must have Full Access and Create permissions in order to be able to use the delete
option. You can select one or more reports to delete.

Creating an Earned Value Analysis Report

Click Create in the Earned Value Analysis Reports log window to open the Earned Value
Analysis Report window.

1) Inthe Name field, enter a descriptive name.

2) Inthe Description field, enter description.

3) From the Earned Value Analysis Scenario field, select a scenario. The drop-down menu
lists all of the earned value scenarios that have been defined in the project. You can select
one scenario, only. Also:

» For formatl to format3, the cost-based earned value scenarios are available to select.
» For format4 you can select a unit-based earned value scenario.

4) From the Report Template field, select a template from the drop-down lists all of available
templates:

a. CONTRACT PERFORMANCE REPORT - FORMAT 1 (Based on WBS)

Format 1 defines cost and schedule performance data by product-oriented Work
Breakdown Structure (WBS).

b. CONTRACT PERFORMANCE REPORT - FORMAT 2 (Based on OBS)

Format 2 defines cost and schedule performance data by the contractor's organizational
structure.

c. CONTRACT PERFORMANCE REPORT - FORMAT 3 (Baseline Changes)
Format 3 defines changes to the Performance Measurement.
Baseline (PMB).

d. CONTRACT PERFORMANCE REPORT - FORMAT 4 (Staffing Forecasts)

e. Format 4 provides staffing forecasts for correlation with the budget plans, cost, and
schedule estimates.

f. CONTRACT PERFORMANCE REPORT - FORMAT 5 (Analysis report)

Format 5 is a narrative report used to provide the required analysis of data contained in
Formats 1-4
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5) If you want to include additional parameters in your report, click to select the Set
Parameters field and proceed to select additional parameters from the options provided.
When you select a period type, Unifier displays the last 10 periods, starting from the current
period, for you to select.

6) When finished, click one of these options:
a. Create to create the report and run it later.
b. Create & Run Report to create the report and run it immediately after.

Note: The staffing numbers are rounded to the closest decimal,
however, the total is calculated per actual value (the numbers before
being rounded).

Record-level Permissions
The following explains the record-level permissions for Earned Value Analysis Reports.
To see the record-level permission:

1) Go to your project or shell (User mode).
2) Click Earned Value Manager to expand.

3) Click Earned Value Analysis Report sub-node to open the Earned Value Analysis
Reports log window.

4) Click to select a record.
5) On the right-hand pane, click Permissions tab.

The Permissions tab displays all the participants and their permission details.
To assign permissions:

1) Go to your project or shell (User mode).

2) Click Earned Value Manager to expand.

3) Click Earned Value Analysis Report sub-node to open the Earned Value Analysis
Reports log window.

4) Click to select a record.

5) Click Actions drop-down menu and click Permissions. The Permissions window opens.

Alternatively, you can click on the gear menu ( % ) of the select record and click
Permissions.

In the Permissions window, click the select icon of the Add field to open User and Group
Picker window (if you know the name, you can enter the name in the field--type ahead). This
enables you to select the user or a group of users who need permission. In this window, use the
View field to find users or groups and follow the prompts. When finished, ensure that you click
Done.

In the Permissions window, you will see the following columns:

» Name (locked column)
» Company (locked column)
» Select All
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To select all of the permission options.
» Modify Permissions
If selected, then the Edit Report and View and Run options would also be selected.
Edit Report
View and Run
Remove
You must save your changes before you can use the Remove option. The Remove option is
not available if you are the owner of the selected record.

Assigning permissions to a single report can be done by a user who is the report owner or has
full access permission.

Assigning permissions to multiple users or groups is allowed if you are the report owner, or have
the required permissions, at the module level. Similar to assigning permissions on a single
record, you can select multiple records from the Earned Value Analysis Reports log window,
click Actions drop-down menu and click Permissions.

Additional information about record-level permissions:

When you assign permissions to multiple reports, you are adding new permissions.

When you select multiple reports to assign permissions, you must be the reports owner, or have
full access permission for all the selected reports.

If you have view permission at module level, or can only run permissions, then clicking the
Permissions option (Actions > Permissions) opens the view only permission window. In this
case, the columns are disabled and the Remove option is not available.

If you highlight, for example, the first three rows but select a permission option on the fifth row,
then the fifth row option will get selected and highlighted.

Earned Value Management Permissions

For Earned Value Management permissions, refer to the Unifier Modules Setup Administration
Guide (Administration Help).
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The following explains the Earned Value Management Attributes. For details about the data
elements, refer to the Unifier Data Reference Guide.

In This Section
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Recost - Activity Attributes

By default, the Master Rate Sheet in the Company Workspace will be used to do the costing.

You can assign a custom rate sheet at the activity sheet (System or Manual) level, or a project
sheet level, and then do the re-costing. Accordingly, the price/unit from the respective sheet is
used to do the re-costing.

The following logic is used to do the re-costing:

» If no rate (Price/Unit) is defined in the activity sheet (System or Manual), and no rate is
defined for the resource/role, then user will see a warning included in the history and a
default value of 0.

» If arate is defined for the individual resource on an activity, Unifier selects the project
currency and multiply that number by the number of units to get the cost.

Only the following fields will be re-costed for baseline schedule:
Activity Attributes

» Planned Total Cost (uuu_P6PIlannedTotalCost)

» Actual Total Cost (uuu_P6ActualTotalCost)

» At Completion Total Cost (uuu_P6AtCompletionTotalCost)
» Remaining Total Cost (uuu_P6RemainingTotalCost)

Assignment Attributes

» Planned Cost (uuu_P6PlannedCost)*

» Actual Cost (uuu_P6ActualCost)*

» Remaining Cost (uuu_P6RemainingCost)*

» At Completion Cost (uuu_P6AtCompletionCost)*
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As part of baseline re-costing, the new planned total cost in current schedule has been updated

and recalculated for all the fields that are impacted by change in baseline planned cost.

» Spread Costing: Applying the correct cost-applicable on that day.

» CBS: Unifier uses the Estimate to Completion (ETC) calculation from Project ETC Formula.
» PV Cost: Planned Value (PV) cost of activity in Current Schedule is Planned Cost of the

same activity in baseline.

For cumulative calculation the system applies the formula on cumulative data, and similarly,

does the same for incremental data.

If a project does not have a baseline schedule, then Unifier uses the corresponding baseline

values from the current schedule.

Activity |Date Element | Calculation

Attribute

Planned |uuu_P6Pla |Planned Total Cost is calculated by consolidating the planned

Total nnedTotal |cost across all assignments under an activity.

Cost Cost

Actual uuu_P6Act |The actual total cost incurred for the activity as of the project

Total ualTotalC |data date.

Cost ost Calculated by consolidating Actual Total Cost across all
assignments under an activity.

At uuu_P6AtC | At Completion Total Cost is calculated by consolidating the at

Completi [ompletion |completion costs across all assignments under an activity.

on Total |TotalCost

Cost

Remaini |uuu_P6Rem |Remaining Total Cost is calculated by consolidating the

ng Total [ainingTot |remaining costs across all assignments under an activity.

Cost alCost

Planned |uuu_P6PVC |The portion of the baseline total cost of the activity or project

Value ost that is scheduled to be completed as of the project data date.
Calculated as Planned Total Cost multiplied by Planned
Completion of the activity at the data date.
Planned Total Cost and Planned completion of the activity are
calculated from project baseline.

Earned |uuu_P6EVC |The portion of the project baseline total cost of an activity

Value ost actually completed as of the project data date.

Calculated as Planned Total Cost multiplied by Performance
Percent Complete.

The method for computing performance percent complete
depends on the Earned Value technique selected for the
activity's WBS.

Planned Total Cost of the activity is calculated from the
project baseline.
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Activity |Date Element | Calculation
Attribute
Estimate |uuu_P6ETC |The estimated cost to complete the activity is calculated as
to Remaining Total Cost for the activity or the Performance
Complet Factor multiplied by (Planned Total Cost minus Earned
e Value), depending on the Earned Value technique selected
for the activity's WBS (calculated from the primary baseline).
Planned Total cost is calculated from the project baseline.
For CBS, project level earned value technique is used for
data roll up.
Schedul [uuu_P6SPI | A measure of the work accomplished as a percentage of the
e ndex work scheduled.
Performa Schedule Performance Index indicates whether you are
nce meeting earned and planned values within your schedule. A
Index value less than 1 indicates that less work was performed than
was scheduled.
Schedule Performance Index = Earned Value/Planned Value.
A value less than 1 indicates that the project is behind
schedule.
For not started activities, SPI is 1.
Cost uuu_P6CPI | A measure of the work accomplished as a percentage of the
Performa | ndex actual costs.
nce Cost Performance Index (CPI) indicates whether you have
Index spent money over the budget to date.
Cost Performance Index = Earned Value/Actual Cost. A value
less than 1 indicates that the actual cost has exceeded the
planned value.
For not started activities, CPl is 1.
Cost uuu_CSInd |A measure to check the overall status by combining cost &
Schedul |ex schedule.
e Index Cost Schedule Index = Schedule Performance Index * Cost
Performance Index.
For not started activities, CSl is 1.
Schedul uuu_PGSch The measure of schedule performance on a project.
e edulevari | A negative value indicates that less work was actually
Variance |ance performed than was scheduled and vice versa.
Schedule Variance = Earned Value - Planned Value.
For not started activities, SV is 0.
Cost uuu_P6Cos | A measure of cost performance on an activity, WBS, or
Variance |tVariance |project.

A negative value indicates that the actual cost has exceeded

159



Earned Value Management User Guide

Activity |Date Element | Calculation
Attribute
the planned value.
Cost Variance = Earned Value - Actual Cost.
For not started activities, CV is 0.
To uuu_P6TCP | A measure of the value of the project work that is remaining.
Complet | Index To Complete Performance Index (TCPI) is essentially a ratio
e of the remaining work to the remaining funds.
Egzéforma It helps determine the level of performance that must be
Index achieved on the remaining work to meet recognized business
goals, such as the Budget at Completion (BAC) or the
Estimate at Completion (EAC).
You can set performance thresholds for calculated TCPI
values to display visual indicators that help you determine
whether you need to take corrective action.
To Complete Performance Index = (Remaining Work) /
(Remaining Funds) where the Remaining Work = Budget at
Completion - Earned Value.
If under budget, then:
Remaining Funds = Budget at Completion - Actual Cost
If over budget, then:
Remaining Funds = Estimate at Completion - Actual Cost
Estimate |uuu_P6EAC |The expected total cost of a schedule activity when the
at Cost defined scope of work will be completed. Calculated as Actual
Completi Cost (14) + Estimate to Complete Cost (24).
on The method for calculating estimate to complete depends on
the earned value technique selected for the activity's WBS.
The estimate at completion (EAC) will help you find a new,
realistic, budget to complete the project. It tells you how much
you may have to spend to complete the project.
The EAC can be calculated in three cases depending on the
situation.
Budget [uuu_P6BAC |The planned total cost through activity completion calculated
at by consolidating costs across all assignments.
Completi
on
Variance |uuu_P6VAC |The difference between the baseline total cost and the current
at estimate of total cost.
Completi A negative value indicates an estimated cost overrun. Budget
on

At Completion is calculated from the current baseline.

Variance at Completion = Budget At Completion - Estimate At
Completion.
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Recost - Assignment Attributes

Assignme |Data Calculation
nt Element
Attribute
Planned uuu_P6Pla | Calculated at spread level.
Cost nnedCost | ypifier Planned Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet (System or Manual)
corresponding to that assignment.
Actual uuu_P6Act | Calculated at spread level.
Cost ualCost | ynifier Actual Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet (System or Manual)
corresponding to that assignment.
Remainin UL_JUTPGRem Calculated at spread level.
g Cost 2'”'”9003 Unifier Remaining Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet (System or Manual)
corresponding to that assignment.
At uuu_P6ATC | Calculated at spread level.
Completio jompletion | ypjfier At Completion Cost is the sum of actual cost and
n Cost Cost remaining cost for that assignment.
WBS Attributes
Assignment Data Element Calculation
Attribute
WBS Code uuu_P6WBSCode | The unique identifier of the WBS for the
associated activity.
WBS Name uuu_P6WBSName |The name of the WBS Code for the associated
activity.
WBS Path uuu_P6WBSPath | The location of the activity on the WBS
hierarchy.
WBS Type REVIEWER: Need REVIEWER: Need info
info
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Assignment Data Element Calculation
Attribute
ETC Technique |uuu_P6ETC The field is populated with the formula used for

the ETC calculation. ETC is the estimated cost to
complete the activity, WBS, or project.
Calculated as Remaining Total Cost for the
activity or the Performance Factor multiplied by
(Budget At Completion minus Earned Value),
depending on the Earned Value technique
selected for the activity's WBS (calculated from
the primary baseline). Budget at Completion is
calculated from the project baseline.

Activity Attributes (General)

Assignment Data Element Calculation
Attribute
Activity ID uuu_P6Activityld |The unique identifier of the activity. In order

to identify and track activities, P6 assigns
each activity a unique Activity ID that is the
result of joining the Activity ID Prefix with
the Activity ID Suffix and then adding an
Increment value. For example, a prefix of
PROJ-A# combined with a suffix of 2500
and an Increment of 5 will yield the
following activity IDs: PROJ-A#2500,
PROJ-A#2505, etc.

Activity Name uuu_P6ActivityName | The name of the activity.

Activity Status uuu_P6ActivityStat | The current condition of the activity. Valid
us values are Not Started; In Progress; and
Completed.

Activity Type uuu_P6ActivityType | Determines how duration and schedule
dates are calculated for an activity. Options
are:

Task Dependent: Activities are scheduled
using the activity calendar rather than the
calendars of assigned resources.

Resource Dependent: Activities are
scheduled using the calendars of assigned
resources.

Level of Effort; Activities have a duration
that is determined by its dependent
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Assignment Data Element Calculation
Attribute

activities and are typically administration
type.

Start or Finish Milestone: Indicates if the
activity marks the beginning or end of a
major stage in the project. Milestones have
zero duration and no resources.

WBS Summary: Activities that are used to
aggregate date, duration, and percent
complete values for a group of activities
that share a common WBS code level.

Activity % uuu_P6PercentCompl | An activity level setting in P6 used to
Complete ete update the amount of work completed on
an activity. Use one of 3 options for
identifying Activity Percent Complete:

Duration % Complete: Used to report
progress based on Remaining Duration:
[(Original Duration - Remaining
Duration)/Original Duration]*100.

Units % Complete: Used to report progress
based upon actual work performed and
remaining units to complete: (Actual
Units/At Completion Units) * 100.

Physical % Complete: Used to progress
based on personal judgment.

CBS Code bitemlD The cost code in Unifier to which you can
link an activity, assignment or expense.

Performance % |uuu_P6Performance% |The percentage of the activity or project
Complete Complete planned work that is currently complete.
Performance % Complete is used to
calculate earned value. It can be based on
the technique for computing earned-value
percent complete for the activity's WBS -
e.g., the activity percent complete, 0/100
rule, 50/50 rule, etc.

Activity Attributes (Scheduling)

Assignment Data Element Calculation
Attribute

Planned Start uuu_P6PlannedSta |The date the activity is scheduled to start.
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Assignment
Attribute

Data Element

Calculation

rt

Planned Finish

uuu_P6PlannedFin
ish

The date the activity is scheduled to finish if
the activity has not started.

Planned
Duration

uuu_P6PlannedDur
ation

The expected amount of time required to
complete an activity. The planned working
time is calculated in P6 using the activity's
calendar. The duration is measured from the
activity's planned start date to its planned
finish date.

Start

uuu_P6Start

Start date is equal to the early start when an
activity has no progress. When the activity is
in progress or complete, start is equal to the
actual start.

Finish

uuu_P6Finish

Finish date is equal to the early finish when
an activity has no progress. When the activity
is in progress, finish will remain equal to early
finish. When the activity is complete, finish
date is equal to the actual finish date.

Actual Start

uuu_P6ActualStar
T

If work has started, the date on which the
activity, WBS, project, or EPS began.

If resources (labor, non-labor, or material) or
roles are assigned to the activity, the actual
start date is the earliest among all the
resource or role assignments.

For a WBS, project, or EPS, the actual start
date is the earliest actual start date among all
activities within the WBS, project, or EPS.

When P6 is integrated with Primavera Unifier,
the Actual Start date might have been
imported from Primavera Unifier rather than
calculated by P6.

Actual Finish

uuu_P6ActualFini
sh

The date on which the item, such as an
activity, assignment, or project, is complete.
When P6 is integrated with Primavera Unifier,
the Actual Finish date might have been
imported from Primavera Unifier rather than
calculated by P6.

Actual Duration

uuu_P6ActualDura
tion

The total working time from the Actual Start
date to the Actual Finish date for completed
activities, or the total working time from the
Actual Start date to the data date for
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in-progress activities. The actual working
time is computed using the activity's
calendar.

Remaining Early
Start

uuu_P6RemainingE
arlyStart

Remaining early start date is basically the
earliest date the activity can start or continue
after the data date. If the Activity has no
progress then remaining early dates are set
equal to the early dates. If progress follows
as expected, then remaining early start is
eqgual to the data date. Once the activity is
complete, remaining early start is blanked
out.

Remaining Early
Finish

uuu_P6RemainingE
arlyFinish

Remaining early finish is calculated by
adding the remaining duration to remaining
early start. Once the activity is complete,
remaining early finish is blanked out.

Remaining
Duration

uuu_P6RemainingD
uration

The total working time from the activity
remaining start date to the remaining finish
date. The remaining working time is
calculated using the activity's calendar.
Before the activity is started, the remaining

duration is the same as the planned duration.

After the activity is completed the remaining
duration is zero.

At Completion
Duration

uuu_P6AtCompleti
onDuration

The total working time from the activity's
current start date to the current finish date.
The current start date is the planned start
date until the activity is started, and then it is
the actual start date. The current finish date
is the activity planned finish date while the
activity is not started, the remaining finish
date while the activity is in progress, and the
actual finish date once the activity is
completed. The total working time is
calculated using the activity's calendar.

Primary
Constraint

uuu_P6PrimaryCon
straint

A user-imposed date restriction can be
applied to an activity that impacts the
scheduling of dependent activities. For
example, use the Start On or After constraint
to specify the earliest date on which an
activity can begin.
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Secondary uuu_P6SecondaryC | A maximum of two constraints - a primary
Constraint onstraint and a secondary can be applied to an

activity. To specify a secondary constraint, a
valid primary constraint must first be applied
to the activity.

Activity Attributes (Units)

Assignment
Attribute

Data Element

Calculation

Planned Total
Units

uuu_P6PlannedTot
alUnits

The planned units of work for the activity.

Actual Total
Units

uuu_P6ActualTota
lUunits

The exact number of units that have been
expended on the selected activity.

Remaining Total
Units

uuu_P6RemainingT
otalUnits

The remaining units of work to be performed
by the resource on the activity. Calculated as
Planned Units minus Actual Units.

At Completion
Total Units

uuu_P6AtCompleti
onTotalUnits

The sum of the actual units and remaining
units for the resource assignment on the
activity. Calculated as Actual Units plus
Remaining Units.

Activity Attributes (Cost)

Assignment
Attribute

Data Element

Calculation

Planned Total
Cost

uuu_P6PlannedTot
alCost

The expected total cost of the activity,
consolidating costs of all assignments.

Actual Total
Cost

uuu_P6ActualTota
ICost

The actual non-overtime plus overtime cost
for all the resource assignments of the
activity.

Remaining Total
Cost

uuu_P6RemainingT
otalCost

The remaining cost of all the resource
assignments for the activity.

At Completion
Total Cost

uuu_P6AtCompleti
onTotalCost

The sum of the actual costs plus remaining
costs for the resource assignment on the
activity. Calculated as Actual Costs plus
Remaining Costs.
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Planned Value
(PV)

uuu_P6PVCost

The portion of the baseline total cost of the
activity or project that is scheduled to be
completed as of the project data date.

Earned Value
(EV)

uuu_P6EVCost

The portion of the project baseline total cost
of an activity or all activities in the project that
are actually completed as of the project data
date. Budget at completion is calculated from
the project baseline. Calculated as Budget At
Completion multiplied by Performance
Percent Complete.

Estimate to
Complete (ETC)

uuu_P6ETC

The estimated cost to complete the activity,
WBS, or project. Calculated as Remaining
Total Cost for the activity or the Performance
Factor multiplied by (Budget At Completion
minus Earned Value), depending on the
Earned Value technique selected for the
activity's WBS (calculated from the primary
baseline). Budget at completion is calculated
from the project baseline.

Schedule uuu_P6SPIndex A measure of the work accomplished as a

Performance percentage of the work scheduled. Schedule

Index (SPI) Performance Index indicates whether you are
meeting earned and planned values within
your schedule. A value less than 1 indicates
that less work was performed than was
scheduled. Calculated as Earned Value
divided by Planned Value.

Cost uuu_P6CPIndex A measure of the value of work accomplished

Performance as a percentage of the actual costs. Cost

Index (CPI) Performance Index (CPI) indicates whether

you have spent money over the budget to
date. On the My Preferences page in P6, you
can set performance thresholds for CPI
calculated values to determine whether you
need to take corrective action. Calculated as
Earned Value Cost divided by Actual Cost. A
value less than 1 indicates that the actual
cost has exceeded the planned value.

Cost Schedule

uuu_P6CSIndex

Product of Schedule Performance Index and
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Index (CSI) Cost Schedule Index.

Schedule uuu_P6ScheduleVa | The measure of schedule performance on a
Variance riance project. A negative value indicates that less

work was actually performed than was
scheduled. Calculated as Earned Value
minus Planned Value.

Cost Variance

uuu_P6CostVarian
ce

A measure of cost performance on an
activity, WBS, or project. A negative value
indicates that the actual cost has exceeded
the planned value. Calculated as Earned
Value minus Actual Cost.

To Complete uuu_P6TCPIndex The ratio of the remaining work to the

Performance remaining funds. Calculated as (Budget at

Index Completion minus Earned Value) divided by
(Estimate at Completion minus Actual Units
or Cost).

Estimate at uuu_P6EACCost The expected total cost of a schedule activity,

Completion a work breakdown structure component, or
the project when the defined scope of work
will be completed. Calculated as Actual Cost
plus Estimate to Complete Cost. The method
for calculating estimate to complete depends
on the earned value technique selected for
the activity's WBS.

Budget at uuu_P6BAC The planned total cost through activity or

Completion project completion. Calculated as Planned
Labor Cost plus Planned Non-labor Cost plus
Planned Expense Cost plus Planned Material
Cost.

Variance at uuu_P6VAC The difference between the baseline total

Completion cost and the current estimate of total cost. A

negative value indicates an estimated cost
overrun. Budget At Completion is calculated
from the current baseline. Calculated as
Budget At Completion minus Estimate At
Completion.
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ID uuu_P6ResourcelD |Resource code from P6.

Name uuu_P6ResourceNa |Resource name from P6; It can be a team
me name or resource name depending on the

rate assigned to that level.

Status uuu_P6ResourceSt | Status of the resource - Active/lnactive.
atus

Currency uuu_P6RateCurren | Currency for the rate.
cy

Role Attributes

Assignment Data Element Calculation

Attribute

ID uuu_P6RolelD Role code from P6

Name uuu_P6RoleName Role name from P6; It can be a team name
or role name depending on the rate assigned
to that level.

Status uuu_P6RoleStatus |Status of the role - Active/lnactive

Currency uuu_P6RateCurren | Currency for the rate

cy

Rate Sheet - Rate Tab

Assignment Data Element Calculation

Attribute

Effective Date  |uuu_P6RateEffect |Date from which the rate is applicable.
iveFrom

Price/Unit uuu_P6priceperun |Rate or price per unit.
it
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Earned Value Management Templates

The following templates are available for the Earned Value Management:

» OBS Templates
» WBS Templates

In This Section

OBS TEMPIALES ...ttt nnnnnnnnnne 171
WBS TeMPIALIES. ... 171
OBS Templates

1) Gotothe Company Workspace and switch to the Admin mode.

2) From the left-hand Navigator click Templates module to expand.

3) Click OBS Sheets to open the OBS Sheets log.

4) Click Create to open the Create OBS Sheet window.

5) Enter a name in the Name field.

6) Enter a description in the Description field.

7) Click Create. The OBS Sheets log window displays the newly created OBS sheet.

8) Click the gear menu ( % ) on the newly created OBS sheet to open and click Open.

9) Proceed to create an OBS structure, under Templates. This can be used when creating the
OBS in a shell (Activity Manager > OBS Sheet).

WBS Templates

No templates are needed for WBS sheet as the WBS sheet is created directly by way of P6 and
Unifier Integration.
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Earned Value Management Configuration Package

The following configuration packages are available for the Earned Value Management:

» OBS Configuration Package
» WBS Configuration Package

In This Section

OBS Configuration PACKAGE ..........uueeieiiiiiiiiiiiiiiieieiiiiieeeeieseeseseeeeasneeeneessennnnennnennnnes 173
WBS Configuration PACKAGE .........cccoeeieeeieeeeeeeeeee e 173

OBS Configuration Package

Open the New Component List > Earned Value Manager > OBS Attributes.
WBS Configuration Package

If you select the Schedule Manager in uDesigner, when creating a configuration package, then
WBS Sheet design will also be available as an option.
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